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1 About this document

1.1 Other applicable documents
The information on the safety sensor is distributed over several documents to make working with the docu-
ments easier. You will find the documents and software for the safety sensor in the following table:

Purpose and target group of the document Document/software ti-
tle

Source

Software for users of the machine a) for safety sen-
sor diagnostics if a fault occurs and for machine de-
sign engineers for configuring the safety sensor

Sensor Studio
DTM RSL 400

Supplied with the safety
sensor on data carrier

Notes for the machine design engineer a) "Safe implementation
and operation" 
(this document)

PDF, supplied with the
safety sensor on data
carrier

Notes for the machine design engineer a) for config-
uring the safety sensor (software instructions)

Online help for software Supplied with the safety
sensor on data carrier

Notices regarding mounting, alignment and connec-
tion of the safety sensor

"Quick Start Guide
RSL 400"

Print document, supplied
with the safety sensor

a) Machine identifies the product that the safety sensor is installed in.

1.2 Downloading configuration software from the Internet
Ä Call up the Leuze home page: www.leuze.com.
Ä Enter the type designation or part number of the device as the search term.
Ä The configuration software can be found on the product page for the device under the Downloads tab.

1.3 Used symbols and signal words

Tab. 1.1: Warning symbols and signal words

Symbol indicating dangers to persons

Symbol indicating dangers from harmful laser radiation

Symbol indicating possible property damage

NOTE Signal word for property damage
Indicates dangers that may result in property damage if the measures for dan-
ger avoidance are not followed.

CAUTION Signal word for minor injuries
Indicates dangers that may result in minor injury if the measures for danger
avoidance are not followed.

WARNING Signal word for serious injury
Indicates dangers that may result in severe or fatal injury if the measures for
danger avoidance are not followed.

DANGER Signal word for life-threatening danger
Indicates dangers with which serious or fatal injury is imminent if the measures
for danger avoidance are not followed.
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Tab. 1.2: Other symbols

Symbol for tips
Text passages with this symbol provide you with further information.

Symbol for action steps
Text passages with this symbol instruct you to perform actions.

Symbol for action results
Text passages with this symbol describe the result of the preceding action.

Tab. 1.3: Terms and abbreviations

CS Switching signal from a control
(Controller Signal)

DAP Device Access Point

DTM Software device manager of the safety sensor
(Device Type Manager)

FDT Software frame for management of device managers (DTM)
(Field Device Tool)

Field pair A protective field with an associated warning field

AGV Automated Guided Vehicle

GSDML Description file of the RSL400 PROFIsafe for integration in the control
Generic Station Description Markup Language

LED LED, display element in the safety sensor
(Light Emitting Diode)

OSSD Safety switching signal or safety-related switching output
(Output Signal Switching Device)

PFHd Probability of a dangerous failure per hour
(Probability of dangerous Failure per Hour)

PL Performance Level

Quad Two field pairs (four fields) that are monitored simultaneously in four field mode

TSS Transverse Side-tracking Skate

RES Start/restart interlock
(Start/REStart interlock)

SIL Safety Integrity Level

State ON: device intact, safety-related switching signals switched on
OFF: device intact, safety-related switching signals switched off
Locking: device, connection or actuation/operation faulty, safety-related switch-
ing signals switched off (lock-out)

1.4 Checklists
The checklists serve as a reference for the machine manufacturer or supplier (see chapter 12 "Testing").
They replace neither testing of the complete machine or system prior to the initial start-up nor their periodic
testing by a competent person. The checklists contain minimum testing requirements. Depending on the
application, other tests may be necessary.
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2 Safety
Before using the safety sensor, a risk assessment must be performed according to valid standards (e.g.
EN ISO 12100, EN ISO 13849-1, IEC 61508, EN IEC 62061). The result of the risk assessment determines
the required safety level of the safety sensor (see chapter 16.1 "Safety-relevant technical data"). For
mounting, operating and testing, this document as well as all applicable national and international stan-
dards, regulations, rules and directives must be observed. Relevant and supplied documents must be ob-
served, printed out and handed to affected persons.
Ä Before working with the safety sensor, completely read and observe the documents applicable to your

task.
In particular, the current version of the following national and international legal regulations apply for com-
missioning, technical tests and handling of safety sensors:

• Machinery Directive
• Low Voltage Directive
• Electromagnetic Compatibility Directive
• Use of Work Equipment Directive
• Directive on the restriction of the use of certain hazardous substances in electrical and electronic equip-

ment
• OSHA
• Safety regulations
• Accident-prevention regulations and safety rules
• Ordinance on Industrial Safety and Health and employment protection act
• Product Safety Law (ProdSG)

NOTICE

For safety-related information you may also contact local authorities (e.g., industrial inspec-
torate, employer's liability insurance association, labor inspectorate, occupational safety and
health authority).

2.1 Intended use
The safety sensor protects persons or body parts at points of operation, danger zones or access points of
machines and systems.

WARNING

A running machine may result in serious injury!
Ä Make certain that the safety sensor is correctly connected and that the protective function of

the protective device is ensured.
Ä Make certain that, during all conversions, maintenance work and inspections, the system is

securely shut down and protected against being restarted.

• The safety sensor may only be used after it has been selected in accordance with the respectively ap-
plicable instructions and relevant standards, rules and regulations regarding labor protection and safety
at work, and after it has been installed on the machine, connected, commissioned, and checked by a
competent person (see chapter 2.3 "Competent persons").

• When selecting the safety sensor it must be ensured that its safety-related capability meets or exceeds
the required Performance Level PLr ascertained in the risk assessment (see chapter 16.1 "Safety-rele-
vant technical data").

• The safety sensor may only be used in North America in applications that satisfy the requirements
specified by NFPA 79.

• With the “access guarding” function, the safety sensor detects persons only when they enter the danger
zone but cannot tell whether there are any persons inside the danger zone. For this reason, a start/
restart interlock in the safety chain is essential in this case.

• The construction of the safety sensor must not be altered. When manipulating the safety sensor, the
protective function is no longer guaranteed. Manipulating the safety sensor also voids all warranty
claims against the manufacturer of the safety sensor.
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• The safety sensor must be inspected regularly by a competent person to ensure proper integration and
mounting (see chapter 16.1 "Safety-relevant technical data").

• The safety sensor must be exchanged after a maximum of 20 years. Repairs or the exchange of wear
parts do not extend the mission time.

CAUTION

Observe intended use!
The protection of personnel and the device cannot be guaranteed if the device is operated in a
manner not complying with its intended use.
Ä Only operate the device in accordance with its intended use.
Ä Leuze electronic GmbH + Co. KG is not liable for damages caused by improper use.
Ä Read these operating instructions before commissioning the device. Knowledge of the oper-

ating instructions is an element of proper use.

NOTICE

Comply with conditions and regulations!
Ä Observe the locally applicable legal regulations and the rules of the employer's liability insur-

ance association.

2.1.1 Vapors, smoke, dust, particles
Vapors, smoke, dust and all particles visible in the air can cause the machine to switch off unintentionally.
This can mislead the user into bypassing the safety devices.
Ä Do not use the safety sensor in environments in which heavy vapors, smoke, dust or other visible parti-

cles occur at the beam level.

2.1.2 Stray light
Light sources can impair the safety sensor's availability. Interfering light sources are:

• Infrared light
• Fluorescent light
• Strobe light
Ä Ensure that there are no interfering light sources at beam level.
Ä Prevent reflective surfaces at beam level.
Ä Where applicable, take protective field addition distances into account.
Ä Implement all additional measures to ensure that any special application of any effected beam types

does not impair the safety sensor's operation.

2.1.3 Obstructions in the protective field
Ä Do not bring any additional window materials into the area monitored by the safety sensor.

NOTICE

No screen between optics cover and monitoring area!
Ä Between the optics cover of the safety sensor and the monitored area, no further screen

may be mounted to protect the safety sensor.
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2.2 Foreseeable misuse
Any use other than that defined under "Intended use" or which goes beyond that use is considered im-
proper use.
In principle, the safety sensor is not suitable as a protective device for use in the following cases:

• Danger posed by ejected objects or the spraying of hot or hazardous liquids from within the danger
zone.

• Applications in explosive or easily flammable atmospheres.
• Use for outdoor applications or under extreme temperature fluctuations.

Humidity, condensation and other weather influences can impair the protective function.
• Use on vehicles with combustion engines.

Alternators and ignition systems can cause EMC interferences.

NOTICE

Do not modify or otherwise interfere with the safety sensor!
Ä Do not carry out modifications or otherwise interfere with the safety sensor. The safety sen-

sor must not be tampered with and must not be changed in any way.
Ä The safety sensor must not be opened. There are no user-serviceable parts inside.
Ä The construction of the safety sensor must not be altered. When manipulating the safety

sensor, the protective function is no longer guaranteed.
Ä Manipulating the safety sensor voids all warranty claims against the manufacturer of the

safety sensor.
Ä Repairs must only be performed by Leuze electronic GmbH + Co. KG.

2.3 Competent persons
Connecting, mounting, commissioning and adjustment of the safety sensor must only be carried out by
competent persons.
Prerequisites for competent persons:

• They have a suitable technical education.
• They know the rules and regulations for labor protection, safety at work and safety technology and can

assess the safety of the machine.
• They know the operating instructions for the safety sensor and the machine.
• They have been instructed by the responsible person on the mounting and operation of the machine

and of the safety sensor.
• They perform a task related to the subject matter shortly thereafter and keep their knowledge up to date

through continuous further training.

Certified electricians
Electrical work must be carried out by a certified electrician.
Due to their technical training, knowledge and experience as well as their familiarity with relevant standards
and regulations, certified electricians are able to perform work on electrical systems and independently de-
tect possible dangers.
In Germany, certified electricians must fulfill the requirements of accident-prevention regulations DGUV
(German Social Accident Insurance) provision 3 (e.g. electrician foreman). In other countries, there are re-
spective regulations that must be observed.
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2.4 Disclaimer
Leuze electronic GmbH + Co. KG is not liable in the following cases:

• The safety sensor is not used as intended.
• Safety notices are not adhered to.
• Reasonably foreseeable misuse is not taken into account.
• Mounting and electrical connection are not properly performed.
• Proper function is not tested (see chapter 12 "Testing").
• Changes (e.g., constructional) are made to the safety sensor.

2.5 Laser safety notices – Laser class 1 for wavelength range outside 400 - 700 nm

NOTICE

Additional measures for shielding the laser radiation are not necessary (safe for eyes).

ATTENTION

LASER RADIATION – CLASS 1 LASER PRODUCT
The device satisfies the requirements of IEC/EN 60825-1:2014 safety regulations for a product
of laser class 1 and complies with 21 CFR 1040.10 except for conformance with IEC 60825-1
Ed. 3., as described in Laser Notice No. 56, dated May 8, 2019.
Ä Observe the applicable statutory and local laser protection regulations.
Ä The device must not be tampered with and must not be changed in any way. 

There are no user-serviceable parts inside the device. 
Repairs must only be performed by Leuze electronic GmbH + Co. KG.

2.6 Responsibility for safety
Manufacturer and operator must ensure that the machine and implemented safety sensor function properly
and that all affected persons are adequately informed and trained.
The type and content of all imparted information must not lead to unsafe actions by users.
The manufacturer of the machine is responsible for:

• Safe machine construction and information on any residual risks
• Safe implementation of the safety sensor, verified by the initial test performed by a competent person
• Imparting all relevant information to the operating company
• Adhering to all regulations and directives for the safe commissioning of the machine

The operator of the machine is responsible for:
• Instructing the operator
• Maintaining the safe operation of the machine
• Adhering to all regulations and directives for labor protection and safety at work
• Regular testing by competent persons
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3 Device description
The safety sensors from the RSL 400 series are optoelectronic, two-dimensional measuring safety laser
scanners. They satisfy the following standards:

RSL 400
Type in accordance with IEC 61496 3

Category in accordance with ISO 13849 3

Safety Integrity Level (SIL) in accordance with IEC 61508 2

SILCL in accordance with IEC 62061 2

Performance Level (PL) in accordance with ISO 13849-1 d

1

2

3

4

5

7

6

1 Scanner unit
2 Connection unit PROFINET (CU400P-3M12)
3 Optics cover
4 Alphanumerical display (displayed)
5 RSL 400 LED indicators
6 Mini-B USB connection (behind protective cap)
7 RSL 400 PROFINET LED indicators

Fig. 3.1: Device overview of RSL 400 safety laser scanners with PROFIsafe interface
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All safety sensors of the RSL 420P series are equipped as follows:
• Laser scanner with the range class S, M, L or XL:

Operating range
class

Operating range [m]

S 3.00

M 4.5

L 6.25

XL 8.25

• 24-digit alphanumerical display
• Integrated electronic spirit level for aligning the safety sensor
• LED indicator
• USB interface

NOTICE

Ä Use the USB connection only temporarily for configuration or diagnosis of the safety sensor.
Ä For permanent connection, connect the safety sensor to the Ethernet connection of the con-

nection unit.

• Connection unit:
• Configuration memory
• Ethernet connection for communication and configuration with the PC/laptop

3.1 Device overview
The following table provides an overview of the possible uses, features and functions of the RSL 400 safety
sensors with PROFIsafe interface.

Tab. 3.1: Device overview

RSL 420P RSL 450P
RSL 455P

Stationary danger zone guarding x x

Mobile danger zone guarding x x

Point of operation guarding x x

Safe output signals 1 bit 4 bit

Additional output signals See description of the process data

Number of changeover-capable protective/warning field
pairs

10 100

Four field mode (quads) - x

Measurement data output optimized for vehicle naviga-
tion

- Only RSL 455P

USB interface x x

3.1.1 Protective function of RSL 400 safety sensors
The safety sensor transmits periodic light pulses via a rotating deflection unit. The light pulses are scattered
in all directions by obstacles, e.g. persons. A part of the light pulses is received again by the safety sensor
and evaluated. The safety sensor calculates the precise position of the object from the propagation time of
the radiated light and the current angle of the deflection unit at that time. If the object is within a predefined
area, the protective field, the safety sensor performs a safety-related switching function. It switches the
safety-related switching outputs off.
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Only when the protective field is free again does the safety sensor reset the safety-related switching func-
tion, either automatically or following acknowledgment, depending on the operating mode.
The safety sensor can even detect people when they are wearing very dark clothes, which have a very
weak diffuse reflectance.

3.1.2 Device and monitoring functions
• Monitoring and release of field pair changeover

3.2 USB connection
The safety sensor features a Mini-B type USB socket as a service interface for configuration and diagnosis.
This interface can be used with a device firmware version V4.5 and higher.

NOTICE

Ä Use the USB connection only temporarily for configuration or diagnosis of the safety sensor.
Ä For permanent connection, connect the safety sensor to the Ethernet connection of the con-

nection unit.

NOTICE

Ä After use, seal the USB connection using a protection cap. Make sure that the protection
cap is felt to engage when sealing. The IP degree of protection specified in the technical
data is only achieved when the protection cap is closed.

3.3 Connection units
The safety sensor is mounted, connected and aligned using the connection unit.
Functions of connection unit:

• Attachment point for mounting, either directly or using an optional mounting system. 
When devices are swapped out, the connection unit remains mounted and aligned.

• EMC wiring for signal inputs/outputs and supply using connection cable
• Connector bushing and EMC for the Ethernet TCP/IP communication and configuration interface to the

PC/laptop
• Memory for the configuration files and automatic parameter transfer in the event of device swap-out
• Quick-release connection to the scanner unit for easy device swap-out (see "Quick Start Guide

RSL 400").

NOTICE

To ensure the IP protection and leak tightness of the devices, the supplied protection caps must
always be placed on unused connections.

Connection unit CU400P-3M12
• Three connections with M12 connectors / sockets
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2 31

1 M12 connector, A-coded, voltage supply, I/O signal RSL
2 M12 socket, D-coded, PROFINET/PROFIsafe communication, input
3 M12 socket, D-coded, PROFINET/PROFIsafe communication, output

Fig. 3.2: Device with connection unit CU400P-3M12

Connection unit CU400P-4M12
• Four connections with M12 connectors / sockets for power and communication

4321

1 M12 connector, L-coded, voltage supply
2 M12 socket, D-coded, PROFINET/PROFIsafe communication, input
3 M12 socket, D-coded, PROFINET/PROFIsafe communication, output
4 M12 socket, L-coded, voltage supply

Fig. 3.3: Device with connection unit CU400P-4M12

Connection unit CU400P-AIDA
• Four push/pull connectors for power and communication
• PROFINET/PROFIsafe connection via copper cable
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12 31

1 AIDA sockets, PROFINET, push-pull, 5-pin, voltage supply
2 AIDA socket, PROFINET, RJ45 push-pull, 8-pin, Ethernet, input
3 AIDA socket, PROFINET, RJ45 push-pull, 8-pin, Ethernet, output

Fig. 3.4: Device with connection unit CU400P-AIDA

Connection unit CU400P-AIDA-OF
• Four push/pull connectors for power and communication
• PROFINET/PROFIsafe connection via fiber optics

12 31

1 AIDA sockets, PROFINET, push-pull, 5-pin, voltage supply via copper cable
2 AIDA socket, PROFINET, SCRJ push-pull, 2-pin, PROFINET/PROFIsafe communication via fiber-optic cable, in-

put
3 AIDA socket, PROFINET, SCRJ push-pull, 2-pin, PROFINET/PROFIsafe communication via fiber-optic cable, out-

put

Fig. 3.5: Device with connection unit CU400P-AIDA-OF

3.4 Display elements
The display elements of the safety sensors simplify start-up and fault analysis.

3.4.1 RSL 400 LED indicator
Located on the connection unit are the LEDs for displaying the operating state.
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• Protective function A: LEDs 1, 2, 3

1 2 3 4 5 6

1 LED 1, red/green
2 LED 2, yellow
3 LED 3, blue
4 LED 4, blue
5 LED 5, yellow
6 No function

Fig. 3.6: LED indicators

Tab. 3.2: Meaning of the LEDs

LED Color State Description
1 Red/green OFF Device switched off

Red Safety signal off

Red, flashing Error

Green Safety signal on

2 Yellow OFF RES deactivated
RES activated and enabled

Flashing Protective field occupied

ON RES activated and blocked but ready to be unlocked
Protective field free and linked sensor enabled (if applicable)

3 Blue OFF Free warning field

ON Warning field interrupted

4 Blue OFF Four field mode: warning field 3 free

ON Four field mode: warning field 3 interrupted

5 Yellow Flashing Four field mode: warning field 2 interrupted
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3.4.2 LED indicator of PROFINET connection unit
The PROFINET connection units are equipped with an additional LED indicator for displaying the
PROFINET/PROFIsafe communication status.

PWR Power LED, green/red
PS PROFIsafe LED, green/red
NET NET LED, green/red/orange
LNK/ACT1
LNK/ACT2

Link LEDs, green/orange

Fig. 3.7: LED indicators of PROFINET connection units

Tab. 3.3: Meaning of the LEDs

LED Color State Description
PWR Green/red Supply voltage of the PROFINET connection unit

OFF Device not supplied with power or switched off

Red Error during self test or internal communication problems

Green,
flashing

PROFINET wave function active

Green,
continuous
light

Device switched on, supply voltage applied, no internal error

PS Green/red PROFIsafe LED

OFF PROFIsafe communication not initialized or switched off

Green,
flashing

Device in passive state or PROFINET wave function active

Green,
continuous
light

Device on PROFIsafe active

Red, flash-
ing

PROFIsafe configuration failed

Red, con-
tinuous
light

PROFIsafe communication error
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LED Color State Description
NET Red/green/

orange
Ethernet communication

OFF PROFINET communication not initialized or inactive

Green,
flashing

PROFINET bus initialization or PROFINET wave function ac-
tive

Green,
continuous
light

PROFINET active, data exchange with IO controller active

Orange,
flashing

Ethernet topology error

Red, flash-
ing

Ethernet configuration failed, no data exchange or exchange
of invalid data

Red, con-
tinuous
light

Bus error, no communication

LNK/ACT1
LNK/ACT2

Green/or-
ange

Ethernet link

OFF No Ethernet link present

Green,
continuous
light

Ethernet link active, no current data transmission

Green /
orange,
flashing

Ethernet link active, current data transmission

3.4.3 Alphanumerical display
In normal operation, the 24-digit alphanumerical display of the safety sensor shows the monitored protec-
tive and warning field pairs. It also provides assistance during detailed error diagnostics (see chapter 13
"Diagnosis and troubleshooting").

Tab. 3.4: Alphanumerical displays

Display Description Example
Upon startup without configuration/upon initial commissioning
Sensor type Sensor type 420P-M

Software version Software version of the device V5.1

Sensor serial number Sensor serial number SN: 21513123456

Sensor name / Network name Name of the sensor / network A123456789

IP: DHCP/FIX DHCP or permanent IP address IP: DHCP
IP: 10.25.45.2

Bluetooth on/off Bluetooth detection ON/OFF Bluetooth ON



Device description

Leuze electronic GmbH + Co. KG RSL 420P 21

Display Description Example
Configuration necessary Configuration required CONFIG REQUESTED

Repeated until end of booting phase / start phase, then

Spirit level permanent Horizontal alignment in degrees: H
Vertical alignment in degrees: V

H -3° V +9°

Upon startup with configuration
Sensor type Sensor type 450P-XL

Software version Software version of the device V5.1

Sensor serial number Sensor serial number SN: 21513123456

Sensor name / Network name Name of the sensor / network A123456789

IP: DHCP/FIX DHCP or permanent IP address IP: DHCP
IP: 10.25.45.2

Bluetooth on/off Bluetooth detection ON/OFF Bluetooth ON

Date of configuration Date of configuration 11/13/2014 08:15

Signature Signature of configuration DG45L8ZU

Level Horizontal alignment in degrees: H
Vertical alignment in degrees: V

H-3° V+9°

Repeated until end of booting phase / start phase, then

Display following configuration of normal operation
e.g. display of active field pair A1.1

Transfer of the configuration data

AWAITING CONFIG Until downloading of configuration data is confirmed

DOWNLOAD CONFIG During transfer of configuration data

Level

H +/- ..° V +/- .. ° Horizontal alignment in degrees: H
Vertical alignment in degrees: V

H -3° V +9°

Sensor detection

PING received Display for identification by device
name

PING received Device name

Message

Message via a signal output or diag-
nosis ID

ProtF A: E123
Device: P007 - wrong Config

Error diagnostics
F… Failure, internal device error

E… Error, external error

U… Usage info, application error

I… Information

P… Parameter, inconsistency in the con-
figuration

For error diagnostics, the error's respective letter is displayed first followed by the number code. An Au-
toReset is carried out after 10 seconds for errors that do not cause locking, with an unauthorized restart be-
ing impossible. In the case of blocking errors, the voltage supply must be separated and the cause of the
error must be eliminated. Before switching on again, the steps taken before initial commissioning must be
repeated (see chapter 10 "Starting up the device").
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When the protective field has been free for about 5 seconds, the device switches back to the display in nor-
mal operation.

Displays in normal operation
The display in normal operation depends on the operating state of the safety sensor. The display can be
switched off or rotated by 180° by means of the software.

Output of texts on the alphanumerical display
The control can display any text on the alphanumerical display of the safety sensor.
The text can contain up to 32 ASCII characters and is displayed as scrolling text for approx. 40 s.
Listed in the character set table are the characters that can be displayed.
Text is output on the alphanumerical display with an acyclic write command of the control on slot 0 or slot
1, subslot 1, index 70DD.

Tab. 3.5: Character set for alphanumerical display

! “ # $ % & ‘ ( ) * + , - . /
0 1 2 3 4 5 6 7 8 9 : ° < = > ?
@ A B C D E F G H I J K L M N O
P Q R S T U V W X Y Z [ \ ] ^ _
´ a b c d e f g h i j k l m n o
p q r s t u v w x y z { | } ~

3.4.4 Field-of-view display

The upper and lower limit of the safety sensor's field of view can be displayed by means of horizontal lines
on the optics cover.
Ä Make sure that the safety sensor's field of view is always completely unobstructed.

NOTICE

Always check the protective field configuration!
Ä Check all defined protective fields each time the configuration is changed. 

The field-of-view display is a comfort function and is not intended as a substitute for check-
ing the protective field configuration.

Ä The safety sensor's field of view must be completely unobstructed on the application side.

3.5 Mounting system (optional)
Mounting systems and mounting brackets simplify mounting and alignment of the safety sensor. Mounting
systems and mounting brackets are available as accessories (see chapter 18 "Order guide and acces-
sories").

3.6 Loop guard (optional)
The loop guard for the optics cover prevents damage to the safety sensor caused by light contact with for-
eign objects. The loop guard is available as an accessory (see chapter 18 "Order guide and accessories").
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4 Configuration and diagnostic software Sensor Studio
To start up a safety sensor in your application, the safety sensor must be set up according to its specific
use using the configuration and diagnostic software. The software is used to set up the safety configuration
of the safety sensor, to change the communication and diagnostics settings and to perform diagnostic rou-
tines. Communication takes place via the PC.
The software is designed according to the FDT/DTM concept:

• You make the individual configurations for the safety sensor in the Device Type Manager (DTM).
• The individual DTM configurations of a project can be called up via the frame application of the Field

Device Tool (FDT).
• Each device DTM has a communication DTM that sets up and monitors the communication connec-

tions to the sensor.

NOTICE

Only use the software for safety sensors manufactured by Leuze.

4.1 System requirements
To use the software, you need a PC or laptop with the following specifications:

Hard disk space At least 250 MB free memory 
If you want to save the protective field or configuration values, you will
need more memory.

Screen display Color

External drive DVD drive

Input device Keyboard and mouse or touchpad

Output device Printer (black-white or color)

Interfaces RJ45 Ethernet network
Bluetooth (optional) - If the PC does not have integrated Bluetooth technol-
ogy, use an appropriate USB or PCMCIA adapter if necessary.

Operating system Microsoft® Windows 7 or higher

NOTICE

Only the term "PC" is used below.

4.2 Installing software
Prerequisites:

• You do not need the safety sensor to install the software on the PC.
• All Windows applications are closed.

NOTICE

The software is installed in two steps:
Ä Installing the Sensor Studio FDT frame.
Ä Installing LeSafetyCollection device manager (DTM).
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Installing the Sensor Studio software

NOTICE

If FDT frame software is already installed on your PC, you do not need the Sensor Studio instal-
lation.
You can install the device manager (DTM) in the existing FDT frame.

Ä Insert the data carrier.
ð The installation will start automatically.
Ä If installation does not start automatically, double-click the file SensorStudioSetup.exe.
Ä If you want to call up the menu of the CD, double-click the file start.exe.
Ä Select a language for the interface text in the installation wizard and software and confirm with [OK].
ð The installation wizard starts.
Ä Click [Next].
ð The installation wizard opens the software license agreement.
Ä If you want to accept the license agreement, select the appropriate option field and click [Next].
Ä If the suggested installation path is OK, click [Next]. 

If you want to specify a different path, click the [Browse] button. Select a different path, confirm with
[OK] and click [Next].

Ä Click the [Install] button to start installation.

ð The wizard installs the software and places a shortcut on the desktop ( ).
Ä Click the [Finish] button to complete installation.

Installing LeSafetyCollection device manager (DTM)
Prerequisites:

• The Sensor Studio software is installed on the PC.
• Data carrier inserted.
Ä Double-click the file LeSafetyCollectionSetup.exe.
Ä Select a language for the interface text in the installation wizard and software and confirm with [OK].
ð The installation wizard starts.
Ä Click [Next].
ð The installation wizard opens the software license agreement.
Ä If you want to accept the license agreement, select the appropriate option field and click [Next].
Ä If the suggested installation path is OK, click [Next]. 

If you want to specify a different path, click the [Browse] button. Select a different path, confirm with
[OK] and click [Next].

Ä Click the [Install] button to start installation.
ð The wizard installs the software.
Ä Click the [Finish] button to complete installation.

NOTICE

During installation of the software, a user admin (without password query) is created so that you
can start the software without user identification. If other users are registered (Tools > User
management in the FDT frame menu), you must log in at the software with a user name and
password.
This setting allows you to connect to the safety sensor and to read out, upload, enter or change
the safety configuration and all settings using the RSL 400 device DTM. The password for the
safety sensor only needs to be entered (i.e. the access level only needs to be changed) when
the changes are downloaded to the safety sensor (see chapter 4.5.1 "Selecting access level").
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4.3 User interface

2 3

4

5

1

6

7

1 FDT frame menu with toolbar
2 RSL 400 device manager (DTM)
3 Navigation tabs
4 Information area
5 Dialog box
6 Status line
7 Navigation area

Fig. 4.1: User interface of the software

FDT frame menu
The device managers (DTM) of the safety sensors are created and managed in the FDT frame menu.

Device manager DTM
Configuration projects for setting up the selected safety sensor are created and managed in the device
managers (DTM) of the safety sensors.
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Project tree view

21

3

1 FDT frame menu
2 Device manager (DTM) tabs
3 Project tree view

Fig. 4.2: User interface with project tree view

The project tree view shows the structure of the currently installed device managers (DTM). In the project
tree view you can, for example, add copies of an already configured device manager (DTM) quickly and
easily to the DTM structure if you want to operate multiple safety sensors with the same configuration set-
tings.
Example: AGV with safety sensors on front and rear side

4.4 FDT frame menu

NOTICE

You can find complete information on the FDT frame menu in the online help system. Select the
Help menu item in the menu [?].

4.4.1 Project wizard
Using the Project Wizard you can create and change configuration projects for setting up the safety sensor
(see chapter 4.5 "Using configuration projects").

Ä Start the Project Wizard in the FDT frame menu by clicking the  button.

NOTICE

Information on the Project Wizard can be found in the online help for the FDT frame menu under
Sensor Studio Options.
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4.4.2 DTM change
The DTM Change function makes it easier for you to call up the communication DTM of a device or change
from device DTM to communication DTM.
Ä Start the DTM change function in the FDT frame menu by clicking the  button.

NOTICE

Information on DTM change can be found in the online help for the FDT frame menu under Sen-
sor Studio Options.

4.4.3 User management
Using the user management in the FDT frame menu, you can create users, log users in/out and manage
passwords.

Creating users
When creating a user in the user management via Tools > User management in the software frame
menu, select the access level for the user. For information on access permissions and access levels (see
chapter 5.1 "Authorization concept of safety sensor").
Ä In the FDT frame menu, click Tools > User management > Create user.

Logging users in/out
Prerequisites:

• Users have been created
Ä In the FDT frame menu, click Tools > Log in/log out.

Managing passwords
Prerequisites:

• Users have been created
Ä In the FDT frame menu, click Tools > Change password.

NOTICE

Password management via the FDT frame menu applies to all installed device managers (DTM)
of the project.
Whenever write access occurs, the safety sensors of the RSL 400 series always check the ac-
cess level (Engineer, Expert) and the password defined via the device manager (DTM) (SET-
TINGS > Passwords) independently of the password management via the FDT frame menu.

4.4.4 Exiting Sensor Studio
When you have finished making the configuration settings, close the configuration and diagnostics soft-
ware.
Ä Exit the program via File > Exit.
Ä Save the configuration settings as a configuration project on the PC.

You can open the configuration project again at later time via File > Open or with the Sensor Studio Project

Wizard ( ).
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4.5 Using configuration projects
Configuration projects are created and managed in the device manager (DTM) of the selected safety sen-
sor.

NOTICE

During installation of the software, a user admin (without password query) is created so that you
can start the software without user identification. If other users are registered (Tools > User
management in the FDT frame menu), you must log in at the software with a user name and
password.
This setting allows you to connect to the sensor and to read out, upload, enter or change the
safety configuration and all settings using the RSL 400 device DTM. The password for the sen-
sor only needs to be entered (i.e. the access level only needs to be changed) when the changes
are downloaded to the safety sensor (see chapter 4.5.1 "Selecting access level").

Ä Start the configuration and diagnostics software on the PC by double-clicking the  button.
ð The mode selection of the Project Wizard is displayed.
ð If the mode selection is not shown, start the Project Wizard in the FDT frame menu by clicking the

[Project Wizard] button ( ).

Fig. 4.3: Project wizard

Ä Select the configuration mode and click [Next].
ð Automatic connection to a connected safety sensor (Online)
ð Device selection without communication connection (offline)
ð Load a saved project again

ð The project wizard displays the SEARCH DEVICES dialog box.
Ä Select the interface and click the [Start] button.

NOTICE

RSL 400 PROFIsafe devices cannot be integrated in a configuration project using the integrated
search function of the communication DTM.

Ä Define the IP address of the PROFIsafe device using a different tool (e.g. PRONETA from Siemens).



Configuration and diagnostic software Sensor Studio

Leuze electronic GmbH + Co. KG RSL 420P 29

Ä Enter the IP address directly in the device manager (DTM) of the RSL 400P (1).
Ä Click on the [Establish connection with device] button (2).

1

2

Fig. 4.4: Device manager (DTM) – IP address

ð The device manager (DTM) of the safety sensor shows the initial screen for the configuration project.

Fig. 4.5: Initial screen for safety configuration

NOTICE

The device manager (DTM) starts without querying the access level of the user. During commu-
nication with the safety sensor, the safety sensor does however query the access level of the
user. To change the access levels (see chapter 4.5.1 "Selecting access level").

Setting device manager
Using the menus of the device manager (DTM) you can set the parameters of the safety configuration. The
online help system provides information on the menu items and adjustment parameters. Select the Help
menu item in the menu [?].



Configuration and diagnostic software Sensor Studio

Leuze electronic GmbH + Co. KG RSL 420P 30

4.5.1 Selecting access level
Using the device manager you can change the access level of the user if necessary. 
For the authorization concept of the software, see chapter see chapter 5.1 "Authorization concept of safety
sensor".

Ä Click in the DTM menu bar on the [Change access level] button ( ).
ð The Change access level dialog box opens.

Ä In the Access level list, select the item Expert, Engineer or Observer and enter the default password or
the password defined for the individual user.

The following access levels are available:
• Observer can read everything (no password)
• Expert can change communication and diagnostics settings (default password = comdiag)
• Engineer can additionally change the safety configuration (default password = safety)

The password is case-sensitive (i.e. a distinction is made between upper-case and lower-case letters).
Ä Confirm with [OK].

4.5.2 IDENTIFICATION
Detailed information on the menu items and setting parameters can be found in the information area and in
the online help. Select the Help menu item in the menu [?].

• RSL 400 safety laser scanner
• Sensor and configuration data
• Technical data

4.5.3 PROCESS
Detailed information on the menu items and setting parameters can be found in the information area and in
the online help. Select the Help menu item in the menu [?].

• Sensor display 
Device display in the DTM menu

• SENSOR DISPLAY
• STATE OF THE ACTIVE PROTECTIVE AND WARNING FIELDS
• SENSOR DATA

• PROFINET connection unit
• LED INDICATOR
• DIAGNOSIS

• Measurement contour
• Inputs / outputs

• SENSOR DISPLAY
• CONNECTIONS AND SIGNALS

• Simulation – only with access level Engineer
• Measurement contour
• Inputs / outputs

4.5.4 CONFIGURATION
see chapter 9 "Configuring the safety sensor"

NOTICE

You can only transfer changes made in the CONFIGURATION menu to the safety sensor if you
are logged in with the access level Engineer.
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4.5.5 DIAGNOSIS
Adjustment / Alignment
Display of safety sensor alignment using the integrated electronic spirit level
Prerequisites: The software and safety sensor are connected.
Ä In the DIAGNOSIS menu, click the [Align sensor mechanically] button ( ).
ð The safety sensor display shows the horizontal and vertical alignment in degrees.

Visually identify device
If you have installed multiple safety sensors, identify the safety sensor that is connected to the currently
open device manager (DTM).
Prerequisites: The software and safety sensor are connected.
Ä In the DIAGNOSIS menu, click the [Visually identify sensor] button ( ).
ð In the display of the safety sensor connected to the device manager (DTM), the message "PING re-

ceived" flashes for ten seconds.

Reset sensor
Acknowledge messages and faults
Set safety sensor to safety mode

Create and save service file
The service file contains all available information on the safety sensor as well as configuration and settings.
When requesting support, send the service file to the Leuze customer service (see chapter 15 "Service and
support").
Sensor display
Device display in the DTM menu

• SENSOR DISPLAY
• STATE OF THE ACTIVE PROTECTIVE AND WARNING FIELDS
• SENSOR DATA

Diagnostics list
Access list
EventLog

4.5.6 SETTINGS

NOTICE

You can only transfer changes made in the SETTINGS menu to the safety sensor if you are
logged in with the access level Engineer.

Communication
• USB

• DHCP
• CONNECTION SETTINGS
• Sensor data

• Bluetooth
• Activate Bluetooth module
• Activate device scan
• Bluetooth address
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PROFINET communication
Set parameters for PROFINET/PROFIsafe communication.

• IP address
Display of the IP connection settings

• F-parameters
Define PROFIsafe address

• Alarm messages
The safety sensor can make alarms available for diagnostic purposes.

• Alarms are output acyclically.
• If the safety sensor detects an error, it passes this on to the PROFIsafe controller as an alarm.
• The signaling of an alarm takes place as acyclic communication.

Both PROFINET-specific as well as device-specific alarms are realized in the safety sensor. Each
alarm can be selected and deselected individually.
Alarm-specific help texts support the user in rectifying the causes of alarms.

• The alarm-specific help texts are stored in the GSDML file of the device.
• The alarm-specific help text can be displayed on or read out by the PROFIsafe controller.

NOTICE

For safety sensors with PROFIsafe interface, the alarm messages, with the exception of the
PROFIsafe-specific alarms, are activated by default.
Ä If necessary, you can activate the alarms individually via the Sensor Studio configuration

software.

• PROFINET I&M
PROFINET function for the unique identification of the safety sensor.

EventLog
Trigger signals output when certain events occur, are recorded and shown in the event list of the safety
sensor.
Information on the monitored signals can be found in the Sensor Studio configuration software in the infor-
mation area and in the online help. Select the Help menu item in the menu [?].
The EventLog data recorder is activated in a different manner with PROFIsafe devices, depending on the
selected PROFINET module structure (see chapter 11.5 "PROFINET project modules"):

• Project modules [M1] … [M8]:
starting/stopping of the data recorder is set via the PROFIsafe configuration (see chapter 11.5.3 "Mod-
ule [M1] ‑ SAFE_SIGNAL") or via an acyclic command.

• Project modules [M11] … [M17]:
starting/stopping of the data recorder is set via an acyclic command.

Acyclic command for activating/deactivating the event log:
• Slot: 1
• SubSlot: 0
• Index 70DE
• Data:

1 byte
1: activate event log
0: deactivate event log

Sensor display
Activation of the safety sensor alphanumerical display.
Information on the display options can be found in the Sensor Studio configuration software in the informa-
tion area and in the online help. Select the Help menu item in the menu [?].
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Passwords

NOTICE

If a user has forgotten his password for login at the safety sensor or has repeatedly entered the
password incorrectly, he cannot log in at the safety sensor. The CHANGE PASSWORD function
is therefore not available.
To reset the password, a user must generate a reset password and have it confirmed by the
manufacturer.

CHANGE PASSWORD
Ä Define individual passwords for the access levels Engineer and Expert. These passwords replace the

default passwords set by the manufacturer. 
The password is case-sensitive (i.e. a distinction is made between upper-case and lower-case letters).

Reset password
Prerequisites:

• The software is connected to the safety sensor.
Ä Generate a one-time password. 

Note down the generated reset password.
Ä Send the reset password to the Leuze customer service for confirmation (see chapter 15 "Service and

support"). 
The device can now be switched off and the connection can be terminated.

Ä Enter the confirmed reset password and create a new password.

Optics cover
• Monitoring of optics cover
• Dialog box for calibrating a replacement optics cover

Field editor display options
Display settings for the field editor when defining protective/warning fields.

• CONTOUR ALIGNMENT
• INSTALLATION POSITION
• COORDINATE DISPLAY
• EDITOR BEHAVIOR

Information on the display options can be found in the Sensor Studio configuration software in the informa-
tion area and in the online help. Select the Help menu item in the menu [?].
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5 Functions
The functions of the safety sensor must be matched to the respective application and its safety require-
ments. You can activate/deactivate the functions and adapt them using parameters. You configure the
functions with the help of the configuration and diagnostics software (see chapter 9 "Configuring the safety
sensor").

• You configure the functions of the safety sensor in the software as configuration projects.
• In each configuration project you determine the protective function and the configurable field pairs via

the selected function mode.
• The changeover-capable protective/warning field pairs for the selected function mode are defined in

configuration banks.
• You determine the resolution, the start-up behavior, the response time and, where applicable, the vehi-

cle speed together for all protective/warning field pairs of a configuration bank.

5.1 Authorization concept of safety sensor
User management allows target-group-oriented communication between the software and the safety sen-
sor. Which functions are available depends on the selected access level of the user. For information on
the software and on user management (see chapter 4 "Configuration and diagnostic software Sensor Stu-
dio").

• Changing the safety configuration as well as the communication and diagnostics settings of the sensor
is only permitted for certain access levels.

• Installation and operation of the software do not depend on the access level of the user.
The following access levels are available:

Tab. 5.1: Access levels and functions available

Access level Functions
Observer • Display the measurement contour

• Upload and display configuration data from the safety sensor
• Display status information from the safety sensor
• Display diagnostics list
• Customize display
• Display and evaluate the measurement contour
• Load configuration data from the safety sensor
• Load status information from the safety sensor
• Display diagnostics list
• Create service file
• Reset password

Expert In addition to the functions of the Observer
• Load the signed safety configuration from a file and transfer/download to

the safety sensor
• Transfer changed communication and diagnostics settings from the PC

to the safety sensor
• Print configuration data incl. protective/warning fields
• Calibrate optics cover
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Access level Functions
Engineer In addition to the functions of the Expert, full access to all user-relevant func-

tions and parameters:
Create and change a safety configuration:

• Save configuration data to file
• Change all parameters of configuration
• Reset safety sensor to default values
• Define and change protective/warning fields
• Set reference contour in protective field
• Print and delete protective/warning fields
• Load protective/warning field data from file
• Save protective/warning field data
• Transfer protective/warning field data from the PC to the safety sensor
• Change passwords

NOTICE

The software saves individual passwords in the connected safety sensor, thereby ensuring that
only authorized users can change the existing configuration.

Determining access level
When creating a user in the user management via Tools > User management in the FDT frame menu, se-
lect the access level for the user. In the user management you can also create and change passwords for
the users.
Using the device manager (DTM) you can change the access level of the user (see chapter 4.5.1 "Select-
ing access level").

Ä Click in the DTM menu bar on the [Change access level] button ( ).

5.2 Function modes of safety sensor
You configure the functions of the safety sensor in configuration projects with the help of the configuration
and diagnostics software. In each configuration project you determine the protective function and the con-
figurable field pairs via the selected function mode.
You select the function mode of the safety sensor in the software device manager (DTM) with CONFIGU-
RATION > Device function (see chapter 9 "Configuring the safety sensor").
You use the protective function to define the criteria for switching off the safety-related switching outputs
(Parameters for protective function).
The changeover-capable protective and warning field pairs for the selected function mode are defined in
the configuration banks, e.g. CONFIGURATION > Protective function A > Bank A1.

Overview of the function modes

Tab. 5.2: Function modes

Function mode Field pairs (FP) 
Protective fields (PF) 
Warning fields (WF)

Field pair activation

One protective function 1 FP / 1 PF + 1 WF Fixed selection of one field pair

5 FP / 5 PF + 5 WF Selection by signal input:
• Overlapped monitoring

10 FP / 10 PF + 10 WF Selection by signal input:
• Fixed changeover moment
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5.2.1 One protective function
Ten changeover-capable field pairs for safety-related switching signals A_SAFE_xx_CLEAR. For the field
pair changeover, see chapter 5.7 "Field pair changeover".

5.3 Selectable resolution for hand, leg and body detection
The application-specific resolution of the safety sensor is defined in the configuration project together for all
protective/warning field pairs of a configuration bank.

Tab. 5.3: Resolution of the safety sensor depending on the function

Safety sensor resolution
[mm]

Function Application(s)

30 Hand detection Point of operation guarding

40 Arm detection Point of operation guarding

50 Leg detection with the safety sensor
mounted close to floor level

Danger zone safeguarding

60 • Leg detection with the safety
sensor mounted at a height of
150 mm

• Leg detection and detection of
lying persons in the case of
mounting on vehicles, mounting
height approx. 200 mm

Stationary danger zone safeguarding 
Mobile danger zone safeguarding

70 • Leg detection with the safety
sensor mounted at a height of
300 mm

Stationary danger zone safeguarding 
Mobile danger zone safeguarding

150 Body detection Access guarding 
Mobile side guarding

Mounting height = Height of the scan level above floor level

5.4 Speed-dependent protective function for vehicles
For object detection in the case of mobile applications, the safety sensor evaluates the relative speed of the
object. If the safety sensor is mounted on vehicles or on moving parts of machines, the maximum speed of
the vehicle must be entered during configuration of the protective function.
The maximum vehicle speed (Max. AGV speed) is selected in the configuration project together for all pro-
tective/warning field pairs of a configuration bank.

5.5 Response time
The response time is the maximum time from a protective field violation to switch-off of the safety-related
switching outputs.
The response time is selected in the configuration project together for all protective/warning field pairs of a
configuration bank.
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5.6 Configurable start-up behavior
The start-up behavior is selected in the configuration project together for all protective/warning field pairs of
a configuration bank.

5.6.1 Automatic start/restart
The machine starts automatically as soon as the machine is switched on or the supply voltage returns and
when the protective field is free again.

Using automatic start/restart
You can use the automatic start/restart function under the following prerequisites:

• The start/restart interlock function is taken over by a downstream safety-related component of the ma-
chine control system.
or:

• It is not possible to walk behind or go around the effective protective field.
Ä Allow for an optical and/or acoustic start warning.

Automatic start-up
The automatic start-up function starts the machine automatically as soon as the supply voltage is present.

Automatic restart
The automatic restart function starts the machine automatically as soon as the protective field is free again.

5.6.2 Start interlock/automatic restart
With start interlock/automatic restart, the safety sensor remains in the OFF state when, following a power
supply interruption, the voltage supply is restored. After violation of the protective field, the system restarts
when the protective field is free again.
The start/restart interlock has two functions:

• Start interlock
• Automatic restart

Using start interlock/automatic restart
Ä In addition to the safety sensor you must also install the reset button. The machine operator starts the

machine with this reset button.
Ä Position the reset button outside the danger zone so that it cannot be activated from the protective

fields and danger zones. The operator must be able to see all danger zones from this position.
Ä Identify the area to be released on the reset button so that its meaning is clear and easy to understand.
Ä Ensure that nobody is in the danger zone before pressing the reset button.
Ä Hold down the reset button for between 0.12 s and 4 s to enable the safety-related switching outputs.

DANGER

Risk of death if start-up is operated unintentionally!
Ä Ensure that the reset button for unlocking the start interlock cannot be reached from the

danger zone.
Ä Before unlocking the start interlock, make certain that no people are in the danger zone.

Start interlock
The start interlock function prevents the machine from starting automatically after switching on or after the
supply voltage returns.
The machine only starts when you press the reset button.

Automatic restart
The automatic restart function starts the machine automatically as soon as the protective field is free again.
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5.6.3 Start/restart interlock (RES)
When accessing the protective field, the start/restart interlock ensures that the safety sensor remains in the
OFF state after the protective field has been cleared. It prevents automatic release of the safety circuits
and automatic start-up of the system, e.g. if the protective field is again clear or if an interruption in the volt-
age supply is restored.
The start/restart interlock has two functions:

• Start interlock
• Restart interlock

NOTICE

For access guarding, the start/restart interlock function is mandatory. The protective device may
only be operated without start/restart interlock in certain exceptional cases and under certain
conditions acc. to ISO 12100.

Using start/restart interlock
Ä In addition to the safety sensor you must also install the reset button. The machine operator starts the

machine with this reset button.
Ä Position the reset button outside the danger zone so that it cannot be activated from the protective

fields and danger zones. The operator must be able to see all danger zones from this position.
Ä Identify the area to be released on the reset button so that its meaning is clear and easy to understand.
Ä Ensure that nobody is in the danger zone before pressing the reset button.
Ä Hold down the reset button for between 0.12 s and 4 s to enable the safety-related switching signals.

DANGER

Risk of death if start/restart is operated unintentionally!
Ä Ensure that the reset button for unlocking the start/restart interlock cannot be reached from

the danger zone.
Ä Before unlocking the start/restart interlock, make certain that no people are in the danger

zone.

Start interlock
The start interlock function prevents the machine from starting automatically after switching on or after the
supply voltage returns.
The machine only starts when you press the reset button.

Restart interlock
The restart interlock function prevents the machine from starting automatically, as soon as the protective
field is free again. The restart interlock function always includes the start interlock function.
The machine only starts again when you press the reset button.

5.7 Field pair changeover
The safety sensor has ten field pairs. Switchover between the field pairs is possible at all times, provided
the operating situation allows this.
Use the field pair changeover when the danger zones vary depending on the activity of the machine or the
operating state, e.g. automated guided vehicles (AGVs), to control the field pair changeover for straight and
curved stretches.
If the rules for field pair changeover are not complied with, the safety sensor signals a fault and the safety-
related switching signals are switched off.
The safety sensor has the following modes for field pair activation and field pair changeover:

• Fixed selection of one field pair
• Selection by signal inputs with the changeover mode Overlapped monitoring
• Selection by signal inputs with the changeover mode Fixed changeover moment
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Field pair activation and field pair changeover are configured via the protective function, e.g. CONFIGURA-
TION > Protective function A > MODE FOR FIELD PAIR ACTIVATION AND CHANGEOVER.
The field pair changeover can be monitored by means of configurable measures (see chapter 5.8 "Monitor-
ing of field pair changeover").
During the changeover process, the safety sensor monitors the field pair active before the field pair
changeover, according to the configured changeover mode and changeover time.

Using field pair changeover
You can configure and switch over the field pairs according to the different requirements. The field pairs are
changed over via the corresponding control inputs.
The rules for field pair changeover depend on the changeover mode and changeover time. The activated
field pair must correspond with the respective operating mode. The time of the field pair changeover must
correspond with the machine's risk assessment. You must take the lead time, braking distances, response
times and machine stopping times, e.g. influenced by overlapping protective fields, into account.
If the rules are not observed, the safety-related switching signals switch off and a message is displayed
(see chapter 13 "Diagnosis and troubleshooting").
The following rules apply for the field pair changeover: 

• The field pair changeover performed by the control system must agree with the safety sensor's configu-
ration. This configuration is specified with the configuration and diagnostics software (see chapter 9.4
"Configuring protective function").

• With field pair changeover to an occupied protective field, the safety sensor only switches off the
safety-related switching signals after the set response time plus a synchronization time of 40 ms.

NOTICE

Take the lead time into consideration!
Ä Take the lead time of the changeover time and response time into consideration before op-

erating the machine in its new operating situation.

5.7.1 Fixed selection of one field pair
If Fixed selection of one field pair is set as the mode for field pair activation, field pair A1.1 is monitored
irrespective of how the control inputs are connected.

5.7.2 Changeover of five field pairs in changeover mode Overlapped monitoring
Changeover mode Overlapped monitoring: This changeover mode is only permitted for up to five field
pairs.
The field pair changeover must take place within a configurable time period of the changeover time. Two
field pairs can be monitored simultaneously during the changeover time.

• First the control unit must switch to a new field pair before it switches off the previously active one.
• A maximum of two field pairs are active.

Each field pair is then only active if it is selected by the control unit.
• The changeover time starts when the second field pair is connected. When the changeover time has

expired, only one field pair should still be active.
• The changeover time is specified with the configuration and diagnostics software (see chapter 9.4.4

"Creating and configuring protective/warning field pairs").
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Tab. 5.4: Connection of control inputs F1 to F5 with activation of field pairs A1.1 to A1.5 for protective function A

Field pair Control input Description
F1 F2 F3 F4 F5

A1.1 1 0 0 0 0 Field pair A1.1 is active

A1.2 0 1 0 0 0 Field pair A1.2 is active

A1.3 0 0 1 0 0 Field pair A1.3 is active

A1.4 0 0 0 1 0 Field pair A1.4 is active

A1.5 0 0 0 0 1 Field pair A1.5 is active

In the case of two protective functions, connection of control inputs F6 to F10 applies analogously for acti-
vation of field pairs B1.1 to B1.5 for protective function B.

PF1.1

PF1.2

PFA…

PFA.x

1

2 3

5

4

0

1

A1.2

0

0

0

1

XX XX

0

1

0

0

A1.2 & A1.x A1.x

0

1

1 Active protective field
2 An old protective field is active
3 Set changeover time
4 A new protective field is active
5 Changeover complete
PF Field pair or quad
X X Field pair changeover

Fig. 5.1: Signal/time diagram: Overlapped monitoring

5.7.3 Changeover of ten field pairs in changeover mode Fixed changeover moment
Changeover mode Fixed changeover moment: The field pair changeover must take place within the con-
figurable changeover time, i.e. after the changeover time has expired, a valid and stable input connection
must be present. The old field pair is monitored during the changeover time.

• The previously active field pair is monitored during the changeover time.
• The changeover time starts when the safety sensor registers a change at control inputs F1 to F5. When

the changeover time has expired, only one field pair should still be active.
• Monitoring of the newly activated field pair starts when the changeover time has expired.
• The changeover time is specified with the configuration and diagnostics software (see chapter 9.4.4

"Creating and configuring protective/warning field pairs").
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Tab. 5.5: Connection of control inputs F1 to F5 with activation of field pairs A1.1 to A1.10 for protective function A

Field pair Control input Description
F1 F2 F3 F4 F5

A1.1 1 0 0 0 0 Field pair A1.1 is active

A1.2 0 1 0 0 0 Field pair A1.2 is active

A1.3 0 0 1 0 0 Field pair A1.3 is active

A1.4 0 0 0 1 0 Field pair A1.4 is active

A1.5 0 0 0 0 1 Field pair A1.5 is active

A1.6 1 1 1 1 0 Field pair A1.6 is active

A1.7 1 1 1 0 1 Field pair A1.7 is active

A1.8 1 1 0 1 1 Field pair A1.8 is active

A1.9 1 0 1 1 1 Field pair A1.9 is active

A1.10 0 1 1 1 1 Field pair A1.10 is active

In the case of two protective functions, connection of control inputs F6 to F10 applies analogously for acti-
vation of field pairs B1.1 to B1.10 for protective function B.

2 3 4

PF1.1

PF1.2

PFA…

PFA.x

1

5

7

6

0 0

1

A1.2

0

0 0

1 1

1

XX

0 1

1 1

0

00 0

A1.2 A1.x

0

0

0

0

0

1

1 Active protective field
2 An old protective field is active
3 Set changeover time
4 A new protective field is active
5 Initiation of the field pair changeover caused by a change in the signal – the old protective field is monitored

until the end of the changeover time
6 Fixed end – field pair changeover complete
7 … Only one field pair change
PF Field pair or quad
X X Field pair changeover

Fig. 5.2: Signal/time diagram: Overlapped monitoring
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5.8 Monitoring of field pair changeover
The Changeover order function determines the permissible field pair changeovers, e.g. if field pair A1.3
must be changed over to field pair A2.5. If the Changeover order function is active, the safety-related
switching signals (OSSDs) switch off in the following cases:

• the control initiates an impermissible field pair changeover.
• the field pair to which the system is changed over has been deactivated.

Activating the function
Ä The Changeover order is defined using the configuration and diagnostics software (see chapter 9.5

"Defining permissible field pair changeovers").

5.9 Reference contour monitoring
The reference contour monitoring function prevents unintentional misalignment and deliberate manipulation
of the safety sensor. If a protective field contains an area with reference contour, the safety sensor not only
monitors interruptions of the protective field, it also monitors the concurrence of the measured area contour
with the set reference contour. If the measurement values of the area contour deviate from the defined ref-
erence contour by more than the tolerance zone of 200 mm, i.e., if no object is detected in the area with
reference contour, the safety sensor switches off and the safety-related switching signals switch to off.

Activation of the function
Ä Activate the Reference contour monitoring function together with the definition of the protective field

boundaries using the configuration and diagnostics software (see chapter 9.4.4 "Creating and configur-
ing protective/warning field pairs").

5.10 Field pair monitoring
The Field pair monitoring function is used to set the monitoring mode for the selected field pair.
The Standby request monitoring mode is used to switch off field pair monitoring and the safety-related
switching signals. This is advisable when parking vehicles, for example.

Activation of the function
Ä Activate field pair monitoring in the configuration and diagnostics software (see chapter 9.4.5 "Configur-

ing field pair monitoring").

5.11 Signaling functions
The device and monitoring functions of the safety sensor deliver indication signals for the following function
groups:

• Protective functions, e.g.
• Protective field violated
• Warning field violated
• Field pair changeover active

• Device functions
• Error messages
• Warnings
• Diagnosis

For an overview of all logic and electrical signals of the safety sensor, see chapter 16.4 "PROFIsafe status
profile".



Applications

Leuze electronic GmbH + Co. KG RSL 420P 43

6 Applications
The following chapters essentially describe the safety sensor's usage possibilities.

• To safely mount the safety sensor for the respective application, see chapter 7 "Mounting".
• For the electrical connection of the safety sensor, see chapter 8 "Electrical connection".
• To safely configure the safety sensor for the respective application, see chapter 9 "Configuring the

safety sensor".

6.1 Stationary danger zone guarding
Stationary danger zone guarding enables a very spacious protection of people on machines that are to re-
main as accessible as much as possible. The safety sensor is applied as a stop-activating and presence-
detecting protective device. The safety sensor's protective field is set up horizontally in front of the machine
or system's point of operation.
You can also use the stationary danger zone guarding if you do have to guard areas under the machine or
at the rear that are not visible.
If the danger zone changes during operation, the respective danger zone is guarded by means of a field
pair changeover while the working area is accessible.

2

1

1 Safety sensor
2 Danger zone, protective function activated

Fig. 6.1: Stationary danger zone guarding

6.2 Stationary point of operation guarding
Hand and arm protection are always required when people must work at the point of operation. The safety
sensor is applied as a stop-activating and presence-detecting protective device. The safety sensor's pro-
tective field is set up vertically in front of the machine or system's point of operation. In accordance with
EN ISO 13855, resolutions from 14 to 40 mm make sense here. This yields the necessary safety distance
for finger protection, among others (see chapter 7.3 "Stationary point of operation guarding").
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6.3 Mobile danger zone guarding
Mobile danger zone guarding protects people that are located in the transportation path of an automated
guided vehicle (AGV). The distance between the protective field front edge and the vehicle front must be
greater than the stopping distance of the vehicle with selected speed and maximum load. A safe control
system selects speed-dependent protective fields and can activate side horizontal protective fields for
curved stretches.

3

4

5
6

2

1

1 Warning field for forward travel
2 Protective field 1 for forward travel, deactivated
3 Protective field 2 for forward travel, activated
4 Protective field 1 for reverse travel, activated
5 Protective field 2 for reverse travel, deactivated
6 Warning field for reverse travel

Fig. 6.2: Mobile danger zone guarding
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1

2

6
5

3

4

1 Warning field for forward travel
2 Protective field 1 for forward travel, deactivated
3 Protective field 2 for forward travel, activated
4 Protective field 1 for reverse travel, activated
5 Protective field 2 for reverse travel, deactivated
6 Warning field for reverse travel

Fig. 6.3: Mobile danger zone guarding
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6.4 Danger zone safeguarding on side-tracking skates

Side-tracking skate guarding
Side-tracking skate guarding protects personnel who are located in the transportation path of a transverse
side-tracking skate (TSS). One safety sensor is mounted in each direction of travel. The safety sensor that
is mounted opposite the current direction of travel is deactivated. Evaluation of the warning field allows the
transverse side-tracking skate to be braked gently. To ensure optimum material transport, the control
changes over the protective/warning field pair depending on the state and speed.

Mobile side guarding
Mobile side guarding protects people and objects that are located on the vehicles path. This application is
used when very low arranged roller conveyors do not permit an unobstructed passage of horizontal, lateral
protrude protective fields. The safety sensors are positioned laterally and the protective fields are arranged
vertically, at a slight tilt. The position of the front edges of the side protective fields is oriented here on the
position of the front edge of the horizontal protective field.

3

4

2

1

1 Protective and warning field pair for forward travel, activated
2 Protective and warning field pair for side guarding, left, activated
3 Protective and warning field pair for side guarding, right, activated
4 Protective and warning field pair for reverse travel, deactivated

Fig. 6.4: Mobile side guarding on side-tracking skates
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7 Mounting
The safety sensor's protective function is only guaranteed when the device arrangement, configuration,
protective field dimensioning and mounting are coordinated with the respective application.
The installation work must only be performed by a competent person in compliance with the applicable
standards and these instructions. The mounting must be thoroughly inspected on completion.
Ä You must observe and comply with the respective relevant machine-specific standards and regulations

(see chapter 17 "Standards and legal regulations").
Ä Observe the basic information on mounting (see chapter 7.1 "Basic infos").

WARNING

Improper mounting may result in serious injury!
The protective function of the safety sensor is only ensured if appropriately and professionally
mounted for the respective, intended area of application.
Ä Only allow competent persons to install the safety sensor.
Ä Maintain the necessary safety distances (Calculation of safety distance S).
Ä Make sure that stepping behind, crawling under or stepping over the protective device is reli-

ably ruled out and reaching under, over or around is taken into account in the safety dis-
tance, if applicable with additional distance CRO corresponding to EN ISO 13855.

Ä Take measures to prevent that the safety sensor can be used to gain access to the danger
zone, e.g. by stepping or climbing into it.

Ä Observe the relevant standards, regulations and these instructions.
Ä After mounting, check the safety sensor for proper function.
Ä Clean the safety sensor at regular intervals. 

Environmental conditions: see chapter 16 "Technical data" 
Care: see chapter 14 "Care, maintenance and disposal"

7.1 Basic infos

7.1.1 Calculation of safety distance S
Optical protective devices can only perform their protective function if they are mounted with adequate
safety distance. When mounting, all delay times must be taken into account, such as the response times of
the safety sensor and control elements, the stopping time of the machine as well as the PROFIsafe watch-
dog time, among others.
The following standards specify calculation formulas:

• EN ISO 13855, "Safety of machines - The positioning of protective device in respect of approach
speeds of parts of the human body": mounting situation and safety distances.

General formula for calculating the safety distance S of an Optoelectronic Protective Device acc. to
EN ISO 13855

S [mm] = Safety distance
K [mm/s] = Approach speed
T [s] = Total time of the delay, sum from (ta + ti + tm + tPS)
ta [s] = Response time of the protective device
ti [s] = Response time of the safety control
tm [s] = Stopping time of the machine
tPS [s] = PROFIsafe watchdog time
C [mm] = Additional distance to the safety distance
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NOTICE

If longer stopping times are determined during regular inspections, an appropriate additional
time must be added to tm.

7.1.2 Suitable mounting locations
Area of application: Mounting
Tester: Technician who mounts the safety sensor

Tab. 7.1: Checklist for mounting preparations

Check: Yes No
Is the safety distance to the hazard location maintained?

Has the scanning angle of the safety sensor as given on the marking/template on
the top of the sensor been taken into consideration?

Can the point of operation or the danger zone only be accessed through the pro-
tective field?

Have measures been taken to prevent the protective field from being bypassed by
crawling under?

Is stepping behind the protective device prevented or is mechanical protection
available?

Can the safety sensors be fastened in such a way that they cannot be moved and
turned?

Is the safety sensor accessible for testing and replacing?

Is it impossible to actuate the reset button from within the danger zone?

Can the entire danger zone be seen from the installation site of the reset button?

NOTICE

If you answer one of the items on the checklist with no, the mounting location must be changed.

7.1.3 Mounting the safety sensor

NOTICE

Detailed information on mounting the safety sensor can be found in the document "Quick Start
Guide RSL 400".

Proceed as follows:
Ä Calculate the necessary safety distance and determine the required additional distances for your appli-

cation.
Ä Determine the mounting location.
• Observe the information regarding the mounting locations; see chapter 7.1.2 "Suitable mounting loca-

tions"
• Ensure that machine parts, safety guards or covers do not impair the safety sensor's field of vision.
• Make sure that the scanning range of the safety sensor is not limited. To mount the safety sensor tak-

ing the scanning range into consideration, a template must be attached to the top cover of the safety
sensor.
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40

2
1

2

4

5

5

1

3

all dimensions in mm
1 Safety sensor
2 Template (markings on safety sensor)
3 Mounting location
4 Reference point for distance measurement and protective field radius
5 Area with unobstructed view; must remain free

Fig. 7.1: Mounting taking the scanning range of 270° into consideration

1

2

1

2

all dimensions in mm
1 Scan level
2 Area with unobstructed view; must remain free (40 mm)

Fig. 7.2: Mounting: area with unobstructed view
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Ä Determine whether you are going to install the safety sensor with or without the mounting system. 
During mounting, use the four supplied M5 screws or four similar screws with a diameter of 5 mm, and
make certain that the mounting elements or mounting construction supports at least four times the
weight of the device with or without mounting system.

Ä Have the appropriate tools at the ready and mount the safety sensor.

1 2

All dimensions in mm
1 Screw connection of safety sensor with connection unit CU400P-3M12
2 Screw connection of safety sensor with connection unit CU400P-AIDA or CU400P-AIDA-OF

Fig. 7.3: Mounting

Ä Install protective enclosures or safety bars if the safety sensor is in an exposed position.
Ä If there is a risk that the safety sensor will be used as a climbing aid, install a suitable physical cover

over the safety sensor.
Ä Align the mounted safety sensor horizontally and vertically using the integrated electronic spirit level.
• For the electronic spirit level to work, the supply voltage of 24 V must be present at the safety sensor.
• The electronic spirit level indicates the vertical (V) and horizontal (H) alignment of the safety sensor. 

The spirit level is displayed
• permanently after the end of the booting phase/start phase when starting without configuration
• repeatedly until the end of the booting phase/start phase when starting with configuration
• using the configuration and diagnostic software: 

Diagnosis > [Align sensor mechanically] button ( )
• When mounting without a mounting system, the safety sensor can be aligned only slightly along the

horizontal axis.
Ä Attach safety notice stickers to the mounted safety sensor (the stickers are included in the delivery con-

tents).
Ä Configure the safety sensor with the configuration and diagnostics software; see chapter 9 "Configuring

the safety sensor":
• Observe the information on the response times, the stopping time of the machine and the protective

field dimensioning for your application.
• Determine the size of the protective field on the basis of the mounting location, the calculated safety

distances and additional distances.
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NOTICE

With protective field boundaries <200 mm, object detection may be restricted owing to the mea-
surement error.
Ä When defining the protective field, take into account the additional distance Zsm to the pro-

tective field contour (see chapter 7.2 "Stationary danger zone guarding").

• Configure the protective field so that the safety-related switching outputs are switched off from every
accessible point with sufficient minimum distance D.

• Determine the start-up/restart operating mode required for the application.
• If you are using start and/or restart interlock, determine the position for the reset button.
• Many safety-relevant parameters are preset for each application in the configuration and diagnostics

software. Use these preset values where possible.
• Determine the conditions for the field pair changeover and the sequence of the field pair changeover.
Ä Create a record document for the device configuration and protective field dimensioning.
• The document must be signed by the person responsible for the configuration.
• Include this document with the machine documentation.
Ä Mark the protective field boundaries on the floor. 

You can easily test the safety sensor along this marking.
After mounting, you can electrically connect (see chapter 8 "Electrical connection"), start up, align (see
chapter 10 "Starting up the device"), and test (see chapter 12 "Testing") the safety sensor.

7.1.4 Mounting examples

5
4

,6

54,6

1

2

3

all dimensions in mm
1 Safety sensor
2 Column
3 BT856M mounting bracket

Fig. 7.4: Example: mounting on a post
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1

4
0

40

2

all dimensions in mm
1 Safety sensor
2 BT840M mounting bracket

Fig. 7.5: Example: mounting on a chamfered corner

2 3

1

1 BTF815M mounting bracket (only in combination with the BTU800M mounting system)
2 BTU800M mounting system
3 Safety sensor

Fig. 7.6: Example: mounting on floor
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7.1.5 Information on protective field dimensioning

NOTICE

With protective field boundaries <200 mm, object detection may be restricted owing to the mea-
surement error.
Ä When defining the protective field, take into account the additional distance Zsm to the pro-

tective field contour (see chapter 7.2 "Stationary danger zone guarding").

Ä Dimension the protective field big enough that the safety sensor's switching signal can stop the danger-
ous movement in good time. 
If several protective fields are selected with field pair changeover, this condition applies for all protec-
tive fields.
If you cannot sufficiently dimension a protective field, use additional protective measures, e.g. safety
guards.

Ä Ensure that the protective field cannot be walked behind in the direction of the danger zone.
Ä Observe all delay times, e.g. safety sensor response times, control element response times,

PROFIsafe watchdog time, braking times or stopping times of the machine or automated guided vehicle
(AGV).

Ä Take changed delay times, which, for example, can be caused by reducing the braking force, into ac-
count.

Ä Observe shadowing effects, e.g. surfaces and areas behind static objects. People in the shadows of
these objects will not be detected by the safety sensor.

Ä Observe the lateral tolerance when dimensioning the protective fields (see chapter 16 "Technical
data").

Ä Do not use cone-shaped protective field contours, as these do not guarantee any protective function.
Ä Take the additional distances required for the application into account.

Handling unmonitored areas
There is an area behind the safety sensor that the safety sensor does not monitor. Unmonitored areas can
also materialize, e.g. if you install a safety sensor on a rounded off vehicle front.
It must not be possible to walk behind unmonitored areas.

1 2 3

1 Safety sensor
2 Protective field
3 Unmonitored area; 

Optimum availability at a distance of 50 mm to fixed contours

Fig. 7.7: Unmonitored area

Ä Prevent access to an unmonitored area with screens.
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Ä Prevent walking behind by countersinking the safety sensor into the machine contour.

3

2

1

1

4 5 4 53

6

1 Countersinking into the machine contour, min. 100 mm
2 Minimum distance above the scanner unit, min. 34 mm
3 Protective field
4 Safety sensor
5 Machine
6 Angled physical cover

Fig. 7.8: Stepping behind protection by countersinking into the machine contour

Ä Use a physical cover set at an angle over the safety sensor if you expect that the safety sensor will be
used as a climbing aid or standing surface.
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Protective field setup with adjacent safety sensors
The safety sensor has been developed in a way that prevents several safety sensors from interfering with
one another as much as possible. Nevertheless, if several safety sensors are positioned adjacent to each
other, this may result in a reduction in the availability of the safety sensors.
Ä When mounting the safety sensor, avoid glossy surfaces directly behind the optics cover.
Ä Plan for shielding with stationary applications. 

The shielding must be at least as high as the safety sensor's optics cover and embedded with the front
housing edge. 
If you plan for a shielding that is still within the countersinking in the machine contour, the resolution of
the protective fields must not be impaired at any accessible points. 
You require the reciprocal shielding with both horizontal and vertical alignment of the protective fields.

2 23

4 4

51 1

1 Point of operation
2 Safety sensor
3 Machine with countersinking for sensor installation
4 Protective fields
5 Shielding

Fig. 7.9: Shielding prevents reciprocal influencing of safety sensors set up beside one another

Ä Install the safety sensors off-set on the height.

1

2

2

1 Minimum distance, min. 100 mm
2 Scan level

Fig. 7.10: Height offset mounting, parallel alignment
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Ä Install the safety sensors with crossed alignment.

11

1 Scan level

Fig. 7.11: Mounting beside one another, without height offset, crossed alignment

11

1 Scan level

Fig. 7.12: Mutually opposing mounting, without height offset, crossed alignment

7.2 Stationary danger zone guarding
The safety sensor takes over the stop-activating and presence-detecting function.

Calculation of safety distance S for parallel approach to the protective field

SRO [mm] = Safety distance
K [mm/s] = Approach speed for danger zone guarding with approach direction parallel to the protective

field (resolution up to 90 mm): 1600 mm/s
T [s] = Total time of the delay, sum from (ta + ti + tm + tPS)
ta [s] = Response time of the protective device
ti [s] = Response time of the safety control
tm [s] = Stopping time of the machine
tPS [s] = PROFIsafe watchdog time
C [mm] Additional distance for danger zone guarding with approach reaction 

H = height of the protective field, Hmin = minimum installation height permitted, but no smaller
than 0, d = resolution of the protective device C = 1200 mm - 0.4 × H; Hmin = 15 × (d - 50)

Response times, stopping time of the machine
The safety sensor's rotary mirror rotates on its own axis every 40 ms. One revolution is a scan. At least two
consecutive scans must be interrupted so that the safety-related switching outputs switch off. The safety
sensor's minimum response time is therefore 80 ms.
If you want to increase the safety sensor's availability in an environment with fine particles, increase the
number of interrupted scans after which the safety-related switching outputs switch off. With each addi-
tional scan the response time ta increases by 40 ms. With K = 1600 mm/s the safety distance increases by
64 mm per additional scan.
Ä Select a response time ta of at least 120 ms or higher.
Ä Determine the machine/system's stopping time tm. 

If data is not available, you can commission Leuze to perform measurements; see chapter 15 "Service
and support".

Ä If an increase in the stopping time within the regular test periods is to be expected, take an additional
time into account for the machine's stopping time tm.
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Additional distance C for danger zone guarding with approach reaction
You prevent reaching the point of operation by reaching over with the additional distance C:

H [mm] = Height of protective field above floor (installation height)
CMIN [mm] = 850 mm
HMAX [mm] = 1000 mm

The minimum permissible installation height depends on the resolution of the safety sensor:

Tab. 7.2: Additional distance C depending on the resolution of the safety sensor

Safety sensor resolution (mm) Minimum permissible installation
height (mm)

Additional dis-
tance C (mm)

50 0 1200

60 150 1140

70 300 1080

Application-related additional distances for safety distance S
The protective field boundaries must be defined so that the calculated safety distance S to the point of op-
eration, extended by the additional distances, is complied with everywhere. Where this is not possible or
does not make sense, you can use hard guards as supplementary measures.

S D

D

S

R
G DS

1

2

3

4

1 Routing machine with free space for sensor protective field in the area under the machine table
2 Safety sensor
3 Protective field contour
4 Warning field contour
S Calculated safety distance S
D Minimum distance D (= safety distance S + additional distance ZSM + ZREFL, where required)
RG Largest protective field radius without additional distances, measured from the rotation axis of the rotary

mirror

Fig. 7.13: Defining the protective field contour for a stationary, horizontal protective field

Ä Define the limits of the protective field using the safety distance S without an additional distance.
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Ä Determine the biggest protective field radius RG for this protective field. 
The biggest protective field radius determines the additional distance ZSM for the system-related mea-
surement error, by which the protective field contour must be enlarged. 
The position of the rotary mirror's center point with regard to the housing is provided by the dimen-
sioned drawings.

Tab. 7.3: Additional distance ZSM for the protective field contour because of measurement error

Biggest protective field radius RG without additional distances Additional dis-
tance ZSM

< 6.25 m 100 mm

> 6.25 m 120 mm

Ä Avoid retro-reflectors at the beam level beyond the protective field boundaries. If this is not possible,
add another additional distance ZREFL of 100 mm.

Minimum distance D to the protective field contour
The minimum distance D is the distance between point of operation and protective field contour.

D [mm] = Minimum distance between the point of operation and the protective field contour
ZSM [mm] = Additional distance for system-related measurement error
ZREFL [mm] = Additional distance for retro-reflectors

Ä If the protective field runs up against fixed boundaries, such as walls or machine frames, take a coun-
tersinking into the machine contour of at least the size of the necessary additional distance ZSM, and
ZREFL where required, into account. With the protective field contour under these conditions, stay about
50 mm away from the machine surface.

Ä If the protective field runs up against hard guards, ensure that the protective field ends under instead of
in front of the hard guards. The width of the lower post must correspond with the size of the required
additional distances.

Ä If all hazards in the fenced off area are covered by the safety sensor and the height of the beam level is
300 mm, you can raise the bottom edge of the hard guards from 200 mm to 350 mm in the protective
field range. The protective field reaching to under the hard guards takes over the protective function of
preventing an adult from crawling under in this case.

NOTICE

The beam level of the safety sensor is level with the alphanumerical display.

Ä Prevent obstructions within the calculated protective field boundaries. If this is not possible, implement
protective measures so that the point of operation cannot be reached from out of the shadow of the ob-
struction.
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7.3 Stationary point of operation guarding
The safety sensor takes over the stop-activating and presence-detecting function.
Calculation of safety distance SRO for access over the vertical protective field

SRO [mm] = Safety distance
K [mm/s] = Approach speed for point of operation guarding with approach reaction and normal approach

direction to the protective field (resolution 14 to 40 mm): 2000 mm/s or 1600 mm/s, when
SRO > 500 mm

T [s] = Total time of the delay, sum from (ta + ti + tm + tPS)
ta [s] = Response time of the protective device
ti [s] = Response time of the safety control
tm [s] = Stopping time of the machine
tPS [s] = PROFIsafe watchdog time
CRO [mm] = Additional distance in which a body part can move towards the protective device before the

protective device triggers

Response times, stopping time of the machine
The safety sensor's rotary mirror rotates on its own axis every 40 ms. One revolution is a scan. With each
additional scan the response time ta increases by 40 ms. With K = 2000 mm/s approach speed this corre-
sponds with an increase in the safety distance of 80 mm per additional scan. With K = 1600 mm/s it is
64 mm.
Ä Select a response time ta of at least 80 ms or higher.
Ä Determine the machine/system's stopping time tm. 

If data is not available, you can commission Leuze to perform measurements (see chapter 15 "Service
and support").

Ä If an increase in the stopping time within the regular test periods is to be expected, take an additional
time into account for the machine's stopping time tm.

Additional distance CR0 for finger protection
The required finger protection is ensured here by an additional distance C, which depends on the safety
sensor resolution, in addition to the safety distance.

• Detection of an adult's hand:
• Resolution: 30 mm
• Additional distance CRO: 128 mm

• Arm detection:
• Resolution: 40 mm
• Additional distance CRO: 208 mm
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Protective field contour and reference contour
With a vertical protective field, you must define at least two sides of the protective field contour as refer-
ence contour. The objective is to monitor the position of the protective field with regard to its marginal area.
If the arrangement misaligns and the distance of the safety sensor to the reference surface changes as a
result, switch the safety-related switching outputs off.

e

e

S

2

3

4

5

1

1

1 Physical frame for reference contour
2 Reference contour, must cover at least two sides of the protective field
3 Safety sensor
4 Distance e between the reference contour frame and machine opening, recommended: e = 150 mm
5 Machine opening contour

Fig. 7.14: Defining the protective field contour and reference contour, stationary point of operation guarding, verti-
cal protective field

7.4 Mobile danger zone guarding on AGVs
Danger zone guarding protects people and objects that are in rooms in which vehicles move in, e.g. auto-
mated guided vehicle systems (AGVs).
A horizontally arranged protective field protects people and objects that are in the vehicle's path and are
detected by the front edge of the protective field.

WARNING

Danger of injury because of insufficient vehicle stopping distance
Ä The operator of the machine must use organizing measures to prevent people from entering

the protective field of the vehicle from the sides or being able to move towards an approach-
ing vehicle.

Ä Only use the safety sensor on vehicles with electrical drive and electrically influenced drive and braking
devices.

Ä Only install the safety sensor on the front of the vehicle. 
If you must also guard the reverse travel, you must also install a safety sensor on the rear of the vehi-
cle.

Ä Mount the safety sensor on the vehicle so that there are no unmonitored areas ≥ 70 mm between the
protective field and vehicle front.

Ä Set the mounting height such that the beam level is not more than 200 mm above the floor. 
A person lying on the floor can therefore be safely detected. This is required by the C standard,
EN 1525 "Safety of industrial trucks – Driverless corridor supply vehicles and their systems".
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NOTICE

The beam level of the safety sensor is level with the alphanumerical display.

7.4.1 Minimum distance D

D [mm] = Minimum distance, vehicle front (danger) to protective field front edge
DA [mm] = Stopping distance
ZTOT [mm] = Sum of required additional distances

D

D  · L  · L
B 1 2

V   · (T  + T  + t )
max 1 ps2

Z
GES

200

D 
A

Fig. 7.15: Mobile danger zone guarding, calculation of required minimum distance D

Stopping distance DA

DA = vmax * (T1 + T2 + tPS) + DB * L1 * L2

DA [mm] = Stopping distance
vmax [mm/s] = Maximum vehicle speed
T1 [s] = Response time of the safety sensor
T2 [s] = Response time of the AGV
tPS [s] = PROFIsafe watchdog time
DB [mm] = Braking distance with vmax and maximum vehicle load
L1 [---] = Factor for brake wear
L2 [---] = -Factor for problematic floor conditions, e.g. dirt, wet conditions

Additional distances Z

Ztot [mm] = Total of the required additional distances
ZSM [mm] = Additional distance for system-related measurement error, see chapter 7.2 "Stationary dan-

ger zone guarding"
ZF [mm] = Additional distance required with lack of floor space HF

ZREFL [mm] = Additional distance required with retro-reflectors beyond the protective field boundaries;
ZREFL = 100 mm

The additional distance ZSM is always required. Its size depends on the biggest radius RG from the safety
sensor mirror's rotary axis to the protective field boundary without ZTot. The position of the rotary mirror axis
depends on the installation situation.
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The additional distance ZF is required if the vehicle does not have enough free floor space HF and there is
therefore no space under the vehicle or the safety sensor for the tips of the feet. You determine the addi-
tional distance ZF according to the following diagram:
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Fig. 7.16: Diagram for determining the additional distance ZF with lack of floor space HF

If wheels are mounted near the side wall, always add an additional distance ZF > 150 mm.

7.4.2 Protective field dimensions

Z
GES

D

F
R
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D
A
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S

R
G

D Minimum distance, vehicle front (danger) to protective field front edge
DA Stopping distance
ZTOT Total required additional distances to the front and for both sides
FL Distance from safety sensor center to left vehicle edge
FR Distance from safety sensor center to right vehicle edge
RG Biggest radius in the protective field without ZTOT for determining the additional distance ZSM

Fig. 7.17: Mobile danger zone guarding, dimensions for horizontal protective field

Ä Select 70 mm resolution.
Ä Set the protective field length so that the response time until braking and the braking distance, including

factors for wear and tear and floor conditions, and any necessary additional distances are taken into
account.

Ä Arrange the protective field symmetrically with reference to the vehicle width, even if the safety sensor
is not arranged centered.

Ä Configure an upstream warning field that reduces the vehicle's speed. 
A full brake with a subsequent interruption of the protective field is then executed moderately and is
less demanding on the vehicle's drives. 
Dimension the minimum distance D for the maximum speed as if the speed reduction initiated by the
warning field had not happened.
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Ä Take the required free space for lateral protrude protective fields under the roller conveyors along the
transportation path into account.

Ä If you have to expect angular deviations of the vehicle during the travel, plan an additional tolerance
area to guarantee undisturbed travel operation.

7.5 Mobile side guarding on AGVs

WARNING

Danger of injury because of insufficient vehicle stopping distance
Ä The operator of the machine must use organizing measures to ensure that people cannot

enter the vehicle's protective field from the side.

Ä For mobile vertical protective fields use a resolution of at least 150 mm.
Ä Position the protective field edges in the travel direction in accordance with the front protective field

edge of the horizontal protective field.
Ä Ensure that the response times of all components of the switch-off circuit are the same or balance the

response times with different protective field dimensioning.
Ä Set the vertical protective fields at a slight angle so that the lower protective field edges protrude over

the vehicle width by the amount of the additional distances, ZSM, ZF and ZREFL where required; see chap-
ter 7.4.2 "Protective field dimensions".

7.6 Mounting accessories

7.6.1 Mounting system
Using the mounting system you can adjust the safety sensor horizontally and vertically by ±10 degrees
when mounting.

Fig. 7.18: BTU800M mounting system

NOTICE

Floor mounting only with mounting system BTU800M
Ä The mounting system BTU800M must be used in the case of installation using the mounting

bracket for floor mounting.

Ä Install the wall mount or mounting bracket for floor mounting on the system side.
Ä Mount the mounting system on the wall mount or on the mounting bracket for floor mounting.
Ä Attach the safety sensor to the mounting system. 

Tightening the screws fixes the safety sensor in position.
Ä Align the safety sensor using the integrated electronic spirit level.



Mounting

Leuze electronic GmbH + Co. KG RSL 420P 64

7.6.2 Loop guard
The loop guard for the optics cover prevents damage to the safety sensor caused by light contact with for-
eign objects.

NOTICE

The loop guard can only be used together with the mounting system BTU800M.

1

1

2

3 3

4

1 BTF815M mounting bracket for floor mounting (only with BTU800M mounting system)
2 BTU800M mounting system
3 Loop guard
4 Safety sensor

Fig. 7.19: Loop guard

Ä Attach the safety sensor to the mounting system.
Ä Engage the loop guard for the optics cover from above into the mounting system.
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8 Electrical connection

WARNING

Faulty electrical connection or improper function selection may result in serious injury!
Ä Only allow competent persons to perform the electrical connection.
Ä For access guarding, activate the start/restart interlock and make certain that it cannot be

unlocked from within the danger zone.
Ä Select the functions so that the safety sensor can be used as intended (see chapter 2.1 "In-

tended use").
Ä Select the safety-relevant functions for the safety sensor (see chapter 5.2 "Function modes

of safety sensor").
Ä Always loop both safety-related switching signals – A_SAFE_xx_CLEAR and

B_SAFE_xx_CLEAR – into the work circuit of the machine.
Ä Signal outputs must not be used for switching safety-relevant signals.

NOTICE

Laying cables!
Ä Lay all connection cables and signal lines within the electrical installation space or perma-

nently in cable ducts.
Ä Lay the cables and lines so that they are protected against external damages.
Ä For further information: see EN ISO 13849-2, Table D.4.

NOTICE

Observe when wiring with terminals and connectors!
In the case of wiring that continues beyond the device or during repairs to connectors, the user
must ensure that cables or conductors that have defectively disconnected cannot result in con-
tact with other signals.
Ä Use suitable terminals.
Ä Use heat-shrink tubing, wire-end sleeves or similar.
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8.1 Electrical supply
see chapter 16.1 "General specifications".

Functional earth

NOTICE

Always connect the housing of the safety sensor to functional earth or ground!
Ä The housing of the safety sensor must always be connected to earth (functional earth) or

machine/vehicle ground.
Ä If the safety sensor is attached to a non-conductive material (e.g. a concrete wall), the hous-

ing of the safety sensor must be earthed.

• Factory recommendation: Functional earth via a ground strap/braid (low impedance for RF). 
Connection points for self-tapping screws used for the ground connection are provided and labeled on
the bottom of the connection unit.

• Functional grounding via the shield of the connection cable. 
For grounding, the shield of the connection cable in the switch cabinet must be connected to earth or
machine/vehicle ground.

NOTICE

Make sure that potential equalization is provided!
Ä If the housing of the safety sensor or the mounting bracket – despite being mounted on a

non-conductive material – is connected to metallic parts (even temporarily), you must ensure
that the appropriate potential equalization is provided between the switch cabinet and hous-
ing potential; e.g. by grounding the Ethernet connection.

8.2 Interfaces
The safety sensor has the following interfaces:

• Interface for voltage supply
• Interface for PROFINET/PROFIsafe communication
• USB interface for communication with PC or laptop

NOTICE

Ä Use the USB connection only temporarily for configuration or diagnosis of the safety sensor.
Ä For permanent connection, connect the safety sensor to the Ethernet connection of the con-

nection unit.

8.3 Connection unit CU400P-3M12

2 31

1 M12 connector, A-coded, voltage supply, I/O signal RSL
2 M12 socket, D-coded, PROFINET/PROFIsafe communication, input
3 M12 socket, D-coded, PROFINET/PROFIsafe communication, output

Fig. 8.1: Device with connection unit CU400P-3M12
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Voltage supply
Voltage is supplied to the safety sensor via a 4-pin M12 connector

2

3

1

4

FE

Fig. 8.2: Pin assignment for M12 connector, 4-pin, A-coded

Tab. 8.1: Pin assignment for voltage supply

PIN Signal Comment
1 VIN Positive supply voltage +24 V DC

2 EA1 I/O signal RSL

3 GND Negative supply voltage 0 V DC

4 EA2 I/O signal RSL

FE GND/shield Functional earth, interconnection cable shield. The shield of the interconnection
cable is on the thread of the M12 connector. The thread is part of the metallic
housing. The housing is at the same potential as functional earth.
It is also possible to operate the device with unshielded interconnection cables.
The use of shielded interconnection cables is, however, recommended.

• The maximum current load of the connections is limited to 4 A/pin.
• The I/O signals are guided from the safety sensor through the PROFINET box to the connector plug.
• The supply voltage is not intended for linear topology and is not looped through.

PROFINET/PROFIsafe communication
The PROFINET/PROFIsafe communication takes place via two 4-pin M12 sockets.

43

12

Fig. 8.3: Pin assignment for M12 socket, 4-pin, D-coded

Tab. 8.2: Pin assignment for PROFINET/PROFIsafe communication interfaces

PIN Signal Direction Comment
1 TD+ OUT Transmitter data +

2 RD+ IN Receiver data +

3 TD- OUT Transmitter data -

4 RD- IN Receiver data -

FE GND/shield Functional earth, communication cable shield. The shield of the intercon-
nection cable is on the thread of the M12 socket. The thread is part of the
metallic housing. The housing is at the same potential as functional earth.
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8.4 Connection unit CU400P-4M12

4321

1 M12 connector, L-coded, voltage supply
2 M12 socket, D-coded, PROFINET/PROFIsafe communication, input
3 M12 socket, D-coded, PROFINET/PROFIsafe communication, output
4 M12 socket, L-coded, voltage supply

Fig. 8.4: Device with connection unit CU400P-4M12

Voltage supply
The safety sensor is supplied with voltage via two 5-pin L-coded M12 connections. The scanner is supplied
from mains L1/N1.

4

5

1

32

1

5

4

23

A B

FE FE

A M12 connector, 5-pin, L-coded
B M12 socket, 5-pin, L-coded

Fig. 8.5: Pin assignment M12 connector/socket, 5-pin, L-coded

Tab. 8.3: Pin assignment for voltage supply

PIN Signal Comment
1 L1 24 V DC (US1+)

2 N2 0 V DC (US2-)

3 N1 0 V DC (US1-)

4 L2 24 V DC (US2+)
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PIN Signal Comment
FE GND/shield It is also possible to operate the device with unshielded interconnection cables.

The use of shielded interconnection cables is, however, recommended.

The current load of the connections must not exceed 16 A/pin.

PROFINET/PROFIsafe communication
The PROFINET/PROFIsafe communication takes place via two 4-pin M12 sockets.

43

12

Fig. 8.6: Pin assignment for M12 socket, 4-pin, D-coded

Tab. 8.4: Pin assignment for PROFINET/PROFIsafe communication interfaces

PIN Signal Direction Comment
1 TD+ OUT Transmitter data +

2 RD+ IN Receiver data +

3 TD- OUT Transmitter data -

4 RD- IN Receiver data -

FE GND/shield Functional earth, communication cable shield. The shield of the intercon-
nection cable is on the thread of the M12 socket. The thread is part of the
metallic housing. The housing is at the same potential as functional earth.

8.5 Connection unit CU400P-AIDA

12 31

All dimensions in mm
1 AIDA sockets, PROFINET, push-pull, 5-pin, voltage supply
2 AIDA socket, PROFINET, RJ45 push-pull, 8-pin, Ethernet, input
3 AIDA socket, PROFINET, RJ45 push-pull, 8-pin, Ethernet, output

Fig. 8.7: Device with connection unit CU400P-AIDA
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Voltage supply
The safety sensor is supplied with voltage via two 5-pin PROFINET AIDA push/pull connections for copper
cables. The scanner is supplied from mains L1/N1.

1 5

Fig. 8.8: Pin assignment PROFINET AIDA push-pull, 5-pin

Tab. 8.5: Pin assignment for voltage supply

PIN Signal Comment
1 L1 24 V DC (US1+)

2 N1 0 V DC (US1-)

3 L2 24 V DC (US2+)

4 N2 0 V DC (US2-)

5 GND/shield It is also possible to operate the device with unshielded interconnection cables.
The use of shielded interconnection cables is, however, recommended.

• The current load of the connections must not exceed 16 A/pin.

NOTICE

Ä Lay the cables for the linear topology and the tap in the PROFINET controller in such a way
that short circuits are prevented.

PROFINET/PROFIsafe communication
The PROFINET/PROFIsafe communication takes place via two 8-pin PROFINET RJ45 AIDA push/pull
connections for copper cables.

1 8

Fig. 8.9: Pin assignment PROFINET RJ45 AIDA push/pull

Tab. 8.6: Pin assignment for PROFINET/PROFIsafe communication interfaces

PIN Core
color

Signal Direction Comment

1 Yellow TD+ OUT Transmitter data +

2 Orange TD- OUT Transmitter data -

3 White RD+ IN Receiver data +

4 --- --- --- n.c.

5 --- --- n.c.

6 Blue RD- IN Receiver data -

7 --- --- --- n.c.
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PIN Core
color

Signal Direction Comment

8 --- --- --- n.c.

FE GND/shield Functional earth, communication cable shield. The shield of
the communication cable is in contact with the housing of the
AIDA socket. The housing is at the same potential as func-
tional earth.

8.6 Connection unit CU400P-AIDA-OF

12 31

1 AIDA sockets, PROFINET, push-pull, 5-pin, voltage supply via copper cable
2 AIDA socket, PROFINET, SCRJ push-pull, 2-pin, PROFINET/PROFIsafe communication via fiber-optic cable,

input
3 AIDA socket, PROFINET, SCRJ push-pull, 2-pin, PROFINET/PROFIsafe communication via fiber-optic cable,

output

Fig. 8.10: Device with connection unit CU400P-AIDA-OF

Voltage supply
The safety sensor is supplied with voltage via two 5-pin PROFINET AIDA push/pull connections for copper
cables. The scanner is supplied from mains L1/N1.

1 5

Fig. 8.11: Pin assignment PROFINET AIDA push-pull, 5-pin

Tab. 8.7: Pin assignment for voltage supply

PIN Signal Comment
1 L1 24 V DC (US1+)

2 N1 0 V DC (US1-)

3 L2 24 V DC (US2+)

4 N2 0 V DC (US2-)
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PIN Signal Comment
5 GND/shield It is also possible to operate the device with unshielded interconnection cables.

The use of shielded interconnection cables is, however, recommended.

• The current load of the connections must not exceed 16 A/pin.

NOTICE

Ä Lay the cables for the linear topology and the tap in the PROFINET controller in such a way
that short circuits are prevented.

PROFINET/PROFIsafe communication
PROFINET/PROFIsafe communication takes place via two fiber-optic cables (FOC) to a PROFINET con-
troller AIDA FOC.
The PROFINET controller AIDA FOC must provide two external Ethernet interfaces:

• Bit rate: 100 Mbit/s
• Medium: glass fiber
• Protocols: PROFINET, TCP/IP

The optical Ethernet connection of the PROFINET controller AIDA FOC must be designed for the use of
PROFINET SCRJ push/pull AIDA connectors (acc. to ISO/IEC 61754-24-2).

Fig. 8.12: PROFINET SCRJ push/pull AIDA connection

Tab. 8.8: Details on the fiber-optic cables

Parameter Minimum Typical Maximum
Transceiver wavelength 635 nm 650 nm 660 nm

Diameter of fiber-optic cable with
polymer optical fiber (POF)

980 µm --- 1000 µm

Cable length 1 m --- 50 m

Line attenuation --- --- 12 dB

NOTICE

Ä Observe the mounting and installation guidelines of the manufacturer of the connectors and
cables, especially with regard to the number of bending cycles (bend cable – extend cable).
The bending radius for the cables must be > 80 mm.

Ä Use as few connectors as possible in the connection cable. 
Ideally, the connection cable consists of a single piece and is connected with one connector
on the connection unit and one on the control. 
The connection cable should not consist of multiple pieces that are connected by means of
connectors.

Ä Use low-loss cables and connectors to achieve a signal reserve of > 4 dB.
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8.7 Cable lengths according to the operating voltage
The maximum cable length is determined by voltage drops on the supply and signal lines.
The following conditions apply for the necessary operating voltage UB at the input terminals of the connec-
tion unit:

• UB must be greater than the permissible nominal voltage limit of 16.8 V.

NOTICE

The recommended operating voltage is at least 19 V!
Leuze recommends an operating voltage UB of at least 19 V at the input terminals of the con-
nection unit.
Ä The operating voltage should not be allowed to drop below the recommended value if possi-

ble.

• The necessary operating voltage UB must also ensure the function of the downstream devices in the
case of a linear configuration.
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9 Configuring the safety sensor
To start up the safety sensor in your application, the safety sensor must be individually adapted using the
software. All configuration data is defined using the configuration and diagnostics software.

General procedure for configuring safety sensor
Ä Assessing the risk
• The system has been determined and its boundaries defined.
• The safety sensor has been selected as the safety component.
• The type of guarding has been determined (danger zone guarding, point of operation guarding, access

guarding).
Ä Calculating safety distance 

Shape and size of the protective and warning fields
Ä Configuring the safety sensor
• Configuration and diagnostics software (see chapter 4 "Configuration and diagnostic software Sen-

sor Studio")
• Determine the configuration project (see chapter 9.3 "Determine the configuration project")
• Configure the protective function (see chapter 9.4 "Configuring protective function")
Ä Checking function (see chapter 12 "Testing")

9.1 Defining safety configuration

WARNING

Serious accidents caused by incorrect safety configuration!
The protective function of the safety sensor is only ensured if the safety sensor is correctly con-
figured for the intended application.
Ä Allow only competent persons to perform safety configuration.
Ä Select the safety configuration so that the safety sensor can be used as intended (see chap-

ter 2.1 "Intended use").
Ä Select the protective field dimensions and contours according to the safety distance calcu-

lated for the application (Calculation of safety distance S).
Ä Select the parameters of the safety configuration according to your risk analysis.
Ä After start-up, check the function of the safety sensor (see chapter 12.1 "Before the initial

start-up and following modifications").

WARNING

Additional protection against manipulation when the monitoring time is increased!
If the monitoring time is increased to above 5 s or if manipulation protection is deactivated, the
system operator must introduce other measures to prevent manipulation.
Ä For example, make sure that the distance range in which manipulation is possible cannot be

accessed by personnel under normal operating conditions.
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NOTICE

Safety-related switching signals will switch off if no reflection signals are being mea-
sured!
If the safety sensor is unable to measure any reflection signals in a continuous scanning angle
of ≥ 90° for a long period of time, the safety-related switching signals switch off. In certain appli-
cation types (e.g. in buildings with extremely large distances), the safety sensor may not be able
to measure any reflection signals. For such application types, it is possible to set or deactivate
the monitoring times.
Ä In the CONFIGURATION menu, click the Other option.

ð The OTHER dialog box opens.
Ä In the PROTECTION AGAINST MANIPULATION dialog box, define the monitoring time ac-

cording to your specific conditions.
ð If the parking position is active, there will be no manipulation monitoring.

Prerequisites:
• The safety sensor is mounted (see chapter 7 "Mounting") and connected (see chapter 8 "Electrical con-

nection") correctly.
• Dangerous process is switched off, outputs of the safety sensor are disconnected, and the system is

protected against being switched back on.
• The size of the protective field is determined on the basis of the mounting location, the calculated

safety distances and additional distances.
• The start/restart operating mode required by the application has been determined.
• The conditions for field pair changeover, if required, have been determined.
• The configuration and diagnostics software for the safety sensor is installed on the PC (see chapter 4.2

"Installing software").

NOTICE

Many safety-relevant parameters are preset for each application in the configuration and diag-
nostics software. Use these preset values where possible.

Procedure
All configuration data is defined using the configuration and diagnostics software.
To configure the safety sensor, proceed as follows:
Ä Connect the PC to the safety sensor
Ä Start the software
• Set up communication
• Determine the configuration project
Ä Configure the protective function using the project wizard
• Protective/warning field configuration
• Resolution and response time
• Start-up behavior
• Field pair changeover
• PROFINET configuration
Ä Save configuration project
Ä Transferring a configuration to the safety sensor
Ä Create a record document for the device configuration and protective field dimensioning. The document

must be signed by the person responsible for the configuration. 
To document the configuration, you can create a PDF file of the safety configuration or save the config-
uration and settings in an *.xml file.
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NOTICE

The configuration data is stored in the connection unit of the safety sensor and is therefore also
available after replacement or repair of the scanner unit. The configuration data only needs to
be transferred again if changes are made to the configuration.

9.2 Connecting safety sensor to PC

9.2.1 Connection via Ethernet cable
Ä Connect the Ethernet cable to the PC or to the network; see the document "Quick Start Guide

RSL 400".
Ä Define the IP address of the device using an external tool (e.g. PRONETA from Siemens).
Ä Enter the IP address of the device directly in the Sensor Studio communication DTM and start commu-

nication.

NOTICE

The TCP/IP protocol is used for communication via Ethernet.

9.2.2 Connection via Bluetooth
Prerequisites: Bluetooth communication of the safety sensor has been activated (see chapter 9.2.4 "Com-
munication between safety sensor and PC")
Ä Activate the Bluetooth interface on the PC.
Ä Select the safety sensor as the device for the Bluetooth connection.

NOTICE

Distance between safety sensor and PC
The possible distance between safety sensor and PC depends on the quality of the Bluetooth
adapter that is used.
USB Bluetooth adapters with external rod antenna enable a larger operating range.

9.2.3 Connection via USB
The USB interface is behind a protection cap on the front of the safety sensor.

NOTICE

Distance between safety sensor and PC with USB connection!
The USB interface of the safety sensor is connected to the USB interface on the PC with a stan-
dard USB cable (plug combination - Mini-B type / Type A).
The distance between safety sensor and PC is limited to 5 m if a standard USB cable is used.
Use active USB cables if longer cable lengths are required.

NOTICE

Ä If possible, use the ready-made cables from Leuze (see chapter 18 "Order guide and acces-
sories").

• Connect the USB cable to the safety sensor and the PC.
• Select the LAN / USB (RNDIS) interface for the device search.
• Start the device search by clicking the [Start] button.
• Select the safety sensor from the list of found devices.
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NOTICE

Ä After use, seal the USB connection using a protection cap. Make sure that the protection
cap is felt to engage when sealing. The IP degree of protection specified in the technical
data is only achieved when the protection cap is closed.

9.2.4 Communication between safety sensor and PC
The following communication settings are active when the safety sensor is delivered:
Bluetooth

• Bluetooth module deactivated
• Device scan deactivated

You can change the communication settings on the PC using the configuration and diagnostics software in
order to, for example, assign a permanent IP address to the safety sensor in your network.
Ä Start the configuration and diagnostics software on your PC.
ð The mode selection of the Project Wizard is displayed.

ð If the mode selection is not shown, click the [Project Wizard] button ( ) in the menu bar of the soft-
ware to start the project wizard.

Ä Select the configuration mode and click [Next].
ð The Project Wizard displays the device selection list containing the configurable safety sensors.
Ä Select the safety sensor from the device selection list and click [Next].
ð The initial screen for the configuration project is displayed together with information for identification of

the selected safety sensor.
Ä In the initial screen, click the SETTINGS tab.
ð The SETTINGS menu opens.

Assign permanent IP address
Ä Select the menu command Communication > LAN.
Ä In the DHCP dialog box, deactivate the Obtain IP address automatically checkbox.
Ä In the CONNECTION SETTINGS dialog box, enter the IP address information.

Activating/deactivating the Bluetooth interface
Ä Select the menu command Communication > Bluetooth.
Ä Activate/deactivate communication with the safety sensor via the Bluetooth interface using the Activate

Bluetooth module checkbox. If the Bluetooth module is deactivated, communication with the safety sen-
sor via the Bluetooth interface is not possible.

Ä Activate/deactivate the Bluetooth device scan using the Activate device scan checkbox. If the device
scan is deactivated, the safety sensor will not be found during the Bluetooth device scan. To allow com-
munication via the Bluetooth interface, you must enter the device identification of the safety sensor
manually.
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9.3 Determine the configuration project
Ä Start the configuration and diagnostics software on your PC.
ð The mode selection of the Project Wizard is displayed.

ð If the mode selection is not shown, click the [Project Wizard] button ( ) in the menu bar of the soft-
ware to start the project wizard.

NOTICE

During installation of the software, a user admin (without password query) is created so that you
can start the software without user identification. If other users are registered (Tools > User
management in the FDT frame menu), you must log in at the software with a user name and
password.
This setting allows you to connect to the safety sensor and to read out, upload, enter or change
the safety configuration and all settings using the RSL 400 device DTM. The password for the
safety sensor only needs to be entered (i.e. the access level only needs to be changed) when
the changes are downloaded to the safety sensor (see chapter 4.5.1 "Selecting access level").

Ä Select the configuration mode and click [Next].
ð The Project Wizard shows the list of configurable safety sensors.

NOTICE

You can use a prepared configuration project as a template and make changes to it. To do so,
select the configuration mode Open a stored project file.
If you want to load the configuration project currently stored in the safety sensor to the PC, se-
lect the configuration mode Device selection with device scan and establishment of connection
(online).

Ä Select the safety sensor in the Sensor list and click OK. 
Alternatively, you can select the safety sensor by entering the part number or by specifying the sensor
range and the sensor type.

ð The device manager (DTM) of the safety sensor shows the initial screen for the configuration project.

1

1 Configuration Wizard

Fig. 9.1: Safety configuration using Configuration Wizard
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NOTICE

The device manager (DTM) starts without querying the access level of the user. During commu-
nication with the safety sensor, the safety sensor does however query the access level of the
user. To change the access levels, see chapter 9.8 "Selecting access level".

9.4 Configuring protective function
Prerequisites: The safety distance, additional distances and protective field dimensions and contours have
been determined according to the mounting position (Calculation of safety distance S).
Ä In the initial screen, click the CONFIGURATION tab.
ð The CONFIGURATION menu opens with the options:

• Administration
• Device function

If the Device function option is selected in the CONFIGURATION menu, the Protective function A
option is displayed.

• Other

9.4.1 Creating simple safety configuration
To create a safety configuration for simple commissioning, you must first perform five configuration steps to
access the editor used for defining the contours of the protective and warning fields.
By clicking [Next], you can proceed to the next configuration step without selecting the corresponding op-
tion in the CONFIGURATION menu.
If you make changes to the default settings in a configuration step, first click the [Confirm] button and then
[Next].
Ä Administration
Ä Device function
Ä Protective function A
Ä Bank A1
Ä Outputs

9.4.2 Entering administration parameters
Ä In the CONFIGURATION menu, click the Administration option.
ð The ADMINISTRATION dialog box opens.
Ä In the input fields, enter the device data and the project data for the configuration project.

9.4.3 Activate protective function
Ä In the CONFIGURATION menu, click the Device function option.
ð The DEVICE FUNCTION dialog box opens.
Ä In the Protective function operating mode list, select the protective function of the safety sensor.
ð The Protective function A option is shown in the CONFIGURATION menu.

NOTICE

The changeover-capable protective/warning field pairs for the selected protective function are
defined in configuration banks.

Ä Click the [Confirm] button.
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9.4.4 Creating and configuring protective/warning field pairs
The changeover-capable protective/warning field pairs for the selected protective function are defined in
configuration banks. The configuration banks are shown in the navigation tree of the configuration menu as
"Bank", e.g. Bank A1.

Creating banks
Ä In the CONFIGURATION menu, click the Protective function A option.
ð The PROTECTIVE FUNCTION A dialog box opens.
Ä Enter the description of the protective function in the input field.
Ä In the CONFIGURATION menu, right-click the Protective function A option. 

Select Add configuration bank.
ð The Add bank dialog box opens.
Ä In the Bank list, select the number of the bank and click the [Add] button. 

When you have added all banks for the protective function, click [Close].

Configuring banks
The resolution for hand, leg or body detection, the response time and start-up behavior of the safety sensor
and the field pair changeover for the protective/warning field pairs are configured via the banks.

NOTICE

For resolution, response time and AGV speed, select the values that you used for calculating
the safety distances and additional distances for the application assigned to the configuration
bank.

Ä In the CONFIGURATION menu, select the bank the configuration of which you want to define.
Ä In the RESOLUTION dialog box, enter the resolution and, if applicable, the maximum speed of an auto-

mated guided vehicle (AGV) in the input fields.

NOTICE

If in the Resolution and Max. AGV speed input fields you select values > 0, the application usu-
ally used for the bank is displayed in the Application field, e.g. Point of operation guarding.
For access guarding, point of operation guarding and danger zone guarding, you must select
Max. AGV speed = 0!

Ä In the RESPONSE TIME dialog box, select the response time of the safety sensor.
Ä In the START-UP BEHAVIOR dialog box, select the start-up behavior and the restart time of the safety

sensor.

NOTICE

Configuration of the start-up behavior is only implemented if the corresponding electrical signal
connections exist; see chapter 8 "Electrical connection".

Ä Click the [Confirm] button.
Ä Configure all other banks of the protective function following the described procedure.

Create protective and warning fields
A field pair consists of one protective field and one warning field.
Ä In the CONFIGURATION menu, right-click the Bank 1 option under Protective function_A 

Select Add field pair.
ð The Add field pair dialog box opens.
Ä In the Field pair list, select the number of the field pair and click the [Add] button. When you have

added all field pairs for the bank, click [Close].
ð The added field pairs are shown in the CONFIGURATION menu as an option under Bank 1 under Pro-

tective function_A. The Parameters option is displayed for each field pair.
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Configure protective and warning fields
Defining contours and boundaries for protective field and warning field

2

3

1

1 Toolbar of field editor
2 Display of field coordinates
3 Structure of safety configuration

Fig. 9.2: Field editor with toolbar for field definition

Ä In the CONFIGURATION menu, click the field pair the protective and warning fields of which you want
to define.

Ä Click the   button and define the contours and boundaries of the protective field.

NOTICE

Determine protective field size!
The protective field size is determined by the calculated safety distances and additional dis-
tances that you determined for the application assigned to the configuration bank.

NOTICE

With protective field boundaries <200 mm, object detection may be restricted owing to the mea-
surement error.
Ä When defining the protective field, take into account the additional distance Zsm to the pro-

tective field contour (see chapter 7.2 "Stationary danger zone guarding").

Ä Click the   button and define the contours and boundaries of the warning field.

NOTICE

By right-clicking the field pair in the CONFIGURATION menu, you can calculate an autocontour
for the protective or warning field.
You can determine the display options for the field editor in the menu SETTINGS > Field editor
display options (see chapter 4.5.6 "SETTINGS").

Ä Configure all other field pairs of the configuration bank following the described procedure.

NOTICE

It is also possible to read in an RS4 configuration file as well as to convert the protective fields
on the RSL400.
Note here, that the converted field pairs are only contour suggestions. Therefore, check that the
fields are appropriate for the requirements of your safety application.
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9.4.5 Configuring field pair monitoring
Ä In the CONFIGURATION menu, click the Parameters option of the field pair the protective and warning

fields of which you have defined.
Ä Select the monitoring mode for the field pair in the Field pair monitoring list.

9.5 Defining permissible field pair changeovers
If monitoring of field pair changeover is activated, you can define the permissible sequence of field pair
changeovers.

Determining changeover mode
Ä In the CONFIGURATION menu, select the protective function A option.
Ä In the dialog box MODE FOR FIELD PAIR ACTIVATION AND CHANGEOVER, select the field pair ac-

tivation, the mode for field pair changeover and, if required, the changeover time.

Field pair activation
Changeover mode

Description

Fixed selection of one field pair Changeover of two field pairs

Selection by signal inputs
Fixed changeover moment

Changeover of 10 field pairs (see chapter 5.7.3 "Changeover of ten field
pairs in changeover mode Fixed changeover moment")
When the changeover time has expired, the system changes over to the
field pair which at this time has a permanent and valid assignment. Field
pair changeover signals issued during the changeover time are ignored.
The inputs F1 - F5 are active.

Selection by signal inputs
Overlapped monitoring

Changeover of 5 field pairs ()
Both field pairs are monitored during the changeover time.
The inputs F1 - F5 are active.

Ä Click the [Confirm] button.

Determining changeover order
Ä In the CONFIGURATION menu, select the Changeover order option.
ð The CHANGEOVER ORDER dialog box opens.
Ä In the MONITORING OF FIELD PAIR CHANGEOVER dialog box, activate the Monitoring option.
Ä In the MONITORING OF FIELD PAIR CHANGEOVER dialog box, define the sequence of field pair

changeovers according to your conditions.
Ä Click the [Confirm] button.

9.6 Saving configuration
To save the changed configuration loaded in the software, you can transfer the configuration and settings
to the safety sensor or save them in a file on the PC.

Saving safety configuration as PDF file
Ä In the CONFIGURATION menu, click the [Create PDF file of safety configuration] button.
Ä Determine the storage location and the file name for the safety configuration.
Ä Click [Save].
ð The safety configuration is saved as a PDF file.

Saving configuration and settings as file
Ä In the CONFIGURATION menu or in the SETTINGS menu, click the [Save configuration and settings to

file] button.
Ä Determine the storage location and the name of the configuration file.
Ä Click [Save].
ð The configuration and settings are saved in the file format *.xml.
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Saving configuration project as file

Ä In the menu bar of the FDT frame menu, click the  button. 
Alternatively, select the menu command File > Save.

Ä Determine the storage location and the name of the configuration project file.
Ä Click [Save].

9.7 Transferring configuration project to safety sensor
The changes that you have made to the configuration only become effective when the changed configura-
tion project file is transferred to the safety sensor.
Prerequisites:

• The software and safety sensor are connected.
• The changed configuration project has been loaded in the software.
• The individual password for the access level Engineer is available.

• Only users with the access level Engineer can transfer configuration data to the safety sensor. To
change the access level, see chapter 9.8 "Selecting access level".

• If no individual password has been defined for the access level Engineer, use the preset default
password (safety).

NOTICE

Alternatively, you can transfer a configuration project saved as a file on the PC directly to the
safety sensor.

Ä In the menu bar of the FDT frame menu, click the [download arrow] button. Alternatively: In the FDT
menu bar, select Device > Download parameters.

ð The software asks for the access level and the password.
Ä Select the access level Engineer and enter the preset default password (safety) or the defined individ-

ual password. 
Confirm with [OK].

Ä Before downloading the safety configuration, check whether you are connected to the correct safety
sensor. 
Confirm the displayed safety notice with [Yes].

Fig. 9.3: Check before safety configuration is downloaded
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The software transfers the data of the configuration project to the safety sensor.
After successful transfer, the safety sensor immediately enters safety mode, i.e. the safety-related switch-
ing outputs switch on if all conditions are fulfilled.

• The configuration data is saved in the connection unit of the safety sensor.
• A copy of the safety configuration is saved in the scanner unit of the safety sensor. 

If, due to a device swap-out, the scanner unit is attached to a brand new, unconfigured connection unit,
the safety configuration is transferred from the scanner unit to the connection unit.

NOTICE

Observe the safety notices regarding changes to the configuration!
Transferring the safety configuration from the scanner unit to the connection unit corresponds to
reconfiguration of the system consisting of scanner unit and connection unit.
Ä Observe the relevant safety notices regarding changes to the configuration (see chapter 9.1

"Defining safety configuration").

Ä Check the displayed signature.
Ä Confirm successful transfer of the safety configuration to the safety sensor with [OK]. 

The safety configuration has only been successfully transferred to the safety sensor when the confirma-
tion dialog is displayed during the download.

Fig. 9.4: Confirmation: safety configuration downloaded

NOTICE

The safety-related switching outputs will already have switched on if all conditions are fulfilled.

ð The software has saved the configuration project in the safety sensor.
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9.8 Selecting access level
Using the device manager (DTM) you can change the access level of the user, if necessary (see chapter
5.1 "Authorization concept of safety sensor").

Ä Click in the DTM menu bar on the Change access level button ( ).
ð The Change access level dialog box opens.
Ä In the Authorization list, select the item Engineer, Expert or Observer and enter the default password

or the password defined for the individual user (see chapter 4.5.6 "SETTINGS").
• Default password for Engineer: safety
• Default password for Expert: comdiag

Ä Confirm with [OK].

9.9 Reset safety configuration
The device manager (DTM) can be used to reset the safety configuration to the default configuration (one
protective function, no restart).
Ä In the DTM menu bar, click the [Reset safety configuration] button.
ð Users with the access level Engineer can additionally transfer the changed safety configuration to the

safety sensor (see chapter 9.7 "Transferring configuration project to safety sensor").
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10 Starting up the device

WARNING

Improper use of the safety sensor may result in serious injury!
Ä Make certain that the entire device and the integration of the optoelectronic protective de-

vice was inspected by competent and instructed persons.
Ä Make certain that a dangerous process can only be started while the safety sensor is

switched on

Prerequisites:
• Safety sensor mounted (see chapter 7 "Mounting") and connected (see chapter 8 "Electrical connec-

tion") correctly
• Operating personnel were instructed in proper use
• Dangerous process is switched off, outputs of the safety sensor are disconnected, and the system is

protected against being switched back on
Ä After start-up, check the function of the safety sensor (see chapter 12.1 "Before the initial start-up and

following modifications").

10.1 Switching on
Requirements for the supply voltage (power supply unit):

• Safe mains separation is ensured.
• Current reserve of at least 3 A is available.
Ä Switch on the safety sensor.

10.2 Aligning the safety sensor

NOTICE

Faulty or incorrect alignment may result in an operating fault!
Ä The alignment performed during start-up should only be performed by qualified personnel.
Ä Observe the data sheets and mounting instructions of the individual components.

To simplify alignment during start-up, the safety sensors of the RSL 400 series have an integrated elec-
tronic spirit level.
Ä Align the safety sensor using the integrated electronic spirit level.

10.3 Unlocking start/restart interlock

WARNING

Premature unlocking of the start/restart interlock may result in serious injury!
If the start/restart interlock is unlocked, the system can start up automatically.
Ä Before unlocking the start/restart interlock, make certain that no people are in the danger

zone.

The responsible person can restore the ON state of the safety sensor following process interruptions (due
to triggering of protective function, failure of the voltage supply).
Ä Unlock the start/restart interlock using the reset button.

The safety-related switching signals are only enabled if you hold down the reset button for between
0.12 s and 4 s.
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10.4 Shutting down

Temporarily shutting down the machine with the safety sensor
When you shut down the machine with the safety sensor temporarily, you do not have to observe any more
steps. The safety sensor saves the configuration and starts again with the switch-on with this configuration.

Shutting down safety sensor and removing from machine
When you shut down the safety sensor and store it away for a later use, you must reset the safety sensor
to the factory settings.
Ä Reset the safety sensor to the factory settings using the software. 

In the device manager (DTM) of the safety sensor, select the CONFIGURATION tab. 
Click the [Reset safety configuration] button.

10.5 Restarting

Restarting the machine with the safety sensor
If you have only shut down the system with the safety sensor temporarily and are restarting the system
without any changes, you can restart the safety sensor with the configuration that applied with the shut-
down. The configuration remains saved in the safety sensor.
Ä Perform a function test (see chapter 12.3 "Periodically by the operator").

Starting up machine with safety sensor after modification or reconfiguration
If you have performed significant changes on the machine or have reconfigured the safety sensor, the
safety sensor must be checked as with the initial start-up.
Ä Test the safety sensor (see chapter 12.1 "Before the initial start-up and following modifications").

10.6 Starting up replacement scanner unit
The replacement scanner unit and the original scanner unit must be the same with regard to the following
points:

• Scanner unit type in accordance with name plate or downward compatible with previous scanner unit
with greater range and greater function range

• Mounting on the existing connection unit

Mounting and aligning replacement scanner unit
Ä Mount the replacement scanner unit on the connection unit instead of the original scanner unit (see

chapter 14.1 "Changing scanner unit").

NOTICE

Realignment of safety sensor not necessary!
Realignment of the safety sensor is not necessary since the replacement scanner unit is
mounted on the existing, aligned connection unit.

Transferring configuration to replacement scanner unit
The configuration stored in the connection unit is automatically transferred to the replacement scanner unit.

WARNING

Malfunctioning of safety sensor due to incorrect configuration!
Ä The safety sensor configuration stored in the connection unit can only be adopted without

changes if the replacement scanner unit and the original scanner unit are downward com-
patible with respect to range and performance class. 
The replacement scanner unit will reject an invalid configuration.

Ä Change the configuration parameters of the safety sensor using the configuration and diag-
nostic software according to the performance class of the replacement scanner unit.

Ä Change the configuration parameters of the safety sensor using the configuration and diag-
nostic software according to the operating range of the replacement scanner unit.



Starting up the device

Leuze electronic GmbH + Co. KG RSL 420P 88

Transferring configuration with the PC
If the range and/or performance class of the replacement scanner unit is not compatible with the original
scanner unit, you must adapt the configuration of the safety sensor to the replacement scanner unit.
Ä Connect the safety sensor's Ethernet communication interface with the PC.
Ä Configure the safety sensor according to the range and performance class of the replacement scanner

unit (see chapter 9 "Configuring the safety sensor").
Ä Transfer the configuration to the safety sensor with the replacement scanner unit.
ð The alphanumerical display confirms successful transfer of the configuration. 

The replacement scanner unit is not compatible with the connection unit if the safety sensor displays a
fault.

NOTICE

Extension of boot time!
After installing large configurations, the boot time of the safety sensor can increase significantly.

Checking replacement scanner unit
The check performed on the replacement device depends on whether you automatically adopted the con-
figuration from the connection unit or whether you transferred the changed configuration to the safety sen-
sor.
Ä If you adopted the configuration from the connection unit, check the safety sensor using the checklist

for the daily test.
Ä If you transferred a new configuration to the safety sensor, check the safety sensor according to the

routine for initial start-up (see chapter 12.1.1 "Checklist for integrator – to be performed prior to the ini-
tial start-up and following modifications").
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11 PROFIsafe and PROFINET

11.1 Overview
The safety laser scanner is designed as a modular field device and is a PROFIsafe device that communi-
cates cyclically with the assigned PROFIsafe control.
The device can be operated as a single device (standalone) with individual device name in a PROFINET-
IO star or tree topology. The control must communicate this device name to the participant during the de-
vice naming (see chapter 11.4 "Configuring for the Siemens TIA Portal").
By means of the integrated 2-port IRT switch, operation in a linear or ring topology is also possible.

Performance characteristics
The device has the following performance characteristics:

• A GSDML file is available for the device description
• The device family is certified as a PROFINET-IO device according to V2.34
• PROFINET-IO with real-time (RT) communication
• The device family is certified as a PROFIsafe device:
• Integrated 2-port IRT switch
• Standard Fast Ethernet (100 Mbit/s) connection (M12 or push-pull technology)
• Auto-crossover and auto-negotiation
• Cyclical data exchange
• Detection of topology errors
• Identification & maintenance functions (I&M) IM0 – IM4
• The IP address, the PROFIsafe address or the name assignment is set using, e.g., the Siemens

STEP7 or TIA development environment or comparable tools
• Cycle time: min. 1 ms (MinDeviceInterval=32)
• Function range acc. to Conformance Class C
• Network class III, security level 1

Communication
Basic communication and integration takes place via the GSDML file (see chapter 11.2 "GSDML file"). The
modules of the GSDML file do not support any configuration of the device functionality. Configuration is
performed using the Sensor Studio configuration software (see chapter 4 "Configuration and diagnostic
software Sensor Studio").
Each device has a unique MAC address (Media Access Control) that is specified on the name plate. The
MAC address (MAC-ID) is linked to an IP address during the course of configuration. The MAC address
can be found on the name plate.
On delivery, the device is assigned the following network address:

• IP address: 0.0.0.0
• Subnet mask: 255.255.255.0

Electrical connection
For the electrical connection of the supply voltage and the interface, M12 connectors/sockets or AIDA
push/pull connectors/sockets are mounted on the device (see chapter 8 "Electrical connection").
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11.2 GSDML file
The functionality of the safety laser scanner via the PROFINET interface is defined with input/output data
that is defined in the modules of the GSDML file (see chapter 11.5 "PROFINET project modules").
A user-specific configuration tool is used during PLC program creation to integrate the required modules
and configure them appropriately for their respective use.
When operating the device on the PROFINET, all input/output data is occupied with default values. If this
input/output data is not changed by the user, the device operates with the default settings set by Leuze on
delivery. The default settings of the device can be found in the module descriptions.

NOTICE

Observe when configuring PROFINET devices!
Ä Always perform the basic configuration using the GSDML file (GSDML=Generic Station De-

scription Markup Language).
Ä Download the appropriate GSDML file from the Internet: www.leuze.com.
Ä In process operation, the input/output data of the respective, activated GSDML modules are

exchanged with the control.
Ä Settings configured with the Sensor Studio configuration software are overwritten by the

PROFINET master with the settings made via the GSDML file upon connection to
PROFINET.

General information on the GSDML file
The term GSD (Generic Station Description) stands for the textual description of a PROFINET device
model. For the description of the complex PROFINET device model, the XML-based GSDML (Generic Sta-
tion Description Markup Language) was introduced.

• In the GSDML file, all data necessary for operating the device is described in modules:
• Input and output data
• Definition of control bits or status bits.

• During configuration, different module structures and their properties can be selected via Device Ac-
cess Points (DAPs) that are created in the GSDML file.

• The GSDML file can support an arbitrary number of languages in one file. Every GSDML file contains a
version of the RSL 400 PROFIsafe device model. This is also reflected in the file name.

• The GSDML file is a certified and integral part of the device and must not be changed. The file is not
changed by the system either. If parameters are changed in the project tool, for example, these
changes are stored by the control in the project, not in the GSDML file.

NOTICE

GSDML file name structure
The file name of the GSDML file is constructed according to the following rule:
GSDML-[GSDML schema version]-Leuze-RSL400P [connection unit]-[date].xml
[GSDML schema version] = Version identifier of the GSDML schema version used, e.g., V2.34
[Date] = Release date of the GSDML file in the format yyyymmdd
This date also stands for the release date of the file.
Example: GSDML-V2.34-LEUZE-RSL400P CU M12-20190608.xml
for RSL400 PROFIsafe devices with M12 connection unit
The following connection units are defined for the GSDML files:
Ä CU M12: connection unit with M12 connectors/sockets
Ä CU 4M12: connection unit with L-coded M12 connectors/sockets for the voltage supply
Ä CU AIDA: connection unit with push-pull connectors/sockets for copper cables
Ä CU AIDA OF: connection unit with push-pull connectors/sockets for fiber-optic cables
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PROFINET module structures
There are two PROFINET module structures available for configuring the functionality of the safety laser
scanner (see chapter 11.5 "PROFINET project modules").
The desired PROFINET module structure is selected during configuration via Device Access Points (DAPs)
in the GSDML file.

• DAP 1: project modules [M1] … [M8] (see chapter 11.5.1 "Project modules for DAP 1")
• DAP 2: project modules [M11] … [M17] (see chapter 11.5.2 "Project modules for DAP 2")

NOTICE

Ä DAP 1 project modules are only available for PROFIsafe version 2.4.
Ä DAP 2 project modules are available for PROFIsafe versions 2.4 and 2.6.

NOTICE

Ä The DAP 2 project modules can only be used in combination with a device firmware version
of 5.4 or higher and a connection unit firmware version of 2.0 or higher.

GSDML files
The following GSDML files are available:

• For devices with M12 connection unit (CU M12):
• DeviceID: 0x0011
• Textual designation for configuration:

RSL400P M12: modules [M1] … [M8] (DAP 1)
RSL400P M12 V2: modules [M11] … [M17] (DAP 2)

• For devices with AIDA connection unit for copper cables (CU AIDA):
• DeviceID: 0x0012
• Textual designation for configuration:

RSL400P AIDA: modules [M1] … [M8] (DAP 1)
RSL400P AIDA V2: modules [M11] … [M17] (DAP 2)

• For devices with AIDA connection unit for fiber-optic cables (CU AIDA-OF):
• DeviceID: 0x0013
• Textual designation for configuration:

RSL400P AIDA-OF: modules [M1] … [M8] (DAP 1)
RSL400P AIDA-OF V2: modules [M11] … [M17] (DAP 2)

• For devices with connection unit with L-coded M12 connectors/sockets for the voltage supply
(CU 4M12):

• DeviceID: 0x0016
• Textual designation for configuration:

RSL400P 4M12: modules [M1] … [M8] (DAP 1)
RSL400P 4M12 V2: modules [M11] … [M17] (DAP 2)

You can find the GSDML files for the device on the Internet at www.leuze.com. Download the appropriate
GSDML file from the Internet:
Ä Call up the Leuze home page: www.leuze.com
Ä Enter the type designation or part number of the device as the search term.
Ä The GSDML files can be found on the product page for the device under the Downloads tab.
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11.3 Integrating in a PROFIsafe network

11.3.1 Network topology
RSL 400 PROFIsafe devices can be integrated in the following network topologies:

• Star
• Line
• Ring

11.3.2 Addressing
The following information is needed for the RSL 400 PROFIsafe to exchange data with other devices in the
network:

• PROFINET name
• Unique IP address
• Subnet mask
• If applicable, the IP address of the router.

You can assign the data to the RSL 400 PROFIsafe in the following ways:
• Sensor Studio configuration software
• Configuration software for a PROFINET network
• PROFINET control

NOTICE

Storing IP address permanently in the device
Ä If you store the IP address permanently in the RSL 400 PROFIsafe, it is retained even after

the device is switched off.
Ä The IP address can, however, be changed by the PROFINET control.

11.3.3 Configuring the PROFINET control

NOTICE

For further information on configuring the PROFINET control, see see chapter 11.4 "Configuring
for the Siemens TIA Portal".

Proceed as follows to configure the PROFINET control:
Ä Load the GSDML file in the configuration software of the control.
Ä Select the desired device in the hardware catalog, e.g., use the search function and enter RSL400 or

Leuze.
Ä Add the device to the project and connect the device to the control.
Ä Select the PROFINET project modules according to the process image (see chapter 11.5 "PROFINET

project modules").
Ä Assign a unique PROFINET device name.
Ä Set the PROFIsafe parameters.

Tab. 11.1: PROFIsafe parameters

Parameter Meaning Setting
F_SIL Safety integration level of the safety laser

scanner
SIL2 (not changeable)

F_Block_ID ’0’ (not changeable)

F_Par_Version PROFIsafe operating mode ’0’ (not changeable)
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Parameter Meaning Setting
F_Source_Add Address of the safe control.

Must be unique in combination with
F_Dest_Add.

1 … 65534

F_Dest_Add Address of the safety laser scanner.
Address F_Dest_Add must be unique.
F_Dest_Add must be the same address as is
assigned in the configuration of the RSL 400
PROFIsafe device.

1 … 65534

F_WD_Time Watchdog time for the cyclical service.
The watchdog time should be long enough
that small delays in the communication are tol-
erated.
The watchdog time affects the response time
of the total system and is therefore relevant to
safety.

80 ms … 10000 ms
Depending on the application

Ä Configure the RSL 400 PROFIsafe device (if not yet performed; see chapter 9 "Configuring the safety
sensor").

Ä If necessary, perform further configurations in the Sensor Studio configuration software.

11.4 Configuring for the Siemens TIA Portal
The functionality of the device is defined via input/output data, which is organized in modules (see chapter
11.5 "PROFINET project modules"). The modules are part of the device description file (GSDML file, see
chapter 11.2 "GSDML file").
By using a user-specific configuration tool, such as SIMATIC Manager or TIA Portal, the required modules
are integrated in a project during programming via the control. These modules are provided by the GSDML
file.

Integrating RSL 400 PROFIsafe in an existing project
The following steps are necessary for commissioning:
To integrate in an existing project – control (PLC) is already configured – the following steps are necessary:

• Start RSL 400 PROFIsafe
• Prepare the control
• Install the device description file (GSDML file)
• Start TIA Portal
• Load the device description file
• Integrate the RSL 400P in the project
• Connect the RSL 400P to the control
• Add safety module
• Configure RSL400P header module
• Configure the safety module
• Conclude configuration

11.4.1 Start RSL 400 PROFIsafe
Ä Connect the supply voltage (typ. +24 V DC).

ð The RSL 400 PROFIsafe starts up.

11.4.2 Prepare the control
Ä Assign the IO controller of the control an IP address.
Ä Prepare the control for consistent data transmission.
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11.4.3 Install the GSDML file
The following GSDML files are available:

• For devices with M12 connection unit (CU M12):
• DeviceID: 0x0011
• Textual designation for configuration:

RSL400P M12: modules [M1] … [M8] (DAP 1)
RSL400P M12 V2: modules [M11] … [M17] (DAP 2)

• For devices with AIDA connection unit for copper cables (CU AIDA):
• DeviceID: 0x0012
• Textual designation for configuration:

RSL400P AIDA: modules [M1] … [M8] (DAP 1)
RSL400P AIDA V2: modules [M11] … [M17] (DAP 2)

• For devices with AIDA connection unit for fiber-optic cables (CU AIDA-OF):
• DeviceID: 0x0013
• Textual designation for configuration:

RSL400P AIDA-OF: modules [M1] … [M8] (DAP 1)
RSL400P AIDA-OF V2: modules [M11] … [M17] (DAP 2)

• For devices with connection unit with L-coded M12 connectors/sockets for the voltage supply
(CU 4M12):

• DeviceID: 0x0016
• Textual designation for configuration:

RSL400P 4M12: modules [M1] … [M8] (DAP 1)
RSL400P 4M12 V2: modules [M11] … [M17] (DAP 2)

NOTICE

Ä DAP 1 project modules are only available for PROFIsafe version 2.4.
Ä DAP 2 project modules are available for PROFIsafe versions 2.4 and 2.6.

NOTICE

Ä The DAP 2 project modules can only be used in combination with a device firmware version
of 5.4 or higher and a connection unit firmware version of 2.0 or higher.

Download the corresponding GSDML file from the Leuze homepage:
Ä Call up the Leuze home page: www.leuze.com
Ä Enter the type designation or part number of the device as the search term.
Ä The GSDML file can be found on the product page for the device under the Downloads tab.

NOTICE

Do not change the GSDML file!
The GSDML file is a certified and integral part of the device and must not be changed. The file is
not changed by the system either.
If parameters are changed in the project tool, for example, these changes are stored by the con-
trol in the project, not in the GSDML file.

Ä Load the GSDML file for the configuration of the safety laser scanner (see chapter 11.4.5 "Load the de-
vice description file (GSDML file)").
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11.4.4 Start TIA Portal
Ä Start the TIA portal and open an existing project with the configured control (PLC).
Ä Select the Devices & Networks option.
Ä Select the configured PLC with a double-click.

ð The device view dialog is displayed
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11.4.5 Load the device description file (GSDML file)
Ä Open the dialog via Tools > Manage device description file (GSD).
Ä Select the RSL 400 device description file (GSDML file) and click the [Install] button.
Ä Close the Manage device description file dialog.

ð The hardware catalog is updated.

11.4.6 Integrate the RSL 400P in the project
In the project navigation, select Devices & Networks and select the Network view tab.
Ä Open the hardware catalog.

Double-click to select 
Other field devices > Profinet IO > Sensors > Leuze electronic GmbH+Co.KG > Leuze >
RSL400P.
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11.4.7 Connect the RSL 400P to the control
Ä With the left mouse button pressed down, connect the PROFINET port of the RSL 400P(1) to the port

of the PLC (2).

1

2

1 PROFINET port of the RSL 400P
2 Port of the PLC

NOTICE

Ä Make certain that the correct PLC port is selected if multiple ports are configured in the PLC.

ð The RSL 400P is connected to the PLC via PROFINET-IO.
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11.4.8 Add safety module
Ä Open the device view of the RSL400P by double-clicking on the RSL400P list entry.
Ä Insert the PROFINET safety module:

Hardware catalog > Catalog > Module > [M1] Safe Signal
; double-click on [M1] Safe Signal.

Ä If necessary, insert other non-safety-oriented PROFINET modules.
Expand the Device data dialog box in the device view.
You can only insert PROFINET modules that are listed under the Device overview tab.
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11.4.9 Configure RSL400P header module
Ä Expand the Device data dialog box in the device view.
Ä On the Device overview tab, select the 

RSL400P module. Perform the configuration via Properties > General.
Ä Set the Ethernet addresses and the PROFINET device names.
• Assign each IP address a unique PROFINET device name.
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NOTICE

Assign unique device names!
Ä Ensure that the device names are unique and that all participants are located in the same

subnet.

Ä Perform other configuration settings as necessary.

11.4.10 Configure the safety module
On the Device overview tab, select module [M1] Safe Signal.
Ä Set the PROFIsafe parameters via Properties > General > PROFIsafe.

PROFIsafe parameters are marked in yellow

Set the safe device address via the PROFIsafe parameters; (PROFIsafe address; see chapter 11.3.3 "Con-
figuring the PROFINET control").
The PROFIsafe address must be unique.

NOTICE

Default PROFIsafe parameters in the GSDML file
The GSDML file defines the default values for the PROFIsafe parameters. The default values
are used if the PROFIsafe parameters were not modified when configuring.
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11.4.11 Conclude configuration
Ä On the Devices tab, select 

PLC > Compile > Hardware.

11.5 PROFINET project modules
During configuration, different module structures and their properties can be selected via Device Access
Points (DAPs) that are created in the GSDML file:

• DAP 1: project modules [M1] … [M8] (see chapter 11.5.1 "Project modules for DAP 1")
• DAP 2: project modules [M11] … [M17] (see chapter 11.5.2 "Project modules for DAP 2")

NOTICE

Ä DAP 1 project modules are only available for PROFIsafe version 2.4.
Ä DAP 2 project modules are available for PROFIsafe versions 2.4 and 2.6.

NOTICE

Ä The DAP 2 project modules can only be used in combination with a device firmware version
of 5.4 or higher and a connection unit firmware version of 2.0 or higher.

NOTICE

If the scanner is separated from the PROFINET communication unit, the connection is automati-
cally terminated and the communication channel is blocked. In this state, the configured mod-
ules no longer update any data. The switch functionality of the PROFINET connection continues
to exist.

11.5.1 Project modules for DAP 1
Modules [M1] … [M8]

• For devices with M12 connection unit (CU M12):
• DeviceID: 0x0011
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• Textual designation for configuration:
RSL400P M12

• For devices with AIDA connection unit for copper cables (CU AIDA):
• DeviceID: 0x0012
• Textual designation for configuration:

RSL400P AIDA
• For devices with AIDA connection unit for fiber-optic cables (CU AIDA-OF):

• DeviceID: 0x0013
• Textual designation for configuration:

RSL400P AIDA-OF
• For devices with connection unit with L-coded M12 connectors/sockets for the voltage supply

(CU 4M12):
• DeviceID: 0x0016
• Textual designation for configuration:

RSL400P 4M12

Module Description Input data
[Byte]

Output
data
[Byte]

[M1]
SAFE_SIGNAL
see chapter 11.5.3 "Module
[M1] ‑ SAFE_SIGNAL"

Safe module with the safe signals and the
most important status signals for simple
system diagnostics.

3 3

[M2]
SYSTEM_STATUS
see chapter 11.5.4 "Module
[M2] ‑ SYSTEM_STATUS"

General information on error diagnostics
and system alignment.

8 0

[M3]
SCAN_NUMBER
see chapter 11.5.5 "Module
[M3] – SCAN_NUMBER"

Sequential scan number 4 0

[M4]
REFLECTOR_STATUS
see chapter 11.5.6 "Module
[M4] – REFLECTOR_STATUS"

Information on reflectors in the field of view
of the safety laser scanner

2 0

[M5]
PROTECTIVE_FUNC-
TION_A_STATUS
see chapter 11.5.7 "Module
[M5] – PROTECTIVE_FUNC-
TION_A_STATUS"

Detailed status of protective function A 3 0

[M6]
PROTECTIVE_FUNC-
TION_B_STATUS
see chapter 11.5.8 "Module
[M6] – PROTECTIVE_FUNC-
TION_B_STATUS"

Detailed status of protective function B 3 0
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Module Description Input data
[Byte]

Output
data
[Byte]

[M7]
PROTECTIVE_FUNC-
TION_A_VIOLATION
see chapter 11.5.9 "Module
[M7] – PROTECTIVE_FUNC-
TION_A_VIOLATION"

Information on protective field interruption
or warning field interruption of protective
function A

8 0

[M8]
PROTECTIVE_FUNC-
TION_B_VIOLATION
see chapter 11.5.10 "Module
[M8] – PROTECTIVE_FUNC-
TION_B_VIOLATION"

Information on protective field interruption
or warning field interruption of protective
function B

8 0

11.5.2 Project modules for DAP 2
Modules [M11] … [M17]

• For devices with M12 connection unit (CU M12):
• DeviceID: 0x0011
• Textual designation for configuration:

RSL400P M12 V2
• For devices with AIDA connection unit for copper cables (CU AIDA):

• DeviceID: 0x0012
• Textual designation for configuration:

RSL400P AIDA V2
• For devices with AIDA connection unit for fiber-optic cables (CU AIDA-OF):

• DeviceID: 0x0013
• Textual designation for configuration:

RSL400P AIDA-OF V2
• For devices with connection unit with L-coded M12 connectors/sockets for the voltage supply

(CU 4M12):
• DeviceID: 0x0016
• Textual designation for configuration:

RSL400P 4M12 V2

Module Description Input data
[Byte]

Output
data
[Byte]

[M11]
SAFE_SIGNAL_PS2V4
see chapter 11.5.11 "Module
[M11] ‑ SAFE_SIGNAL_PS2V4"

For PROFIsafe version 2.4:
Safe module containing the safe input and
output signals.

3 7

[M11]
SAFE_SIGNAL_PS2V6
see chapter 11.5.12 "Module
[M11] ‑ SAFE_SIGNAL_PS2V6"

For PROFIsafe version 2.6:
Safe module containing the safe input and
output signals.

2 6

[M12]
SYSTEM_STATUS
see chapter 11.5.13 "Module
[M12] ‑ SYSTEM_STATUS"

General information on the status of the de-
vice and safety functions.
Simple system diagnostics is possible.

6 0
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Module Description Input data
[Byte]

Output
data
[Byte]

[M13]
SYSTEM_DATA
see chapter 11.5.14 "Module
[M13] – SYSTEM_DATA"

Current data:
Alignment of the safety laser scanner
Voltage supply
Inside temperature

8 0

[M14]
PROTECTIVE_FUNC-
TION_A_STATUS
see chapter 11.5.15 "Module
[M14] – PROTECTIVE_FUNC-
TION_A_STATUS"

Detailed status of protective function A 8 0

[M15]
PROTECTIVE_FUNC-
TION_B_STATUS
see chapter 11.5.16 "Module
[M15] – PROTECTIVE_FUNC-
TION_B_STATUS"

Detailed status of protective function B 8 0

[M16]
PROTECTIVE_FUNC-
TION_A_VIOLATION
see chapter 11.5.17 "Module
[M16] – PROTECTIVE_FUNC-
TION_A_VIOLATION"

Information on protective field interruption
or warning field interruption of protective
function A

8 0

[M17]
PROTECTIVE_FUNC-
TION_B_VIOLATION
see chapter 11.5.18 "Module
[M17] – PROTECTIVE_FUNC-
TION_B_VIOLATION"

Information on protective field interruption
or warning field interruption of protective
function B

8 0
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11.5.3 Module [M1] ‑ SAFE_SIGNAL
• Module ID: 0x00000002
• Submodule ID: 0x00000001

Description
The module defines the safe input and output data of the RSL 400 PROFIsafe:

• The protective fields and configuration banks are changed over via the output data.
• The output data contains the start signals for releasing a manual (re-)start as well as possibilities for

controlling the data recorder.
• The input data contains the safe switching signals for the protective fields and warning fields of the

RSL 400 PROFIsafe.
• The input data contains the most important diagnostic information for the protective functions, the

RSL 400 and PROFIsafe. Simple device diagnostics is made possible by integrating this module.

NOTICE

The layout of the output data varies depending on the function mode of the RSL 400
PROFIsafe. For this reason, the layout of the output data is listed separately for each function
mode.

Input data structure module SAFE_SIGNAL

Byte in
safe tele-
gram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

0 0 0 Bit A-SAFE-WF-
CLEAR

Y Safe switching sig-
nal of warning field
free - protective
function A

1 Bit A-SAFE-PF-
CLEAR

AS-
SIGNE
D

FREE Y Safe switching sig-
nal of protective
field free - protec-
tive function A

2 Bit B-SAFE-WF-
CLEAR

Y Safe switching sig-
nal of warning field
free - protective
function B

3 Bit B-SAFE-PF-
CLEAR

AS-
SIGNE
D

FREE Y Safe switching sig-
nal of protective
field free - protec-
tive function B

4 Bit A-WF-VIO AS-
SIGNE
D

FREE N Status of active
warning field - pro-
tective function A

5 Bit A-PF-VIO AS-
SIGNE
D

FREE N Status of active
protective field -
protective func-
tion A

6 Bit B-WF-VIO AS-
SIGNE
D

FREE N Status of active
warning field - pro-
tective function B

7 Bit B-PF-VIO AS-
SIGNE
D

FREE N Status of active
protective field -
protective func-
tion B
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Byte in
safe tele-
gram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

1 1 0 Bit A-RES-WF N Start/restart inter-
lock active (start
request A for
warning field)
Note:
The signal is only
necessary if the
warning field is
evaluated as safe.

1 Bit A-RES OFF AC-
TIVE

N Start/restart inter-
lock active (start
request A)

2 Bit B-RES-WF N Start/restart inter-
lock active (start
request B for
warning field)
Note:
The signal is only
necessary if the
warning field is
evaluated as safe.

3 Bit B-RES OFF AC-
TIVE

N Start/restart inter-
lock active (start
request B)

4 Bit Reserve0

5 Bit Reserve1

6 Bit Reserve2

7 Bit Reserve3

2 2 0 Bit ERROR OFF Mes-
sage

N Collective mes-
sage: error with
switch-off

1 Bit SCREEN OFF Mes-
sage

N Optics cover con-
tamination indica-
tor (warning and
switch-off)

2 Bit FIELD PAIR OFF Mes-
sage

N Collective mes-
sage: fault de-
tected by field pair
selection monitor-
ing

3 Bit MODE-PARK NOT
PARKE
D

PARKE
D

N Park request ful-
filled

4 Bit EA1 N Status of local out-
put 1

5 Bit EA2 N Status of local out-
put 2

6 Bit Reserve4

7 Bit Reserve5



PROFIsafe and PROFINET

Leuze electronic GmbH + Co. KG RSL 420P 107

Byte in
safe tele-
gram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

3 3 0 … 7 Byte Profisafe sta-
tus

PROFIsafe status

4 4 0 … 7 Byte CrcHL Crc PROFIsafe

5 5 0 … 7 Byte CrcLH Crc PROFIsafe

6 6 0 … 7 Byte CrcLL Crc PROFIsafe

Output data structure module SAFE_SIGNAL

NOTICE

The layout of the output data varies depending on the function mode of the RSL 400
PROFIsafe. For this reason, the layout of the output data is listed separately for each function
mode.

Tab. 11.2: Function mode: one protective function, 5/10 field pairs

Byte in safe
telegram

Byte in
module

Bit Data type Signal name Safe Description

0 0 0 … 4 Bit Y Field pair selection

5 … 7 Bit Reserve Y

1 1 0 … 7 Bit Reserve Y

2 2 0 … 1 Bit Y Start signals

2 … 6 Bit Reserve Y

7 Bit N Start/stop data
recorder

Tab. 11.3: Function mode: one protective function, 100 field pairs

Byte in safe
telegram

Byte in
module

Bit Data type Signal name Safe Description

0 0 0 … 4 Bit Y Field pair selection
group 1

5 … 7 Bit Reserve Y

1 1 0 … 4 Bit Y Field pair selection
group 2

5 … 7 Bit Reserve Y

2 2 0 … 1 Bit Y Start signals

2 … 6 Bit Reserve Y

7 Bit N Start/stop data
recorder
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Tab. 11.4: Function mode: one protective function, multi configuration

Byte in safe
telegram

Byte in
module

Bit Data type Signal name Safe Description

0 0 0 … 4 Bit Y Bank selection

5 … 7 Bit Reserve Y

1 1 0 … 4 Bit Y Field pair selection

5 … 7 Bit Reserve Y

2 2 0 … 1 Bit Y Start signals

2 … 6 Bit Reserve Y

7 Bit N Start/stop data
recorder

Tab. 11.5: Function mode: two protective functions

Byte in safe
telegram

Byte in
module

Bit Data type Signal name Safe Description

0 0 0 … 4 Bit Y Field pair selection A

5 … 7 Bit Reserve Y

1 1 0 … 4 Bit Y Field pair selection B

5 … 7 Bit Reserve Y

2 2 0 … 1 Bit Y Start signals A

2 … 3 Bit Reserve Y

4 … 5 Bit Y Start signals B

6 Bit Reserve Y

7 Bit N Start/stop data
recorder

Tab. 11.6: Function mode: two protective functions, four field mode

Byte in safe
telegram

Byte in
module

Bit Data type Signal name Safe Description

0 0 0 … 4 Bit Y Field pair selection
group 1 AB

5 … 7 Bit Reserve Y

1 1 0 … 4 Bit Y Field pair selection
group 2 AB

5 … 7 Bit Reserve Y

2 2 0 … 1 Bit Y Start signals A

2 … 3 Bit Reserve Y

4 … 5 Bit Y Start signals B

6 Bit Reserve Y

7 Bit N Start/stop data
recorder
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Tab. 11.7: Function mode: two protective functions, multi configuration

Byte in safe
telegram

Byte in
module

Bit Data type Signal name Safe Description

0 0 0 … 4 Bit Y Field pair selection
group 1 AB

5 … 7 Bit Reserve Y

1 1 0 … 4 Bit Y Field pair selection
group 2 AB

5 … 7 Bit Reserve Y

2 2 0 … 1 Bit Y Start signals A

2 … 3 Bit Reserve Y

4 … 5 Bit Y Start signals B

6 Bit Reserve Y

7 Bit N Start/stop data
recorder



PROFIsafe and PROFINET

Leuze electronic GmbH + Co. KG RSL 420P 110

11.5.4 Module [M2] ‑ SYSTEM_STATUS
• Module ID: 0x00000002
• Submodule ID: 0x00000002

Description
The module supplies information on the current operating mode of the RSL 400 PROFIsafe and on possi-
ble error causes. The module also contains the pitch of the internal spirit level and the internal system tem-
perature.

Input data structure module SYSTEM_STATUS

Byte in
non-safe
telegram

Byte in
module

Bit Data
type

Signal name Value ‘0‘ Value ‘1‘ Safe Description

0 0 0 … 7 Byte OP-MODE N Current operating
mode of the
RSL 400
PROFIsafe

1 1 0 Bit ERROR OFF Message N Collective mes-
sage: error with
switch-off

1 Bit ALARM OFF Message N Collective mes-
sage: warnings
without shutdown
(including optics
cover contamina-
tion warning)

2 Bit SCREEN OFF Message N Optics cover con-
tamination indica-
tor (warning and
switch-off)

3 Bit FIELD PAIR OFF Message N Collective mes-
sage: fault de-
tected by field pair
selection monitor-
ing

4 Bit MODE-PARK NOT
PARKED

PARKED N Park request ful-
filled

5 Bit Reserve1

6 Bit Reserve2

7 Bit Reserve3

2 2 0 … 15 Int16 ALIGNMENT-
H

N Horizontal align-
ment of the spirit
level

4 4 0 … 15 Int16 ALIGNMENT-
V

N Vertical alignment
of the spirit level

6 6 0 … 15 Int16 SYS-TEMP N System tempera-
ture
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11.5.5 Module [M3] – SCAN_NUMBER
• Module ID: 0x00000002
• Submodule ID: 0x00000003

Description
The module contains the sequential scan number of the measurement system. The scan number is a 32-bit
value that is incremented with each revolution of the system. In the event of an overflow and after power-
on, the counter begins with value 0.

Input data structure module SCAN_NUMBER

Byte in
non-safe
telegram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

8 0 0 … 31 uint32 SCAN Y Sequential count-
ing of the scans;
reset to 0 by
switching off

11.5.6 Module [M4] – REFLECTOR_STATUS
• Module ID: 0x00000002
• Submodule ID: 0x00000004

Description
This module supplies information on reflectors that are found in the current scan.

NOTICE

This function has not yet been implemented and only outputs values of '0'.

11.5.7 Module [M5] – PROTECTIVE_FUNCTION_A_STATUS
• Module ID: 0x00000002
• Submodule ID: 0x00000005

The module returns detailed information on the status of protective function A.
• The module indicates whether the protective field or warning field is free or occupied at a certain angle.
• In addition, the module indicates which field pair is selected for protective function A and whether the

active field pair corresponds to a predefined field pair.
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Input data structure module – PROTECTIVE_FUNCTION_A_STATUS

Byte in
non-safe
telegram

Byte in
module

Bit Data
type

Signal name Value ‘0‘ Value ‘1‘ Safe Description

14 0 0 Bit A-ACTIVE OFF ACTIVE N Protective function
A is active / config-
ured

1 Bit A-WF-VIO AS-
SIGNED

FREE N Status of active
warning field - pro-
tective function A

2 Bit A-PF-VIO AS-
SIGNED

FREE N Status of active
protective field -
protective function
A

3 Bit A-WF-VIO-
SEG-1

AS-
SIGNED

FRE N Status of active
warning field seg-
ment – Protective
function A

4 Bit A-WF-VIO-
SEG-2

AS-
SIGNED

FREE N Status of active
warning field seg-
ment – Protective
function A

5 Bit A-PF-VIO-
SEG-1

AS-
SIGNED

FREE N Status of active
protective field
segment - protec-
tive function A

6 Bit A-PF-VIO-
SEG-2

AS-
SIGNED

FREE N Status of active
protective field
segment - protec-
tive function A

7 Reserve0

15 1 0 … 3 Bit A-PAIR-
SEL 1

N First selected field
pair A (numbers
1 - 10)

4 … 7 Bit A-PAIR-
SEL 2

N Second selected
field pair A (num-
bers 1 - 10); super-
imposed field

16 2 0 … 3 Bit A-PAIR-
SEL 3

N Third selected field
pair A (numbers
1 - 10); superim-
posed field

4 Reserve1

5 Reserve2

6 Bit A-FP-SEL-1 OFF SE-
LECTED

N Defined field pair
selected – Protec-
tive function A

7 Bit A-FP-SEL-2 OFF SE-
LECTED

N Defined field pair
selected – Protec-
tive function A
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11.5.8 Module [M6] – PROTECTIVE_FUNCTION_B_STATUS
• Module ID: 0x00000002
• Submodule ID: 0x00000006

The module returns detailed information on the status of protective function B.
• The module indicates whether the protective field or warning field is free or occupied at a certain angle.
• In addition, the module indicates which field pair is selected for protective function B and whether the

active field pair corresponds to a predefined field pair.

Input data structure module – PROTECTIVE_FUNCTION_B_STATUS

Byte in
non-safe
telegram

Byte in
module

Bit Data
type

Signal name Value ‘0‘ Value ‘1‘ Safe Description

17 0 0 Bit B-ACTIVE OFF ACTIVE N Protective function
B is active / config-
ured

1 Bit B-WF-VIO AS-
SIGNED

FREE N Status of active
warning field - pro-
tective function B

2 Bit B-PF-VIO AS-
SIGNED

FREE N Status of active
protective field -
protective function
B

3 Bit B-WF-VIO-
SEG-1

AS-
SIGNED

FRE N Status of active
warning field seg-
ment - protective
function B

4 Bit B-WF-VIO-
SEG-2

AS-
SIGNED

FREE N Status of active
warning field seg-
ment - protective
function B

5 Bit B-PF-VIO-
SEG-1

AS-
SIGNED

FREE N Status of active
protective field
segment - protec-
tive function B

6 Bit B-PF-VIO-
SEG-2

AS-
SIGNED

FREE N Status of active
protective field
segment - protec-
tive function B

7 Reserve0

18 1 0 … 3 Bit B-PAIR-
SEL 1

N First selected field
pair B (numbers
1 - 10)

4 … 7 Bit B-PAIR-
SEL 2

N Second selected
field pair B (num-
bers 1 - 10); super-
imposed field
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Byte in
non-safe
telegram

Byte in
module

Bit Data
type

Signal name Value ‘0‘ Value ‘1‘ Safe Description

19 2 0 … 3 Bit B-PAIR-
SEL 3

N Third selected field
pair B (numbers
1 - 10); superim-
posed field

4 Reserve1

5 Reserve2

6 Bit B-FP-SEL-1 OFF SE-
LECTED

N Defined field pair
selected - protec-
tive function B

7 Bit B-FP-SEL-2 OFF SE-
LECTED

N Defined field pair
selected - protec-
tive function B

11.5.9 Module [M7] – PROTECTIVE_FUNCTION_A_VIOLATION
• Module ID: 0x00000002
• Submodule ID: 0x00000007

If the protective field or warning field is interrupted for protective function A, the module indicates the angle
and distance of the first interruption. The first interruption corresponds to the first interruption in the direc-
tion of rotation.

Input data structure module – PROTECTIVE_FUNCTION_A_VIOLATION

Byte in
non-safe
telegram

Byte in
module

Bit Data
type

Signal name Value ‘0‘ Value ‘1‘ Safe Description

20 0 0 … 15 Int16 A-PF-VIO-
ANGLE

N Angle of the first
beam with protec-
tive field violation
in the direction of
rotation for protec-
tive field
-135 ° … +135 °

22 2 0 … 15 uInt16 A-PF-VIO-
RADIUS

N Distance of the
first beam with pro-
tective field viola-
tion in the direction
of rotation for pro-
tective field
0 mm … 8250 mm

24 4 0 … 15 Int16 A-WF-VIO-
ANGLE

N Angle of the first
beam with warning
field violation in the
direction of rotation
for warning field
-135 ° … +135 °

26 6 0 … 15 uInt16 A-WF-VIO-
RADIUS

N Distance of the
first beam with
warning field viola-
tion in the direction
of rotation for
warning field
0 mm … 20000 m
m
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11.5.10 Module [M8] – PROTECTIVE_FUNCTION_B_VIOLATION
• Module ID: 0x00000002
• Submodule ID: 0x00000008

If the protective field or warning field is interrupted for protective function B, the module indicates the angle
and distance of the first interruption. The first interruption corresponds to the first interruption in the direc-
tion of rotation.

Input data structure module – PROTECTIVE_FUNCTION_B_VIOLATION

Byte in
non-safe
telegram

Byte in
module

Bit Data
type

Signal name Value ‘0‘ Value ‘1‘ Safe Description

20 0 0 … 15 Int16 B-PF-VIO-
ANGLE

N Angle of the first
beam with protec-
tive field violation
in the direction of
rotation for protec-
tive field
-135 ° … +135 °

22 2 0 … 15 uInt16 B-PF-VIO-
RADIUS

N Distance of the
first beam with pro-
tective field viola-
tion in the direction
of rotation for pro-
tective field
0 mm … 8250 mm

24 4 0 … 15 Int16 B-WF-VIO-
ANGLE

N Angle of the first
beam with warning
field violation in the
direction of rotation
for warning field
-135 ° … +135 °

26 6 0 … 15 uInt16 B-WF-VIO-
RADIUS

N Distance of the
first beam with
warning field viola-
tion in the direction
of rotation for
warning field
0 mm … 20000 m
m

11.5.11 Module [M11] ‑ SAFE_SIGNAL_PS2V4

NOTICE

SAFE_SIGNAL module for PROFIsafe version 2.4

• Module ID: 0x00000004
• Submodule ID: 0x0000000B

Description
The module defines the safe input and output signals of the RSL 400 PROFIsafe:

• The protective fields and configuration banks are changed over via the output signals.
• The output signals contain the start signals for releasing a manual (re-)start.
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• The input data contains the safe switching signals for the protective fields and warning fields of the
RSL 400 PROFIsafe.

NOTICE

The layout of the output data varies depending on the function mode of the RSL 400
PROFIsafe. For this reason, the layout of the output data is listed separately for each function
mode.

Input data structure module SAFE_SIGNAL_PS2V4

Byte in
safe tele-
gram

Byte
in
mod-
ule

Bit Data
type

Signal
name

Value
‘0‘

Value
‘1‘

Safe Description

0 0 0 Bit A-SAFE-
WF-CLEAR

AS-
SIGNE
D

FREE Y Safe switching signal of
warning field free - protec-
tive function A

1 Bit A-SAFE-PF-
CLEAR

AS-
SIGNE
D

FREE Y Safe switching signal of
protective field free - pro-
tective function A

2 … 7 Bit Reserve

1 1 0 Bit B-SAFE-
WF-CLEAR

AS-
SIGNE
D

FREE Y Safe switching signal of
warning field free - protec-
tive function B.

1 Bit A-SAFE-PF-
CLEAR

AS-
SIGNE
D

FREE Y Safe switching signal of
protective field free - pro-
tective function B

2 … 7 Bit Reserve

2 2 0 … 7 Byte Reserve

3 3 0 … 7 Byte Profisafe
status

PROFIsafe status

4 4 0 … 7 Byte CrcHL Crc PROFIsafe

5 5 0 … 7 Byte CrcLH Crc PROFIsafe

6 6 0 … 7 Byte CrcLL Crc PROFIsafe

Output data structure module SAFE_SIGNAL_PS2V4

NOTICE

The layout of the output data varies depending on the function mode of the RSL 400
PROFIsafe. For this reason, the layout of the output data is listed separately for each function
mode.

Tab. 11.8: General layout of the output data

Byte in
safe
tele-
gram

Byte in
module

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

0 … 5 0 … 5 0 … 7 Byte Output data ac-
cording to the func-
tion mode

6 6 0 … 7 Byte Reserve
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Byte in
safe
tele-
gram

Byte in
module

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

7 7 0 … 7 Byte Profisafe sta-
tus

PROFIsafe status

8 8 0 … 7 Byte CrcHL Crc PROFIsafe

9 9 0 … 7 Byte CrcLH Crc PROFIsafe

10 10 0 … 7 Byte CrcLL Crc PROFIsafe

Tab. 11.9: Function mode: one protective function, 5/10 field pairs

Byte in
safe tele-
gram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

0 0 0 … 4 Bit Y Selection of pro-
tective field
switchover
(F1 … F5) - pro-
tective function A

5 … 7 Bit Reserve

1 1 0 … 7 Bit Reserve

2 2 0 … 7 Byte Reserve

3 3 0 … 7 Byte Reserve

4 4 0 Bit OFF AC-
TIVE

Y Start/restart signal
for warning field -
protective func-
tion A

1 OFF AC-
TIVE

Y Start/restart signal
for protective field
- protective func-
tion A

2 … 7 Bit Reserve

5 5 0 … 7 Byte Reserve

Tab. 11.10: Function mode: one protective function, 100 field pairs

Byte in
safe tele-
gram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

0 0 0 … 4 Bit Y Selection of pro-
tective field
switchover
group 1 (F1 … F5)

5 … 7 Bit Reserve

1 1 0 … 7 Byte Reserve

2 2 0 … 4 Bit Y Selection of pro-
tective field
switchover
group 2
(F6 … F10)

5 … 7 Bit Reserve

3 3 0 … 7 Byte Reserve



PROFIsafe and PROFINET

Leuze electronic GmbH + Co. KG RSL 420P 118

Byte in
safe tele-
gram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

4 4 0 Bit OFF AC-
TIVE

Y Start/restart signal
for warning field -
protective func-
tion A

1 OFF AC-
TIVE

Y Start/restart signal
for protective field
- protective func-
tion A

2 … 7 Bit Reserve

5 5 0 … 7 Byte Reserve

Tab. 11.11: Function mode: one protective function, multi configuration

Byte in
safe tele-
gram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

0 0 0 … 4 Bit Y Selection of con-
figuration bank
(F1 … F5) - pro-
tective function A

5 … 7 Bit Reserve

1 1 0 … 7 Byte Reserve

2 2 0 … 4 Bit Y Selection of pro-
tective field
switchover
(F6 … F10) - pro-
tective function A

5 … 7 Bit Reserve

3 3 0 … 7 Byte Reserve

4 4 0 Bit OFF AC-
TIVE

Y Start/restart signal
for warning field -
protective func-
tion A

1 OFF AC-
TIVE

Y Start/restart signal
for protective field
- protective func-
tion A

2 … 7 Bit Reserve

5 5 0 … 7 Byte Reserve

Tab. 11.12: Function mode: two protective functions

Byte in
safe tele-
gram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

0 0 0 … 4 Bit Y Selection of pro-
tective field
switchover
(F1 … F5) - pro-
tective function A

5 … 7 Bit Reserve



PROFIsafe and PROFINET

Leuze electronic GmbH + Co. KG RSL 420P 119

Byte in
safe tele-
gram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

1 1 0 … 7 Byte Reserve

2 2 0 … 4 Bit Y Selection of pro-
tective field
switchover
(F6 … F10) - pro-
tective function B

5 … 7 Bit Reserve

3 3 0 … 7 Byte Reserve

4 4 0 Bit OFF AC-
TIVE

Y Start/restart signal
for warning field -
protective func-
tion A

1 OFF AC-
TIVE

Y Start/restart signal
for protective field
- protective func-
tion A

2 … 7 Bit Reserve

5 5 0 Bit OFF AC-
TIVE

Y Start/restart signal
for warning field -
protective func-
tion B

1 OFF AC-
TIVE

Y Start/restart signal
for protective field
- protective func-
tion B

2 … 7 Bit Reserve

Tab. 11.13: Function mode: two protective functions, four field mode

Byte in
safe tele-
gram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

0 0 0 … 4 Bit Y Selection of pro-
tective field
switchover
group 1 (F1 … F5)
- protective func-
tion A, B

5 … 7 Bit Reserve

1 1 0 … 7 Byte Reserve

2 2 0 … 4 Bit Y Selection of pro-
tective field
switchover
group 2
(F6 … F10) - pro-
tective function A,
B

5 … 7 Bit Reserve

3 3 0 … 7 Byte Reserve
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Byte in
safe tele-
gram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

4 4 0 Bit OFF AC-
TIVE

Y Start/restart signal
for warning field -
protective func-
tion A

1 OFF AC-
TIVE

Y Start/restart signal
for protective field
- protective func-
tion A

2 … 7 Bit Reserve

5 5 0 Bit OFF AC-
TIVE

Y Start/restart signal
for warning field -
protective func-
tion B

1 OFF AC-
TIVE

Y Start/restart signal
for protective field
- protective func-
tion B

2 … 7 Bit Reserve

Tab. 11.14: Function mode: two protective functions, multi configuration

Byte in
safe tele-
gram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

0 0 0 … 4 Bit Y Selection of con-
figuration bank
(F1 … F5) - pro-
tective function A,
B

5 … 7 Bit Reserve

1 1 0 … 7 Byte Reserve

2 2 0 … 4 Bit Y Selection of pro-
tective field
switchover
(F6 … F10) - pro-
tective function A,
B

5 … 7 Bit Reserve

3 3 0 … 7 Byte Reserve

4 4 0 Bit OFF AC-
TIVE

Y Start/restart signal
for warning field -
protective func-
tion A

1 OFF AC-
TIVE

Y Start/restart signal
for protective field
- protective func-
tion A

2 … 7 Bit Reserve
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Byte in
safe tele-
gram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

5 5 0 Bit OFF AC-
TIVE

Y Start/restart signal
for warning field -
protective func-
tion B

1 OFF AC-
TIVE

Y Start/restart signal
for protective field
- protective func-
tion B

2 … 7 Bit Reserve

11.5.12 Module [M11] ‑ SAFE_SIGNAL_PS2V6

NOTICE

SAFE_SIGNAL module for PROFIsafe version 2.6

• Module ID: 0x00000004
• Submodule ID: 0x0000001B

Description
The module defines the safe input and output signals of the RSL 400 PROFIsafe:

• The protective fields and configuration banks are changed over via the output signals.
• The output signals contain the start signals for releasing a manual (re-)start.
• The input data contains the safe switching signals for the protective fields and warning fields of the

RSL 400 PROFIsafe.

NOTICE

The layout of the output data varies depending on the function mode of the RSL 400
PROFIsafe. For this reason, the layout of the output data is listed separately for each function
mode.

Input data structure module SAFE_SIGNAL_PS2V6

Byte in
safe tele-
gram

Byte
in
mod-
ule

Bit Data
type

Signal
name

Value
‘0‘

Value
‘1‘

Safe Description

0 0 0 Bit A-SAFE-
WF-CLEAR

AS-
SIGNE
D

FREE Y Safe switching signal of
warning field free - protec-
tive function A

1 Bit A-SAFE-PF-
CLEAR

AS-
SIGNE
D

FREE Y Safe switching signal of
protective field free - pro-
tective function A

2 … 7 Bit Reserve
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Byte in
safe tele-
gram

Byte
in
mod-
ule

Bit Data
type

Signal
name

Value
‘0‘

Value
‘1‘

Safe Description

1 1 0 Bit B-SAFE-
WF-CLEAR

AS-
SIGNE
D

FREE Y Safe switching signal of
warning field free - protec-
tive function B.

1 Bit A-SAFE-PF-
CLEAR

AS-
SIGNE
D

FREE Y Safe switching signal of
protective field free - pro-
tective function B

2 … 7 Bit Reserve

2 2 0 … 7 Byte Profisafe
status

PROFIsafe status

3 3 0 … 7 Byte CrcHH PROFIsafe Crc

4 4 0 … 7 Byte CrcHL Crc PROFIsafe

5 5 0 … 7 Byte CrcLH Crc PROFIsafe

6 6 0 … 7 Byte CrcLL Crc PROFIsafe

Output data structure module SAFE_SIGNAL_PS2V6

NOTICE

The layout of the output data varies depending on the function mode of the RSL 400
PROFIsafe. For this reason, the layout of the output data is listed separately for each function
mode.

Tab. 11.15: General layout of the output data

Byte in
safe
tele-
gram

Byte in
module

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

0 … 5 0 … 5 0 … 7 Byte Output data ac-
cording to the func-
tion mode

6 6 0 … 7 Byte Profisafe sta-
tus

PROFIsafe status

7 7 0 … 7 Byte CrcHH PROFIsafe Crc

8 8 0 … 7 Byte CrcHL Crc PROFIsafe

9 9 0 … 7 Byte CrcLH Crc PROFIsafe

10 10 0 … 7 Byte CrcLL Crc PROFIsafe

Tab. 11.16: Function mode: one protective function, 5/10 field pairs

Byte in
safe tele-
gram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

0 0 0 … 4 Bit Y Selection of pro-
tective field
switchover
(F1 … F5) - pro-
tective function A

5 … 7 Bit Reserve
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Byte in
safe tele-
gram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

1 1 0 … 7 Bit Reserve

2 2 0 … 7 Byte Reserve

3 3 0 … 7 Byte Reserve

4 4 0 Bit OFF AC-
TIVE

Y Start/restart signal
for warning field -
protective func-
tion A

1 OFF AC-
TIVE

Y Start/restart signal
for protective field
- protective func-
tion A

2 … 7 Bit Reserve

5 5 0 … 7 Byte Reserve

Tab. 11.17: Function mode: one protective function, 100 field pairs

Byte in
safe tele-
gram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

0 0 0 … 4 Bit Y Selection of pro-
tective field
switchover
group 1 (F1 … F5)

5 … 7 Bit Reserve

1 1 0 … 7 Byte Reserve

2 2 0 … 4 Bit Y Selection of pro-
tective field
switchover
group 2
(F6 … F10)

5 … 7 Bit Reserve

3 3 0 … 7 Byte Reserve

4 4 0 Bit OFF AC-
TIVE

Y Start/restart signal
for warning field -
protective func-
tion A

1 OFF AC-
TIVE

Y Start/restart signal
for protective field
- protective func-
tion A

2 … 7 Bit Reserve

5 5 0 … 7 Byte Reserve
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Tab. 11.18: Function mode: one protective function, multi configuration

Byte in
safe tele-
gram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

0 0 0 … 4 Bit Y Selection of con-
figuration bank
(F1 … F5) - pro-
tective function A

5 … 7 Bit Reserve

1 1 0 … 7 Byte Reserve

2 2 0 … 4 Bit Y Selection of pro-
tective field
switchover
(F6 … F10) - pro-
tective function A

5 … 7 Bit Reserve

3 3 0 … 7 Byte Reserve

4 4 0 Bit OFF AC-
TIVE

Y Start/restart signal
for warning field -
protective func-
tion A

1 OFF AC-
TIVE

Y Start/restart signal
for protective field
- protective func-
tion A

2 … 7 Bit Reserve

5 5 0 … 7 Byte Reserve

Tab. 11.19: Function mode: two protective functions

Byte in
safe tele-
gram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

0 0 0 … 4 Bit Y Selection of pro-
tective field
switchover
(F1 … F5) - pro-
tective function A

5 … 7 Bit Reserve

1 1 0 … 7 Byte Reserve

2 2 0 … 4 Bit Y Selection of pro-
tective field
switchover
(F6 … F10) - pro-
tective function B

5 … 7 Bit Reserve

3 3 0 … 7 Byte Reserve
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Byte in
safe tele-
gram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

4 4 0 Bit OFF AC-
TIVE

Y Start/restart signal
for warning field -
protective func-
tion A

1 OFF AC-
TIVE

Y Start/restart signal
for protective field
- protective func-
tion A

2 … 7 Bit Reserve

5 5 0 Bit OFF AC-
TIVE

Y Start/restart signal
for warning field -
protective func-
tion B

1 OFF AC-
TIVE

Y Start/restart signal
for protective field
- protective func-
tion B

2 … 7 Bit Reserve

Tab. 11.20: Function mode: two protective functions, four field mode

Byte in
safe tele-
gram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

0 0 0 … 4 Bit Y Selection of pro-
tective field
switchover
group 1 (F1 … F5)
- protective func-
tion A, B

5 … 7 Bit Reserve

1 1 0 … 7 Byte Reserve

2 2 0 … 4 Bit Y Selection of pro-
tective field
switchover
group 2
(F6 … F10) - pro-
tective function A,
B

5 … 7 Bit Reserve

3 3 0 … 7 Byte Reserve

4 4 0 Bit OFF AC-
TIVE

Y Start/restart signal
for warning field -
protective func-
tion A

1 OFF AC-
TIVE

Y Start/restart signal
for protective field
- protective func-
tion A

2 … 7 Bit Reserve
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Byte in
safe tele-
gram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

5 5 0 Bit OFF AC-
TIVE

Y Start/restart signal
for warning field -
protective func-
tion B

1 OFF AC-
TIVE

Y Start/restart signal
for protective field
- protective func-
tion B

2 … 7 Bit Reserve

Tab. 11.21: Function mode: two protective functions, multi configuration

Byte in
safe tele-
gram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

0 0 0 … 4 Bit Y Selection of con-
figuration bank
(F1 … F5) - pro-
tective function A,
B

5 … 7 Bit Reserve

1 1 0 … 7 Byte Reserve

2 2 0 … 4 Bit Y Selection of pro-
tective field
switchover
(F6 … F10) - pro-
tective function A,
B

5 … 7 Bit Reserve

3 3 0 … 7 Byte Reserve

4 4 0 Bit OFF AC-
TIVE

Y Start/restart signal
for warning field -
protective func-
tion A

1 OFF AC-
TIVE

Y Start/restart signal
for protective field
- protective func-
tion A

2 … 7 Bit Reserve

5 5 0 Bit OFF AC-
TIVE

Y Start/restart signal
for warning field -
protective func-
tion B

1 OFF AC-
TIVE

Y Start/restart signal
for protective field
- protective func-
tion B

2 … 7 Bit Reserve
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11.5.13 Module [M12] ‑ SYSTEM_STATUS
• Module ID: 0x00000004
• Submodule ID: 0x0000000C

Description
The module supplies information on the current operating mode of the RSL400 and on possible error
causes. It contains the most important diagnostic information for the total system and the individual protec-
tive functions. Simple device diagnostics is made possible by integrating this module.

Input data structure module SYSTEM_STATUS

Byte in
non-safe
telegram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

0 0 0 … 7 Byte OP-MODE N Current operating
mode of the
RSL 400
PROFIsafe
0: No configura-
tion defined
1: Safety monitor-
ing mode
2: Simulation
mode

1 1 0 Bit A-ACTIVE N Y N Protective func-
tion A active / con-
figured

1 … 3 Bit Reserve

4 Bit B-ACTIVE N Y N Protective func-
tion B active / con-
figured

5 … 7 Bit Reserve

2 2 0 Bit ERROR OFF Mes-
sage

N Collective mes-
sage: error (safety
bit 0)

1 Bit ALARM OFF Mes-
sage

N Collective mes-
sage: warning
(safety bit 1)

2 Bit SCREEN OFF Mes-
sage

N Contamination dis-
play for optics
cover
(Warning and
switch-off)

3 Bit FIELD PAIR OFF Mes-
sage

N Collective mes-
sage for field pair
changeover error

4 Bit MODE-PARK NOT
PARKE
D

PARKE
D

N Park mode con-
firmed

5 … 7 Bit Reserve
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Byte in
non-safe
telegram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

3 3 0 Bit EA1 N Status of local out-
put 1 (currently not
implemented)

1 Bit EA2 N Status of local out-
put 2 (currently not
implemented)

2 … 7 Bit Reserve

4 4 0 Bit A-WF-VIO AS-
SIGNE
D

FREE N Status of active
warning field - pro-
tective function A

1 Bit A-PF-VIO AS-
SIGNE
D

FREE N Status of active
protective field -
protective func-
tion A

2 … 3 Bit Reserve

4 Bit B-WF-VIO AS-
SIGNE
D

FREE N Status of active
warning field - pro-
tective function B

5 Bit B-PF-VIO AS-
SIGNE
D

FREE N Status of active
protective field -
protective func-
tion B

6 … 7 Bit Reserve

5 5 0 Bit A-RES-WF OFF AC-
TIVE

N Start/restart active
(warning field A)

1 Bit A-RES OFF AC-
TIVE

N Start/restart active
(protective field A)

2 … 3 Bit Reserve

4 Bit B-RES-WF OFF AC-
TIVE

N Start/restart active
(warning field B)

5 Bit B-RES OFF AC-
TIVE

N Start/restart active
(protective field B)

6 … 7 Bit Reserve
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11.5.14 Module [M13] – SYSTEM_DATA
• Module ID: 0x00000004
• Submodule ID: 0x0000000D

Description
The module contains the current data of the internal spirit level for aligning the device.
The module also contains the data of the inside temperature and the applied supply voltage.

Input data structure module SYSTEM_DATA

Byte in
non-safe
telegram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

6 0 0 … 15 int16 ALIGNMENT-
H

N Horizontal align-
ment of the spirit
level
-90 ° … +90 °
0.01 ° display

8 2 0 … 15 int16 ALIGNMENT-
V

N Vertical alignment
of the spirit level
-90 ° … +90 °
0.01 ° display

10 4 0 … 15 int16 SYS-TEMP N Internal system
temperature
0.1 °C display

12 6 0 … 15 int16 VOLTAGE N Applied supply
voltage
0.1 V display

11.5.15 Module [M14] – PROTECTIVE_FUNCTION_A_STATUS
• Module ID: 0x00000004
• Submodule ID: 0x0000000E

The module returns detailed information on the status of protective function A.
• The module indicates whether the protective field or warning field is free or occupied at a certain angle.
• In addition, the module indicates which field pair is selected for protective function A and whether the

active field pair corresponds to a predefined field pair.

Input data structure module – PROTECTIVE_FUNCTION_A_STATUS

Byte in
non-safe
telegram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

14 0 0 Bit A-WF-VIO AS-
SIGNE
D

FREE N Status of active
warning field - pro-
tective function A

1 Bit A-PF-VIO AS-
SIGNE
D

FREE N Status of active
protective field -
protective function
A

2 … 3 Bit Reserve

4 Bit A-ACTIVE OFF AC-
TIVE

N Protective func-
tion A active / con-
figured

5 … 7 Bit Reserve



PROFIsafe and PROFINET

Leuze electronic GmbH + Co. KG RSL 420P 130

Byte in
non-safe
telegram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

15 1 0 Bit A-RES-WF OFF AC-
TIVE

N Start/restart active
(warning field A)

1 Bit A-RES OFF AC-
TIVE

N Start/restart active
(protective field A)

2 … 7 Bit Reserve

16 2 0 Bit A-WF-VIO-
SEG-1

AS-
SIGNE
D

FREE N Status of active
warning field seg-
ment 1 - protective
function A

1 Bit A-WF-VIO-
SEG-2

AS-
SIGNE
D

FREE N Status of active
warning field seg-
ment 2 - protective
function A

2 … 7 Bit Reserve

17 3 0 Bit A-PF-VIO-
SEG-1

AS-
SIGNE
D

FREE N Status of active
protective field
segment 1 - pro-
tective function A

1 Bit A-PF-VIO-
SEG-2

AS-
SIGNE
D

FREE N Status of active
protective field
segment 2 - pro-
tective function A

2 … 7 Bit Reserve

18 4 0 … 3 Bit A-PAIR-
SEL 1

N First selected field
pair A (numbers
1 … 10)

4 … 7 Bit A-PAIR-
SEL 2

N Second selected
field pair A (num-
bers 1 … 10); su-
perimposed field

19 5 0 … 3 Bit A-PAIR-
SEL 3

N Third selected
field pair A (num-
bers 1 … 10); su-
perimposed field
(currently not im-
plemented)

4 … 7 Reserve

20 6 0 Bit A-FP-SEL-1 OFF SE-
LECTE
D

N Defined field pair
selected 1 - pro-
tective function A

1 Bit A-FP-SEL-2 OFF SE-
LECTE
D

N Defined field pair
selected 2 - pro-
tective function A

2 … 7 Bit Reserve

21 7 0 … 7 Byte Reserve
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11.5.16 Module [M15] – PROTECTIVE_FUNCTION_B_STATUS
• Module ID: 0x00000004
• Submodule ID: 0x0000000F

The module returns detailed information on the status of protective function B.
• The module indicates whether the protective field or warning field is free or occupied at a certain angle.
• In addition, the module indicates which field pair is selected for protective function B and whether the

active field pair corresponds to a predefined field pair.

Tab. 11.22: Input data structure module – PROTECTIVE_FUNCTION_B_STATUS

Byte in
non-safe
telegram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

22 0 0 Bit B-WF-VIO AS-
SIGNE
D

FREE N Status of active
warning field - pro-
tective function B

1 Bit B-PF-VIO AS-
SIGNE
D

FREE N Status of active
protective field -
protective func-
tion B

2 … 3 Bit Reserve

4 Bit B-ACTIVE N Y N Protective func-
tion B active / con-
figured

5 … 7 Bit Reserve

23 1 0 Bit B-RES-WF OFF AC-
TIVE

N Start/restart active
(warning field B)

1 Bit B-RES OFF AC-
TIVE

N Start/restart active
(protective field B)

2 … 7 Bit Reserve

24 2 0 Bit B-WF-VIO-
SEG-1

AS-
SIGNE
D

FREE N Status of active
warning field seg-
ment 1 - protective
function B

1 Bit B-WF-VIO-
SEG-2

AS-
SIGNE
D

FREE N Status of active
warning field seg-
ment 2 - protective
function B

2 … 7 Bit Reserve

25 3 0 Bit B-PF-VIO-
SEG-1

AS-
SIGNE
D

FREE N Status of active
protective field
segment 1 - pro-
tective function B

1 Bit B-PF-VIO-
SEG-2

AS-
SIGNE
D

FREE N Status of active
protective field
segment 2 - pro-
tective function B

2 … 7 Bit Reserve
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26 4 0 … 3 Bit B-PAIR-
SEL 1

N First selected field
pair B (numbers
1 … 10)

4 … 7 Bit B-PAIR-
SEL 2

N Second selected
field pair B (num-
bers 1 … 10); su-
perimposed field

27 5 0 … 3 Bit B-PAIR-
SEL 3

N Third selected
field pair B (num-
bers 1 … 10); su-
perimposed field
(currently not im-
plemented)

4 … 7 Reserve

28 6 0 Bit B-FP-SEL-1 OFF SE-
LECTE
D

N Defined field pair
selected 1 - pro-
tective function B

1 Bit B-FP-SEL-2 OFF SE-
LECTE
D

N Defined field pair
selected 2 - pro-
tective function B

2 … 7 Bit Reserve

29 7 0 … 7 Byte Reserve

11.5.17 Module [M16] – PROTECTIVE_FUNCTION_A_VIOLATION
• Module ID: 0x00000004
• Submodule ID: 0x00000010

If the protective field or warning field is interrupted for protective function A, the module indicates the angle
and distance of the first interruption. The first interruption corresponds to the first interruption in the direc-
tion of rotation.

Input data structure module – PROTECTIVE_FUNCTION_A_VIOLATION

Byte in
non-safe
telegram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

30 0 0 … 15 int16 A-WF-VIO-
ANGLE

N Angle of the first
beam with warning
field violation in
the direction of ro-
tation for warning
field
-135 ° … +135 °

32 2 0 … 15 uint16 A-WF-VIO-
RADIUS

N Distance of the
first beam with
warning field viola-
tion in the direc-
tion of rotation for
warning field
0 mm … 20000 m
m
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Byte in
non-safe
telegram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

34 4 0 … 15 int16 A-PF-VIO-
ANGLE

N Angle of the first
beam with protec-
tive field violation
in the direction of
rotation for protec-
tive field
-135 ° … +135 °

36 6 0 … 15 uint16 A-PF-VIO-
RADIUS

N Distance of the
first beam with
protective field vio-
lation in the direc-
tion of rotation for
protective field
0 mm … 8250 mm

11.5.18 Module [M17] – PROTECTIVE_FUNCTION_B_VIOLATION
• Module ID: 0x00000004
• Submodule ID: 0x00000011

If the protective field or warning field is interrupted for protective function B, the module indicates the angle
and distance of the first interruption. The first interruption corresponds to the first interruption in the direc-
tion of rotation.

Input data structure module – PROTECTIVE_FUNCTION_B_VIOLATION

Byte in
non-safe
telegram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

38 0 0 … 15 int16 B-WF-VIO-
ANGLE

N Angle of the first
beam with warning
field violation in
the direction of ro-
tation for warning
field
-135 ° … +135 °

40 2 0 … 15 uint16 B-WF-VIO-
RADIUS

N Distance of the
first beam with
warning field viola-
tion in the direc-
tion of rotation for
warning field
0 mm … 20000 m
m
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Byte in
non-safe
telegram

Byte in
mod-
ule

Bit Data
type

Signal name Value
‘0‘

Value
‘1‘

Safe Description

42 4 0 … 15 int16 B-PF-VIO-
ANGLE

N Angle of the first
beam with protec-
tive field violation
in the direction of
rotation for protec-
tive field
-135 ° … +135 °

44 6 0 … 15 uint16 B-PF-VIO-
RADIUS

N Distance of the
first beam with
protective field vio-
lation in the direc-
tion of rotation for
protective field
0 mm … 8250 mm

11.6 Status messages of the PROFINET stack
In certain situations, the safety laser scanner may send device-specific PROFINET status messages to the
control that are not described in the PROFINET standard.
These PROFINET status messages indicate a special situation in which the device is located.
The following device-specific PROFINET status messages are defined for RSL 400 PROFIsafe devices:

Value Text Description
0x8181FF00 Resource available again A scanner unit was plugged into the connection unit

during operation. The total system is now ready for op-
eration.

0x8181FF01 Resource unavailable The scanner unit was unplugged from the connection
unit during operation. As a result, valid data is no
longer available.

0x8181FF03 Configuration changed A valid configuration was loaded in the device for the
first time. The system switches to monitoring mode.

NOTICE

You can find further information on PROFINET status message in the description of the
PROFINET device protocol.
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12 Testing
NOTICE

Ä Safety sensors must be replaced at the end of their mission time (see chapter 16 "Technical
data").

Ä Always exchange entire safety sensors.
Ä For the tests, observe, if necessary, nationally applicable regulations.
Ä Document all tests in a comprehensible manner and include the configuration of the safety

sensor along with the data for the safety- and minimum distances in the documentation.

12.1 Before the initial start-up and following modifications

WARNING

Unpredictable machine behavior during initial start-up may result in serious injury!
Ä Make certain that there are no people in the danger zone.

Ä Before they begin work, train the operators on their respective tasks. The training is the responsibility of
the operating company.

Ä Attach notes regarding daily testing in the respective national language of the operator on the machine
in a highly visible location, e.g. by printing out the corresponding chapter (see chapter 12.3 "Periodically
by the operator").

Ä Test the electrical function and installation according to this document.
Acc. to IEC 62046 and national regulations (e.g. EU directive 2009/104/EC), tests are to be performed by
competent persons in the following situations:

• Prior to initial commissioning
• Following modifications to the machine
• After longer machine downtime
• Following retrofitting or new configuration of the machine
Ä As preparation, check the most important criteria for the safety sensor according to the following check-

list (see chapter 12.1.1 "Checklist for integrator – to be performed prior to the initial start-up and follow-
ing modifications"). Completing the checklist does not replace testing by a competent person!

Not until proper function of the safety sensor is ascertained may it be integrated in the control circuit of the
system.

12.1.1 Checklist for integrator – to be performed prior to the initial start-up and following modifications

NOTICE

Completing the checklist does not replace testing by a competent person!
Ä If you answer one of the items on the check list with no, the machine must no longer be op-

erated (see table below).
Ä IEC 62046 contains additional recommendations on testing protective devices.
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Tab. 12.1: Checklist for integrator – to be performed prior to the initial start-up and following modifications

Check: Yes No n. a.
not ap-
plicable

Is the safety sensor operated acc. to the specific environmental conditions that
are to be maintained (see chapter 16 "Technical data")?

Is the safety sensor correctly aligned and are all fastening screws and connec-
tors secure?

Are safety sensor, connection cables, connectors, protection caps and com-
mand devices undamaged and without any sign of manipulation?

Does the safety sensor satisfy the required safety level (PL, SIL, category)?

Are the safety-related switching signals integrated in the downstream machine
control acc. to the required safety category?

Are switching elements that are controlled by the safety sensor monitored ac-
cording to the required safety level (PL, SIL, category) (e.g., contactors through
EDM)?

Are all points of operation near the safety sensor accessible only through the
protective field of the safety sensor?

Are the necessary additional protective devices in the immediate surroundings
(e.g., safety guard) properly mounted and secured against tampering?

If it is possible to be present undetected between the safety sensor and point
of operation: is an assigned start/restart interlock functional?

Is the command device for unlocking the start/restart interlock mounted in such
a way that it cannot be reached from within the danger zone and so that the
complete danger zone can be seen from the installation location?

Has the maximum stopping time of the machine been measured and docu-
mented?

Is the required safety distance maintained?

Does interruption with a test object intended for this purpose cause the danger-
ous movement(s) to stop?

Is the safety sensor effective during the entire dangerous movement(s)?

Is the safety sensor effective in all relevant operating modes of the machine?

Is start-up of dangerous movements reliably prevented if the protective field is
interrupted with a test object intended for this purpose?

Was the sensor detection capacity successfully tested (see chapter 12.3.1
"Checklist – periodically by the operator")?

Were distances to reflective surfaces taken into account during configuration
and no reflection bypasses subsequently detected?

Are notices for regular testing of the safety sensor legible to the operator and
are they located in a highly visible location?

Are changes to the safety function (e.g. protective field changeover) not easy
to achieve through tampering?

Are settings that could result in an unsafe state possible only by means of key,
password or tool?

Are there incentives that pose stimulus for tampering?

Were the operators instructed prior to starting work?
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12.2 To be performed periodically by competent persons
The reliable interaction of safety sensor and machine must be periodically tested by competent persons in
order to detect changes to the machine or impermissible tampering with the safety sensor.
Acc. to IEC 62046 and national regulations (e.g., EU directive 2009/104/EC), tests of elements which are
subject to wear must be performed by competent persons at regular intervals. Testing intervals may be reg-
ulated by nationally applicable regulations (recommendation acc. to IEC 62046: 6 months).
Ä Have all tests performed by competent persons.
Ä Observe the nationally applicable regulations and the time periods specified therein.
Ä As preparation, observe the checklist (see chapter 12.1 "Before the initial start-up and following modifi-

cations").

12.3 Periodically by the operator
The function of the safety sensor must be checked regularly (e.g., daily, on shift change, monthly or in an
even longer cycle) according to the following checklist. The frequency of the checks is determined by
means of the risk analysis performed by the operating company.
Due to complex machines and processes, it may be necessary under certain circumstances to check some
points at longer time intervals. Observe the classification in "Test at least" and "Test when possible".

WARNING

Unpredictable machine behavior during the test may result in serious injury!
Ä Make certain that there are no people in the danger zone.
Ä Before they begin work, train the operators on their respective tasks and provide suitable

test objects and an appropriate test instruction.
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12.3.1 Checklist – periodically by the operator

NOTICE

Ä If you answer one of the items on the check list with no, the machine must no longer be op-
erated (see chapter 12.1.1 "Checklist for integrator – to be performed prior to the initial start-
up and following modifications").

Tab. 12.2: Checklist – regular function test by trained operators/persons

Test at least: Yes No
Are safety sensor and connectors securely mounted and free of obvious signs of damage,
changes or tampering?

Were obvious changes made to access or entry possibilities?

Test the effectiveness of the safety sensor:
1. The LED 1 on the safety sensor must illuminate green (see chapter 3.4 "Display ele-

ments").
2. Interrupt the protective field using a suitable opaque test object (see figure).

Checking the protective field function with test rod.
Use a sample item with the set resolution as the test rod. The sample item should have a
matt surface structure.
Does the LED 1 on the safety sensor illuminate constantly red while the protective field is
interrupted?

Tab. 12.3: Checklist – regular function test by trained operators/persons

When possible, test during running operation: Yes No
Protective device with approach function: during machine operation, the protective field is
interrupted with the test object – are the obviously dangerous machine parts stopped with-
out noticeable delay?

Protective device with presence detection: the protective field is interrupted with the test
object – does this prevent operation of the obviously dangerous machine parts?
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13 Diagnosis and troubleshooting

13.1 What to do in case of failure?
After switching the safety sensor on, the display elements assist in checking the correct functionality and in
faultfinding (see chapter 3.4 "Display elements").
In case of failure, you can determine the fault from the LED displays and read a message from the display.
With the error message you can determine the cause of the error and initiate measures to rectify it.

PROFIsafe alarm messages
The safety sensor can make alarms available for diagnostic purposes.

• If the safety sensor detects an error, it passes this on to the PROFIsafe control as an alarm.
• Both PROFINET-specific as well as device-specific alarms are realized in the safety sensor. Each

alarm can be selected and deselected individually.
• Alarm-specific help texts can be displayed on the PROFIsafe control or read out by the PROFIsafe con-

trol.

NOTICE

For safety sensors with PROFIsafe interface, the alarm messages, with the exception of the
PROFIsafe-specific alarms, are activated by default.
Ä If necessary, you can activate the alarms individually via the Sensor Studio configuration

software.

NOTICE

If the safety sensor responds with an error display, you will often be able to eliminate the
cause yourself!
Ä Switch off the machine and leave it switched off.
Ä Analyze the cause of the fault using the diagnostics displays and rectify the fault.
Ä If you are unable to rectify the fault, contact the Leuze branch responsible for you or call the

Leuze customer service (see chapter 15 "Service and support").

13.2 Diagnostics displays
The diagnostics displays consist of one letter plus four numbers, divided into classes consisting of letters
and the first number.
Diagnostics classes:

• I (Information)
• No switch-off of the safety-related switching signals
• Unhindered operation possible

• U (Usage) 
Application error

• E (External) 
External fault

• F (Failure) 
internal device error

• Switch-off of the safety-related switching signals
• Self test unsuccessful
• Hardware error

• P (Parameter) 
Inconsistency in configuration
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Tab. 13.1: Diagnostics displays in order of ascending ID number

Diagnostic
ID

Diagnostic message Measure

U0370 Input level at the electrical inputs is unclear. Check the wiring of the safety sensor.

P0409 Safety configuration is not compatible: un-
known bank switchover.

Swap out the safety sensor or change the
configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.

P0410 Safety configuration is not compatible: un-
known output signals.

Swap out the safety sensor or change the
configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.

P0413 Safety configuration is not compatible: un-
known inputs SE1 and SE2.

Swap out the safety sensor or change the
configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.

P0414 Safety configuration is not compatible: un-
known EDM inputs.

Swap out the safety sensor or change the
configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.

P0415 Safety configuration is not compatible: un-
known field pair monitoring mode.

Swap out the safety sensor or change the
configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.

P0416 Safety configuration is not compatible: un-
known field pair monitoring parameters.

Swap out the safety sensor or change the
configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.

P0417 Safety configuration is not compatible: un-
known field pair monitoring mode.

Swap out the safety sensor or change the
configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.

P0419 Safety configuration is not compatible: un-
known monitoring parameter for the
changeover order.

Swap out the safety sensor or change the
configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.

P0420 Safety configuration is not compatible: un-
known monitoring mode of the field pair
changeover.

Swap out the safety sensor or change the
configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.

P0421 Safety configuration is not compatible: un-
known parameter for field pair changeover
monitoring.

Swap out the safety sensor or change the
configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.

P0422 Safety configuration is not compatible: un-
known field pair selection mode.

Swap out the safety sensor or change the
configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.

P0423 Safety configuration is not compatible: un-
known field pair selection parameter.

Swap out the safety sensor or change the
configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.
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Diagnostic
ID

Diagnostic message Measure

P0424 Safety configuration is not compatible: un-
known parameter for manipulation monitor-
ing.

Swap out the safety sensor or change the
configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.

P0425 Safety configuration is not compatible: un-
known configuration of the output signals.

Swap out the safety sensor or change the
configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.

P0426 Safety configuration is not compatible: un-
known resolution.

Swap out the safety sensor or change the
configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.

P0427 Safety configuration is not compatible: un-
known parameter.

Swap out the safety sensor or change the
configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.

P0429 Safety configuration is not compatible: un-
known start/restart mode.

Swap out the safety sensor or change the
configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.

P0430 Safety configuration is not compatible: un-
known start mode.

Swap out the safety sensor or change the
configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.

P0431 Safety configuration is not compatible: un-
known restart mode.

Swap out the safety sensor or change the
configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.

P0432 Safety configuration is not compatible: un-
known safety-signal stop mode.

Swap out the safety sensor or change the
configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.

U0582 Field pair changeover is not performed in
accordance with the specifications config-
ured in the safety sensor: overlap time too
long.

Check the changeover times of function inputs
F1 to F10 or the parameter settings in the
configuration.

U0583 Field pair changeover is not performed in
accordance with the specifications config-
ured in the safety sensor: no signal for field
pair activation.

Check the wiring and the changeover times of
function inputs F1 to F10.

U0584 Field pair changeover is not performed in
accordance with the specifications config-
ured in the safety sensor: changeover time
exceeded.

Check the changeover times of function inputs
F1 to F10 or the parameter settings in the
configuration.

U0585 Field pair changeover is not performed in
accordance with the specifications config-
ured in the safety sensor: changeover order
not observed.

Check the wiring of function inputs F1 to F10
and that the parameter settings in the configu-
ration are correct.

U0792 Field pair changeover without release. Check the release signal for field pair
changeover or change the safety configura-
tion.

U0793 Field pair changeover without request. Check the request signal for field pair
changeover or change the safety configura-
tion.
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Diagnostic
ID

Diagnostic message Measure

U0849 Field pair changeover not permitted. Check the wiring of the field pair inputs.

E0588 Optics cover is soiled. Clean the optics cover.

I0604 Optics cover is soiled. Clean the optics cover as soon as possible.
Sensor is still in safety mode.

P0653 Safety configuration is not compatible: pro-
tective/warning field radius too large.

Swap out the safety sensor or change the
configuration. The type of safety sensor must
be the same as the type stored in the connec-
tion unit or in the Sensor Studio software.

P0654 Field pair changeover is not performed in
accordance with the specifications config-
ured in the safety sensor: field pair not de-
fined.

Check the wiring of function inputs F1 to F10
and that the parameter settings in the configu-
ration are correct.

I0660 Field pair changeover is not performed in
accordance with the specifications config-
ured in the safety sensor: no field pair acti-
vated at system start.

Check the wiring of function inputs F1 to F10
and that the parameter settings in the configu-
ration are correct.

I0719 Timeout of signals RES1 or RES2 (acknowl-
edgment button, start/restart).

Check the wiring of inputs RES1 and RES2.
The time specifications for start/restart must
be observed.

P0747 Safety configuration is not compatible: pro-
tective/warning field radius too small.

Change the dimensions and contour of the
protective field in the configuration. The mini-
mum range of the protective field must be ob-
served.

I0825 Simulation mode has been activated. The safety-related switching signals have
been switched off.

I0826 Simulation mode has been deactivated. Safety sensor is again in safety mode.
CAUTION!
Be aware of potential hazards which can oc-
cur when the machine is started up!

I0859 Configuration was reset. +24 V detected at RES input after switch-on.
The communication parameters were reset to
default values.

I0914 Internal temperature is normal again. The safety sensor is in the specified tempera-
ture range and in normal operation.

I0915 Internal temperature above 82°C. Switch off the safety sensor and wait until it
has cooled down.

I0935 Life expectancy will soon be reached. Replace the safety sensor with a new device.

I0936 All PROFINET errors deleted. The safety sensor is in normal operation.

I0992 CU incompatible. Use a connection unit that is suitable for the
safety sensor.

I1004 Field violation due to glare.
(With switch-off of the safety-related switch-
ing signals)

Mount the safety sensor so that the light
source does not hit the outlet disc directly.

I1005 Dazzled RSL.
(Without switch-off of the safety-related
switching signals)

Mount the safety sensor so that the light
source does not hit the outlet disc directly.

I1018 Internal temperature is normal again. The safety sensor is in the specified tempera-
ture range and in normal operation.
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Diagnostic
ID

Diagnostic message Measure

I1019 Internal temperature below 3°C. Temperature outside of the specified tempera-
ture range. Move the safety sensor to a
warmer environment.

I1025 Internal temperature above 85°C. Switch off the safety sensor and wait until it
has cooled down.

I1027 Internal temperature below -0.5°C. Temperature outside of the specified tempera-
ture range. Move the safety sensor to a
warmer environment.

I1028 Internal temperature above 82°C. Switch off the safety sensor and wait until it
has cooled down.

I1030 Internal temperature below 3°C. Temperature outside of the specified tempera-
ture range. Move the safety sensor to a
warmer environment.

F.... The monitoring functions have detected an
internal error.

Create the service file (see chapter 4.5.5 "DI-
AGNOSIS") and contact the Leuze customer
service (see chapter 15 "Service and sup-
port").



Care, maintenance and disposal

Leuze electronic GmbH + Co. KG RSL 420P 144

14 Care, maintenance and disposal

14.1 Changing scanner unit
If the safety sensor check or an error message indicates a defective scanner unit, change the scanner unit.
Only a trained and competent person is permitted to change the scanner unit.
The scanner unit is changed as follows:

• Detach the scanner unit from the connection unit.
• Attach the replacement scanner unit to the connection unit.

NOTICE

Safety sensor malfunction caused by dirt!
Ä Perform all work in an environment which is as dust-free and dirt-free as possible.
Ä Do not touch any of the parts inside the device.

WARNING

Malfunctioning of safety sensor due to incompatibility of connection unit and scanner
unit! Malfunctioning of safety sensor due to incorrect configuration!
Ä Wherever possible, replace the scanner unit with a scanner unit with the same range and

performance class (e.g. RSL 420P-M with RSL 420P-M). The safety sensor configuration
stored in the connection unit is only adopted without changes if the new scanner unit sup-
ports all configured functions.

Ä Change the configuration parameters of the safety sensor using the configuration and diag-
nostic software according to the performance class of the scanner unit or of the connection
unit. 
If a scanner unit is attached to a connection unit with a lower performance class (e.g. scan-
ner unit RSL 430 to connection unit CU416), the integrated cable management of the con-
nection unit means that only the functions of the lower performance class (of the connection
unit) are available.
If a scanner unit is attached to a connection unit with a higher performance class (e.g.
RSL 420 scanner unit to CU429 connection unit), the performance of the scanner unit re-
stricts the functions to those of the lower performance class (of the scanner unit).

Ä If a PROFIsafe scanner unit is attached to a connection unit without PROFINET, no function
is possible (e.g., scanner unit RSL 420P on connection unit CU416).
If a scanner unit without PROFIsafe is attached to a PROFINET connection unit, no function
is possible (e.g., scanner unit RSL 420 on connection unit CU400P-3M12).

Ä Change the configuration parameters of the safety sensor using the configuration and diag-
nostic software according to the operating range of the replaced scanner unit. If the scanner
unit is replaced with a scanner unit with a different range (e.g. RSL 420P-L with RSL 420P-
M), you must check and, if necessary, adapt the configuration of the safety sensor.

NOTICE

Detailed information on attaching the scanner unit can be found in the document "Quick Start
Guide RSL 400".

Ä Undo the quick-release fasteners on both sides of the scanner unit.
Ä Pull the scanner unit off the connection unit.
Ä Place the new scanner unit on the connection unit.
Ä Connect and lock the new scanner unit using the quick-release fasteners on both sides.
Ä Check the configuration of the safety sensor (see chapter 9 "Configuring the safety sensor").
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NOTICE

If a preconfigured scanner unit is attached to a brand new, unconfigured connection unit, the
safety configuration stored in the scanner unit is transferred to the connection unit and you can
use the safety sensor without reconfiguration after a restart.

Ä Check the safety sensor according to the routine for initial start-up (see chapter 12.1.1 "Checklist for in-
tegrator – to be performed prior to the initial start-up and following modifications").

14.2 Cleaning the optics cover
Clean the optics cover as required by the application-related load rating.
Use the cleaning set consisting of special cleaning agent and cleaning cloths for cleaning (see chapter 18
"Order guide and accessories").
The procedure for cleaning depends on the kind of contamination:

Soiling Cleaning
Particles, loose, scouring Vacuum without touching or blow away softly, oil-free

Wipe free in one swipe with cleaning cloth

Particles, loose, non-scouring Vacuum without touching or blow away softly, oil-free
or
Wipe free in one swipe with cleaning cloth

Particles, sticking Wet with cloth soaked in cleaning agent
Wipe free in one swipe with cleaning cloth

Particles, statically charged Vacuum without touching
Wipe free in one swipe with cleaning cloth soaked with cleaning
agent

Particles/drops, smearing Wet with cloth soaked in cleaning agent
Wipe free in one swipe with cleaning cloth

Water drops Wipe free in one swipe with cleaning cloth

Oil drops Wet with cloth soaked in cleaning agent
Wipe free in one swipe with cleaning cloth

Fingerprints Wet with cloth soaked in cleaning agent
Wipe free in one swipe with cleaning cloth

Scratches Change optics cover

NOTICE

The wrong cleaning agents or cloths will damage the optics cover!
Ä Do not use any scouring cleaning agents or scratching cloths.

NOTICE

If cleaning takes longer than four seconds, e.g. with fingerprints, the safety sensor displays a
fault of optics cover monitoring. After cleaning is complete, the safety sensor resets itself auto-
matically.

Ä Clean the optics cover over the entire 360° range.
Ä Soak cloth with cleaning agent.
Ä Wipe optics cover free in one swipe.
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Ä Clean not only the optics cover, but also the reflector ring under the cap.

1

1 Reflector ring

Fig. 14.1: Reflector ring

NOTICE

Internal monitoring of optics cover!
Ä The monitored area is dependent on the configuration and can be smaller than the entire

scanning range of 270°.
Ä On account of device safety, the internal monitoring of the optics cover monitors a range

that is larger than specified by the configured protective field.

14.3 Servicing
The device does not normally require any maintenance by the operator.
Repairs to the device must only be performed by the manufacturer.
Ä For repairs, contact your responsible Leuze subsidiary or Leuze customer service (see chapter 15 "Ser-

vice and support").

14.4 Disposing
Ä For disposal observe the applicable national regulations regarding electronic components.
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15 Service and support
24-hour on-call service at: 
+49 7021 573-0

Service hotline: 
+49 7021 573-123

E-mail: 
service.protect@leuze.de

Return address for repairs:
Servicecenter
Leuze electronic GmbH + Co. KG
In der Braike 1
D-73277 Owen/Germany
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16 Technical data

16.1 General specifications

Tab. 16.1: Safety-relevant technical data

Type in accordance with IEC 61496 Type 3

SIL in accordance with IEC 61508 SIL 2

SILCL in accordance with IEC 62061 SILCL 2

Performance Level (PL) in accordance with
ISO 13849-1

PL d

Category in accordance with ISO 13849-1 Cat. 3

Average probability of a failure to danger per hour
(PFHd)

9x10-8 1/h

Mission time (TM) 20 years

Tab. 16.2: Optics

Laser protection class in accordance with
EN 60825-1

Class 1

Wavelength 905 nm (infrared)

Impulse duration 2.5 ns

Maximum output power (peak) 35 W

Pulse frequency of laser transmitter 90 kHz

Scanning rate 25 scans/s, equal to 40 ms/scan

Scanning angle Max. 270 °

Angular resolution 0.1 °

Tolerance field of reference contour + 200  mm

Tab. 16.3: Protective field data

Safety sensor RSL 420P RSL 450P
RSL 455P

Number of field pairs 10 100

Reference contour selectable x x

Minimum adjustable range 50 mm

Detection range of the test object from the 
housing edge

The detection capability is limited in the 0 mm to 50 mm
range to increase availability.

Diffuse reflectance PF minimum 1.8 %

Tab. 16.4: Protective field range

Device range S M L XL
Resolution [mm] Protective field range [m]
150 3.00 4.50 6.25 8.25

70 3.00 4.50 6.25 8.25

60 3.00 4.50 6.25 8.25

50 3.00 4.50 6.25 6.25

40 3.00 4.50 4.50 4.50

30 3.00 3.50 3.50 3.50
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Tab. 16.5: Warning field data

Safety sensor RSL 420P RSL 450P
RSL 455P

Number of field pairs 10 100

Warning field range 0 … 20 m

Object size 150 mm x 150 mm

Diffuse reflectance WF minimum Min. 10%

Tab. 16.6: Measurement field data

Detection range 0 … 50 m

Diffuse reflection 90 %

Radial resolution 1 mm

Lateral resolution 0.1 °

Tab. 16.7: Electrical supply

RSL 4xxP voltage supply 24 V DC (+20% / -30%)

Power supply unit/battery Supply acc. to IEC 742 with safe mains separation
and equalization for power outages of up to 20 ms
acc. to IEC 61496-1.

Current consumption RSL 4xxP with CU400P-3M12, CU400P-4M12 or
CU400P-AIDA:
0.9 A

RSL 4xxP with CU400P-AIDA-OF:
1.0 A

Power consumption RSL 4xxP with CU400P-3M12, CU400P-4M12 or
CU400P-AIDA:
22 W

RSL 4xxP with CU400P-AIDA-OF:
24 W

Switch-on current Max. 2 A

Overvoltage protection overvoltage protection with protected limit stop

Protective conductor Connection required

Tab. 16.8: Device connection and PROFIsafe/communication connection

CU400P-3M12 • Device connection:
M12 connector, 4-pin, standard, A-coded

• Connection socket PROFIsafe/communication:
M12 socket, 4-pin, D-coded

CU400P-4M12 • Device connection:
M12 connector/socket, 5-pin, L-coded

• Connection socket PROFIsafe/communication:
M12 socket, 4-pin, D-coded

CU400P-AIDA • Device connection:
PROFINET push-pull 24 V

• Connection socket PROFIsafe/communication:
PROFINET RJ45 push-pull IEC 61076-3-117 var. 14
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CU400P-AIDA-OF • Device connection:
PROFINET push-pull 24 V

• Connection socket PROFIsafe/communication:
PROFINET SCRJ push-pull ISO/IEC 61754-24-2

Tab. 16.9: Inputs and outputs

Properties Max. output current Ia Min. input current Ie Typical connection
components

EA1, EA2 20 mA ---

Signal definition:

High/logical 1 16 - 30 V

Low/logical 0 < 3 V

Tab. 16.10: Reaction time

Minimum Typical Maximum

Response time (TSC) 80 ms (2 scans) 1000 ms (25 scans)

PROFIsafe processing and output
(DAToutput)

47 ms

PROFIsafe watchdog time (TWD) DAToutput + TPS-MASTER + 4*TPN

Tab. 16.11: PROFINET

PROFINET device Device acc. to Spec V2.3.4

GSDML GSDML acc. to Spec V2.3.4

Profile PROFINET/PROFIsafe

Conformance class Class C

Network load class Class III

Security level Security level 1

Switch IRT-ready 2-port switch acc. to IEEE 802; integrated in connection
unit

Port properties Auto-Negotiation
Auto-Polarity
Auto-Crossover

I&M I&M 0 - 4

Supported topologies SNMP
MRP client

Safety-related switching signals 1

Tab. 16.12: USB

Type of interface USB 2.0

Connection type USB 2.0 mini-B socket

Transmission rate ≤ 12 Mbit/s

Cable length ≤ 5 m
Longer cable lengths are possible using active ca-
bles.
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Tab. 16.13: Bluetooth

Frequency band 2400 ... 2483.5 MHz

Radiated transmitting power Max. 4.5 dBm (2.82 mW), class 2

Tab. 16.14: Software

Configuration and diagnostics software Sensor Studio for Windows 7 or higher

Tab. 16.15: General system data

Degree of protection IP 65 in acc. with IEC 60529

Protection class III in accordance with EN 61140

Ambient temperature, operation 0 … +50 °C

Ambient temperature, storage -20 … +60 °C

Humidity DIN 40040, table 10, code letter E (reasonably dry)

Interference rejection In acc. with IEC 61496-1 (type 4), also in acc. with
DIN 40839-1/3 test pulses 1, 2, 3a, 3b and 5

Vibration stress over 3 axes In acc. with IEC 60068 part 2 - 6, 10 - 55 Hz
max 5 G

Continuous shock over 3 axes In acc. with IEC 60068 part 2 - 29, 10 G, 16 ms

Disposal Specialist disposal required

Housing Diecast zinc, plastic

Standard version dimensions (ensure free space for
connector with fixing and connection cable)

see chapter 16.2 "Dimensions"

Weight of standard version incl. connection unit Approx. 3 kg

Distance, beam level center to bottom housing edge 104 mm

Tab. 16.16: Patents

US patents US 7,656,917 B
US 7,696,468 B
US 8,520,221 B
US 2016/0086469 A
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16.2 Dimensions

all dimensions in mm

Fig. 16.1: Dimensions of safety laser scanner with CU400P-3M12 connection unit
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all dimensions in mm

Fig. 16.2: Dimensions safety laser scanner with connection unit CU400P-4M12, CU400P-AIDA or CU400P-AIDA-
OF
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1

all dimensions in mm
1 Reference point for distance measurement and protective field radius

Fig. 16.3: Dimensions of scanning range

16.3 Dimensioned drawings: Accessories
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Fig. 16.4: BTU800M mounting system
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Fig. 16.5: Bracket for floor assembly BTF815-30M
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Fig. 16.6: BTF815M mounting bracket
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Fig. 16.7: BTF830M mounting bracket
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Fig. 16.9: BT840M mounting bracket
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Fig. 16.10: Mounting bracket BT840M, view A
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Fig. 16.11: BT856M mounting bracket
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Fig. 16.12: Mounting bracket BT856M, view A

16.4 PROFIsafe status profile
The PROFIsafe configuration modules contain all logical and electrical signals that are present in the safety
sensor. The signal names are used consistently throughout the configuration and diagnostics software (de-
vice DTM), in the event log and in the data telegram.

PROFIsafe project modules
During configuration, different module structures and their properties can be selected via Device Access
Points (DAPs) that are created in the GSDML file:

• DAP 1: project modules 1 … 8

16.4.1 Project modules for DAP 1
Modules [M1] … [M8]

• For devices with M12 connection unit (CU M12):
• DeviceID: 0x0011
• Textual designation for configuration:

RSL400P M12
• For devices with AIDA connection unit for copper cables (CU AIDA):

• DeviceID: 0x0012
• Textual designation for configuration:

RSL400P AIDA
• For devices with AIDA connection unit for fiber-optic cables (CU AIDA-OF):

• DeviceID: 0x0013
• Textual designation for configuration:

RSL400P AIDA-OF
• For devices with connection unit with L-coded M12 connectors/sockets for the voltage supply

(CU 4M12):
• DeviceID: 0x0016
• Textual designation for configuration:

RSL400P 4M12
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Module Description Input data
[Byte]

Output
data
[Byte]

[M1]
SAFE_SIGNAL
see chapter 11.5.3 "Module
[M1] ‑ SAFE_SIGNAL"

Safe module with the safe signals and the
most important status signals for simple
system diagnostics.

3 3

[M2]
SYSTEM_STATUS
see chapter 11.5.4 "Module
[M2] ‑ SYSTEM_STATUS"

General information on error diagnostics
and system alignment.

8 0

[M3]
SCAN_NUMBER
see chapter 11.5.5 "Module
[M3] – SCAN_NUMBER"

Sequential scan number 4 0

[M4]
REFLECTOR_STATUS
see chapter 11.5.6 "Module
[M4] – REFLECTOR_STATUS"

Information on reflectors in the field of view
of the safety laser scanner

2 0

[M5]
PROTECTIVE_FUNC-
TION_A_STATUS
see chapter 11.5.7 "Module
[M5] – PROTECTIVE_FUNC-
TION_A_STATUS"

Detailed status of protective function A 3 0

[M6]
PROTECTIVE_FUNC-
TION_B_STATUS
see chapter 11.5.8 "Module
[M6] – PROTECTIVE_FUNC-
TION_B_STATUS"

Detailed status of protective function B 3 0

[M7]
PROTECTIVE_FUNC-
TION_A_VIOLATION
see chapter 11.5.9 "Module
[M7] – PROTECTIVE_FUNC-
TION_A_VIOLATION"

Information on protective field interruption
or warning field interruption of protective
function A

8 0

[M8]
PROTECTIVE_FUNC-
TION_B_VIOLATION
see chapter 11.5.10 "Module
[M8] – PROTECTIVE_FUNC-
TION_B_VIOLATION"

Information on protective field interruption
or warning field interruption of protective
function B

8 0
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16.4.2 Project modules for DAP 2
Modules [M11] … [M17]

• For devices with M12 connection unit (CU M12):
• DeviceID: 0x0011
• Textual designation for configuration:

RSL400P M12 V2
• For devices with AIDA connection unit for copper cables (CU AIDA):

• DeviceID: 0x0012
• Textual designation for configuration:

RSL400P AIDA V2
• For devices with AIDA connection unit for fiber-optic cables (CU AIDA-OF):

• DeviceID: 0x0013
• Textual designation for configuration:

RSL400P AIDA-OF V2
• For devices with connection unit with L-coded M12 connectors/sockets for the voltage supply

(CU 4M12):
• DeviceID: 0x0016
• Textual designation for configuration:

RSL400P 4M12 V2

Module Description Input data
[Byte]

Output
data
[Byte]

[M11]
SAFE_SIGNAL_PS2V4
see chapter 11.5.11 "Module
[M11] ‑ SAFE_SIGNAL_PS2V4"

For PROFIsafe version 2.4:
Safe module containing the safe input and
output signals.

3 7

[M11]
SAFE_SIGNAL_PS2V6
see chapter 11.5.12 "Module
[M11] ‑ SAFE_SIGNAL_PS2V6"

For PROFIsafe version 2.6:
Safe module containing the safe input and
output signals.

2 6

[M12]
SYSTEM_STATUS
see chapter 11.5.13 "Module
[M12] ‑ SYSTEM_STATUS"

General information on the status of the de-
vice and safety functions.
Simple system diagnostics is possible.

6 0

[M13]
SYSTEM_DATA
see chapter 11.5.14 "Module
[M13] – SYSTEM_DATA"

Current data:
Alignment of the safety laser scanner
Voltage supply
Inside temperature

8 0

[M14]
PROTECTIVE_FUNC-
TION_A_STATUS
see chapter 11.5.15 "Module
[M14] – PROTECTIVE_FUNC-
TION_A_STATUS"

Detailed status of protective function A 8 0

[M15]
PROTECTIVE_FUNC-
TION_B_STATUS
see chapter 11.5.16 "Module
[M15] – PROTECTIVE_FUNC-
TION_B_STATUS"

Detailed status of protective function B 8 0
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Module Description Input data
[Byte]

Output
data
[Byte]

[M16]
PROTECTIVE_FUNC-
TION_A_VIOLATION
see chapter 11.5.17 "Module
[M16] – PROTECTIVE_FUNC-
TION_A_VIOLATION"

Information on protective field interruption
or warning field interruption of protective
function A

8 0

[M17]
PROTECTIVE_FUNC-
TION_B_VIOLATION
see chapter 11.5.18 "Module
[M17] – PROTECTIVE_FUNC-
TION_B_VIOLATION"

Information on protective field interruption
or warning field interruption of protective
function B

8 0
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17 Standards and legal regulations
In particular, the current version of the following national and international legal regulations apply for com-
missioning, technical tests and handling of safety sensors:

• Machinery Directive
• Low Voltage Directive
• Electromagnetic compatibility
• Use of Work Equipment Directive
• Directive on the restriction of the use of certain hazardous substances in electrical and electronic equip-

ment
• OSHA
• Vibration IEC 60068-2-6
• Eye safety (measurement laser) IEC 60825-1
• Safety regulations
• Accident-prevention regulations and safety rules
• Ordinance on Industrial Safety and Health and employment protection act
• Product Safety Law (ProdSG)
• Standards for risk assessment, e.g.

• ISO 12100
• ISO 13849-1, -2
• IEC 61508-1 to -7
• IEC 62061
• IEC 60204-1

• ISO 13849-1
• ISO 13855
• IEC 61496-3
• EN 1525
• IEC 62046
• IEC 61158
• IEC 61784
• IEC 61784-3-3
• IEC 61076-3-117
• ISO/IEC 61754-24-2
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18 Order guide and accessories
Scope of delivery

• 1 self-adhesive notice sign "Important notes and notes for the machine operator"
• 1 Original operating instructions "Safe implementation and operation" (PDF file on data carrier)
• 1 print document "Quick Start Guide RSL 400"

Tab. 18.1: Part numbers

Part no. Article Description
53800300 RSL420P-S/

CU400P-3M12
1 safety-related switching signal; 10 field pairs; protective field
range max. 3.0 m, PROFIsafe
PROFINET: 2x M12 connector

53800301 RSL420P-M/
CU400P-3M12

1 safety-related switching signal; 10 field pairs; protective field
range max. 4.5 m, PROFIsafe
PROFINET: 2x M12 connector

53800302 RSL420P-L/
CU400P-3M12

1 safety-related switching signal; 10 field pairs; protective field
range max. 6.25 m, PROFIsafe
PROFINET: 2x M12 connector

53800303 RSL420P-XL/
CU400P-3M12

1 safety-related switching signal; 10 field pairs; protective field
range max. 8.25 m, PROFIsafe
PROFINET: 2x M12 connector

53800329 RSL420P-S/
CU400P-4M12

1 safety-related switching signal; 10 field pairs; protective field
range max. 3.0 m, PROFIsafe
PROFINET: 2x M12 connector

53800330 RSL420P-M/
CU400P-4M12

1 safety-related switching signal; 10 field pairs; protective field
range max. 4.5 m, PROFIsafe
PROFINET: 2x M12 connector

53800331 RSL420P-L/
CU400P-4M12

1 safety-related switching signal; 10 field pairs; protective field
range max. 6.25 m, PROFIsafe
PROFINET: 2x M12 connector

53800332 RSL420P-XL/
CU400P-4M12

1 safety-related switching signal; 10 field pairs; protective field
range max. 8.25 m, PROFIsafe
PROFINET: 2x M12 connector

53800304 RSL420P-S/CU400P-
AIDA

1 safety-related switching signal; 10 field pairs; protective field
range max. 3.0 m, PROFIsafe
PROFINET: 2x push-pull connector for copper cables

53800305 RSL420P-M/CU400P-
AIDA

1 safety-related switching signal; 10 field pairs; protective field
range max. 4.5 m, PROFIsafe
PROFINET: 2x push-pull connector for copper cables

53800306 RSL420P-L/CU400P-
AIDA

1 safety-related switching signal; 10 field pairs; protective field
range max. 6.25 m, PROFIsafe
PROFINET: 2x push-pull connector for copper cables

53800307 RSL420P-XL/CU400P-
AIDA

1 safety-related switching signal; 10 field pairs; protective field
range max. 8.25 m, PROFIsafe
PROFINET: 2x push-pull connector for copper cables

53800308 RSL420P-S/CU400P-
AIDA-OF

1 safety-related switching signal; 10 field pairs; protective field
range max. 3.0 m, PROFIsafe
PROFINET: 2x push-pull connector for fiber-optic cables
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Part no. Article Description
53800309 RSL420P-M/CU400P-

AIDA-OF
1 safety-related switching signal; 10 field pairs; protective field
range max. 4.5 m, PROFIsafe
PROFINET: 2x push-pull connector for fiber-optic cables

53800310 RSL420P-L/CU400P-
AIDA-OF

1 safety-related switching signal; 10 field pairs; protective field
range max. 6.25 m, PROFIsafe
PROFINET: 2x push-pull connector for fiber-optic cables

53800311 RSL420P-XL/CU400P-
AIDA-OF

1 safety-related switching signal; 10 field pairs; protective field
range max. 8.25 m, PROFIsafe
PROFINET: 2x push-pull connector for fiber-optic cables

Tab. 18.2: Scanner units as spare parts

Part no. Article Description
53800154 RSL420P-S 1 safety-related switching signal; 10 field pairs; protective field

range max. 3.0 m, PROFIsafe

53800157 RSL420P-M 1 safety-related switching signal; 10 field pairs; protective field
range max. 4.5 m, PROFIsafe

53800160 RSL420P-L 1 safety-related switching signal; 10 field pairs; protective field
range max. 6.25 m, PROFIsafe

53800163 RSL420P-XL 1 safety-related switching signal; 10 field pairs; protective field
range max. 8.25 m, PROFIsafe

Tab. 18.3: Connection units as spare parts

Part no. Article Description
53800150 CU400P-3M12 PROFINET, 1x M12 connector for supply, 2x M12 connector for

communication

53800169 CU400P-4M12 PROFINET, 1x M12 connector and 1x M12 socket for supply, 2x
M12 connector for communication

53800151 CU400P-AIDA PROFINET, 2x push-pull connector for supply, 2x push-pull con-
nector for communication via copper cable

53800152 CU400P-AIDA-OF PROFINET, 2x push-pull connector for supply, 2x push-pull con-
nector for communication via fiber-optic cable

Tab. 18.4: Accessories

Part no. Article Description
Connection technology – Connection cables
678055 CB-M12-5000E-5GF Connection cable, 5-pin, 5 m

678056 CB-M12-10000E-5GF Connection cable, 5-pin, 10 m

678057 CB-M12-15000E-5GF Connection cable, 5-pin, 15 m

678058 CB-M12-25000E-5GF Connection cable, 5-pin, 25 m

50129553 CB-M12-30000E-5GF Connection cable, 5-pin, 30 m

Connection technology – RJ45 interconnection cables
50135080 KSS ET-M12-4A-RJ45-

A-P7-020
Interconnection cable RJ45, 2 m

50135081 KSS ET-M12-4A-RJ45-
A-P7-050

Interconnection cable RJ45, 5 m
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Part no. Article Description
50135082 KSS ET-M12-4A-RJ45-

A-P7-100
Interconnection cable RJ45, 10 m

50135083 KSS ET-M12-4A-RJ45-
A-P7-150

Interconnection cable RJ45, 15 m

50135084 KSS ET-M12-4A-RJ45-
A-P7-300

Interconnection cable RJ45, 30 m

Connection technology – USB interconnection cables
547822 AC-MSI-USB USB-Mini-B interconnection cable, USB-A, 3 m

Connection technology – Adapters
50134656 RSL400 M12 adapter Adapter for the simple connection of an Ethernet cable to the front

side of the device.

Mounting technology
53800130 BTU800M Laser scanner mounting system for vertical and horizontal align-

ment

53800132 BTF815M Mounting bracket for floor mounting; scanning height 150 mm
Mounting of safety sensor only in combination with BTU800M

53800133 BTF830M Mounting bracket for floor mounting; scanning height 300 mm
Mounting of safety sensor only in combination with BTU800M

53800134 BT840M Mounting bracket for corner mounting on posts (chamfered corner)
Direct mounting of the safety sensor

53800135 BT856M Mounting bracket for corner mounting on posts
Direct mounting of the safety sensor

53800131 BTP800M Loop guard for optics cover
Only in combination with BTU800M

53800138 BTF815-30M Bracket for floor mounting
Adjustable scanning height: 75 mm – 375 mm
Mounting of safety sensor only in combination with BTU800M

Cleaning fluids
430400 Cleaning set 1 Cleaning fluid for plastic, 150 ml, cleaning cloths, 25x, soft, fuzz-

free

430410 Cleaning set 2 Cleaning fluid for plastic, 1,000 ml, cleaning cloths, 100x, soft, fuzz-
free
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